Description
This manual is issued for reference only, at the convenience of Arbiter Systems. Reasonable effort was made to verify that all contents were accurate as of the time of publication. Check with Arbiter Systems at the address below for any revisions made since the original date of publication.

Contact Information
Arbiter Systems, Inc.
1324 Vendels Circle, Suite 121
Paso Robles, CA 93446
(805) 237-3831
www.arbiter.com
techsupport@arbiter.com
sales@arbiter.com

What This Manual Covers
This manual describes the set up and operation of the Model 1133A Power Sentinel.

ROM Dates
This version of the manual is written a Power Sentinel having a ROM date of 11 June 2012 or later. Any changes made in subsequent revisions which affect operation or specifications will be noted with either (a) a new manual or (b) a revised version of this manual. To display the ROM date for your instrument, press and hold down the STATUS key after power-on for three seconds; a second set of menus will be available. The ROM date (firmware version) will be displayed.

Firmware Updates
Firmware updates are available to customers by download from the Arbiter web site. Where applicable, this update may include new documentation, such as a new version of this manual.

For the latest firmware see www.arbiter.com and look under Downloads.
LIMITED WARRANTY

Arbiter Systems makes no warranty, expressed or implied, on any product manufactured or sold by Arbiter Systems except for the following limited warranty against defects in materials and workmanship on products manufactured by Arbiter Systems.

Products manufactured by Arbiter Systems are guaranteed against defective materials and workmanship under normal use and service from the date of delivery for the period listed below. The responsibility of Arbiter Systems under this warranty is limited to repair or replacement, at Arbiter Systems’ option, of any product found to be defective. Arbiter Systems shall have no liability under this warranty unless it receives written notice of any claimed defect, within two years.

For warranty service or repair, products must be returned to a service facility designated by Arbiter Systems. Buyer shall prepay all shipping charges to Arbiter Systems, and Arbiter Systems shall pay shipping charges incurred in returning the product to Buyer. However, Buyer shall pay all shipping charges, duties and taxes for products returned to Buyer in a country other than the United States of America.

THE WARRANTY SET FORTH HEREIN CONSTITUTES THE ONLY WARRANTY OBLIGATIONS OF ARBITER SYSTEMS, EXPRESSED OR IMPLIED, STATUTORY, BY OPERATION OF LAW, OR OTHERWISE. ARBITER SYSTEMS DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND BUYER EXPRESSLY WAIVES ALL OTHER WARRANTIES.

This limited warranty does not extend to any product, which has been subject to:

1. Improper use or application, abuse, or operation beyond its rated capacity, or contrary to the instructions in the operation and maintenance manuals (if any);

2. Accident;

3. Repair or maintenance performed by Buyer, except in accordance with the operation and maintenance manuals, if any, and any special instructions of Arbiter Systems;

4. Modification without the prior written authorization of Arbiter Systems (whether by the substitution of non-approved parts or otherwise). The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall Arbiter Systems be liable for direct, indirect, incidental or consequential damages (including loss of profits), whether based on contract, tort, or other legal theory.

FOR THE FASTEST POSSIBLE SERVICE, PLEASE PROCEED AS FOLLOWS:

1. Notify Arbiter Systems, Inc., specifying the instrument model number and serial number and giving full details of the difficulty. Service data or instrument-return authorization will be provided upon receipt of this information.

2. If instrument return is authorized, forward prepaid to the manufacturer. If it is determined that the instrument is not covered by this warranty, an estimate will be made before the repair work begins, if requested.

See Contact Information on page ii.
# Contents

1 Unpacking the 1133A ............................ 1  
1.1 Introduction ........................................... 1  
1.2 Precautions ........................................... 1  
1.3 Unpacking and Locating Accessories .................. 2  
1.4 Attaching Rack-Mount Ears to 1133A ................. 2  

2 Front and Rear Panels .................................. 4  
2.1 Introduction ........................................... 4  
2.2 Front Panel Controls and Indicators ................. 4  
  2.2.1 Annunciator LED Definitions .................... 5  
  2.2.2 Command Key Definitions ....................... 6  
2.3 Rear Panel Connectors and Identification .......... 6  
  2.3.1 Power Inlet .................................... 7  
  2.3.2 Antenna or IRIG-B Input ....................... 7  
  2.3.3 AC Voltage Inputs ............................... 8  
  2.3.4 AC Current Inputs ............................... 8  
  2.3.5 Event Inputs .................................. 8  
  2.3.6 IRIG-B Timing Output ......................... 9  
  2.3.7 Communication Ports ......................... 9  
  2.3.8 Form C Contacts ............................... 9  

3 Connecting Inlet Power, Input and Output Signals ..... 10  
3.1 Introduction ........................................... 10  
3.1.1 Connecting Inlet Power ............................ 10  
3.1.2 Option 03, 110 to 350 Vdc Terminal Power Strip, Surge Withstand .... 10  
3.1.3 Option 04, 10 Vdc to 60 Vdc ONLY, Terminal Power Strip Surge Withstand 11  
3.1.4 Fuse Locations and Types ....................... 11  
3.2 Connecting Voltage and Current Signals ............. 12  
  3.2.1 AC Voltage Inputs ............................... 12  
  3.2.2 AC Current Inputs ............................... 12  
  3.2.3 Electrical System Connection Diagrams ........... 12  
3.3 Relay Contact Outputs ................................ 19  
3.4 Event Inputs ........................................ 19  
3.5 IRIG-B Output ....................................... 19  
3.6 Data Connections ................................... 20  
  3.6.1 Serial Interface Connections .................... 20
3.6.2 Ethernet Interface Connections ........................................ 20

4 GNSS Antenna and Cable Information ...................................... 21
    4.1 GNSS Antenna Installation ........................................... 21
       4.1.1 Mounting the Antenna .......................................... 21
       4.1.2 Optional Antenna Mounting Bracket ......................... 22
    4.2 Verifying Antenna and Cable Operation .............................. 24
       4.2.1 Checking the Antenna Voltage ................................. 24
       4.2.2 Power Supply Check ........................................... 24
       4.2.3 Checking the Antenna Resistance .............................. 24
    4.3 GNSS Surge Arrester .................................................. 24
       4.3.1 Using the Antenna Surge Arrester ............................ 24
    4.4 Technical Details on GNSS, Antennas and Cables .................. 25
       4.4.1 Antenna Cable .................................................. 25

5 Startup Operation and Indication ......................................... 28
    5.1 Startup ............................................................. 28
       5.1.1 Startup Display Indications .................................. 28
       5.1.2 Locked Indication .............................................. 28
       5.1.3 Annunciator LED Startup Indications ....................... 29
       5.1.4 Viewing Electrical Parameters ................................. 29
    5.2 Overview of Command Keys .......................................... 29
       5.2.1 Voltage/Current Key ........................................... 29
       5.2.2 Frequency/Time Deviation Key ............................... 30
       5.2.3 Event Log Key ................................................ 30
       5.2.4 Status/Time Keys – Primary Functions .................... 30
       5.2.5 Status/Time Keys – Secondary Functions .................. 32
       5.2.6 Power Key ..................................................... 33
       5.2.7 Energy Key ..................................................... 33
       5.2.8 Harmonics Key ................................................. 34
       5.2.9 Flicker Key ..................................................... 34
    5.3 Unlocked and System Fault Indication ............................... 34
       5.3.1 Unlocked Indication .......................................... 34
       5.3.2 Fault Indication ............................................... 34

6 PSCSV Basics – Starting, Connecting and Logging In .................. 36
    6.1 Introduction ......................................................... 36
       6.1.1 Getting Started ................................................ 36
       6.1.2 Triggering from the DSP, Power Quality, and from I/O Connections ......................................................... 36
       6.1.3 C37.118 Phasor Broadcast ..................................... 36
       6.1.4 Power Quality, DNP and Modbus ............................ 37
       6.1.5 Scheduled Data, Relays and KYZ Pulses .................... 37
    6.2 Menus, Toolbars, Buttons and Windows ................................ 37
       6.2.1 Moving and Viewing Features ................................. 37
    6.3 Toolbar and Button Definitions .................................... 38
       6.3.1 Main Toolbar .................................................. 38
       6.3.2 Connection Toolbar ............................................ 38
## Contents

6.3.3 Broadcast Toolbar ............................................. 38
6.3.4 Configuration Toolbar ....................................... 39
6.3.5 Flash Toolbar .................................................. 39
6.3.6 Input Toolbar .................................................. 40
6.3.7 Records Toolbar ............................................... 41
6.3.8 View Menu ..................................................... 41
6.3.9 Edit Menu ..................................................... 41

6.4 Connecting with the 1133A ..................................... 42
6.4.1 Introduction ................................................... 42
6.4.2 Communication Ports ......................................... 42
6.4.3 Starting PSCSV ................................................. 43
6.4.4 Checking Communication Parameters on the 1133A .... 43
6.4.5 Opening a Connection ....................................... 43
6.4.6 Adding a TCP or UDP Connection ......................... 45
6.4.7 Renaming a TCP or UDP Connection ..................... 46
6.4.8 Removing a TCP or UDP Connection ....................... 46
6.4.9 Closing a Connection ....................................... 46
6.4.10 Automatic Connection Closure ............................ 46
6.4.11 Special Note on 115200 Baud Rates .................... 46
6.4.12 Logging In to the 1133A ..................................... 46
6.4.13 Logging In Using admin .................................... 47

7 Configuring the Model 1133A .................................... 48
7.1 Introduction ..................................................... 48
7.1.1 1133A Configuration Options by Section ................. 48
7.1.2 Basic Configuration Requirements ....................... 48
7.2 Configuring an 1133A Communication Port .................. 48
7.2.1 To view COM Port Settings on the 1133A ............... 49
7.2.2 Configure Ports – Communication Ports 1 and 2 ....... 49
7.3 Configure Ports – Ethernet .................................... 50
7.3.1 Additional Information on Ethernet Connections ....... 51
7.3.2 Check the Computer Network Settings with ipconfig .. 51
7.3.3 Ping the 1133A Port ........................................... 51
7.4 Configuring Measurement Parameters ........................ 51
7.5 Configure Ports – IRIG-B ....................................... 53
7.6 Configure Ports – DNP 3.0 Protocol .......................... 54
7.6.1 Configuring Class 0 Data .................................... 54
7.7 Configure Ports – Modbus ...................................... 56
7.8 Configure Ports – C37.118 Synchrophasor Protocol ....... 57
7.8.1 Setup .......................................................... 57
7.8.2 PMU Setup Terms and Definitions ....................... 57
7.8.3 Window Functions ............................................ 59
7.8.4 Setup Example – Ethernet .................................. 60
7.8.5 Audible Frequency Alert, from Phasor Display ......... 61
7.9 Broadcasting UDP Data ......................................... 62
7.9.1 Transmitting UDP, Arbiter Protocol ...................... 62
8.5 Logging Data when Triggers Occur .................................................. 85
  8.5.1 “Data Logged” Procedure Details .............................................. 86
8.6 Configuring Schulz-Laios Settings .................................................... 87
8.7 Configuring Event Notification ....................................................... 88
8.8 Downloading Triggered Events from Flash ........................................ 88

9 Working with Broadcast Data ............................................................ 91
  9.1 Introduction ................................................................................. 91
    9.1.1 Filter Data Selection Tool ..................................................... 91
    9.1.2 Broadcast Data Choices ....................................................... 92
  9.2 Logging Basic Data .................................................................... 92
  9.3 Logging Energy Data .................................................................. 93
  9.4 Logging Harmonic Data ............................................................... 95
  9.5 Logging Harmonic Summary Data .................................................. 96
    9.5.1 Harmonic Summary Values .................................................... 97
    9.5.2 Harmonic Load Currents ....................................................... 98
    9.5.3 Harmonic Summary Data ....................................................... 98
  9.6 Logging Waveform Data ................................................................ 98
  9.7 Logging Phasor Data ................................................................... 99
  9.8 Logging Phase Data .................................................................... 100
  9.9 Exporting Data in CSV Format ...................................................... 101
  9.10 Exporting Data in PQDIF Format .................................................. 102

10 Working with Scheduled Data .......................................................... 103
  10.1 Introduction .............................................................................. 103
    10.1.1 Topics Addressed in this Section ............................................ 103
    10.1.2 Protocols ............................................................................ 103
    10.1.3 Registered or Scheduled Data ............................................... 103
    10.1.4 Downloading Scheduled Data with PSCSV ............................... 104
    10.1.5 Logging Data with KVZ Pulse Metering .................................... 104
  10.2 Logging Scheduled Data using Other Protocols ................................. 104
    10.2.1 DNP 3.0 and Modbus Protocols ............................................. 104
    10.2.2 Checking the Flash Memory Status ......................................... 104
  10.3 Downloading Scheduled Data using PSCSV ..................................... 105
  10.4 Configuring Scheduled Storage .................................................... 107
  10.5 Erasing Scheduled Data Using PSCSV .......................................... 108
  10.6 1133A Scheduled Data Values ....................................................... 108
    10.6.1 Energy Values .................................................................... 108
    10.6.2 Voltage Values ................................................................... 108
    10.6.3 Sequence Values ................................................................. 109
    10.6.4 Frequency Variation Values .................................................. 109
    10.6.5 Flicker .............................................................................. 109
    10.6.6 Harmonics ....................................................................... 109
  10.7 How Energy is Totalized in the Model 1133A ................................... 109
    10.7.1 Example, Totalizing Energy .................................................. 110
11 Functional Description

11.1 Overview ................................................................. 111
11.2 GNSS Synchronization ............................................... 111
11.3 Current Inputs ....................................................... 111
11.4 Voltage Inputs ....................................................... 112
11.5 Self Calibration ..................................................... 112
11.6 Error Analysis ...................................................... 112
11.7 Signal Sampling ..................................................... 112
11.8 Power and Energy ................................................... 112
11.9 Voltage and Current ................................................. 114
11.10 CT and PT Compensation ......................................... 114
11.11 Transformer Compensation ....................................... 114
11.12 DC Offsets ........................................................... 115
11.13 Phase and Frequency .............................................. 115
11.14 Harmonics ............................................................ 116
11.15 Flicker ................................................................. 117
11.16 Interruptions ......................................................... 117
11.17 Voltage Fluctuations ............................................... 117
11.18 System Time Deviation ............................................ 117
11.19 Phasor Measurements ............................................. 117
11.20 Phase Balance ....................................................... 118
11.21 Load Balance ........................................................ 118
11.22 Flash Memory and Event Logging ............................... 118
11.23 Contact Outputs .................................................... 119
11.24 Event Inputs ........................................................ 119
11.25 Serial Channels ..................................................... 119
11.26 Ethernet MMS Interface ........................................... 120
11.27 Triggering in the Model 1133A .................................... 120
11.28 Detecting Oscillatory Transients and Other Anomalies .... 121
  11.28.1 Signal Functions Available for Triggering ............... 122
  11.28.2 Trigger Channel Parameter Summary ....................... 123
  11.28.3 Schulz-Laios Transient Detector Values ................... 123

12 Technical Specifications and Operational Parameters ......... 124

12.1 Scope .................................................................. 124
12.2 Standard Options ................................................... 125
12.3 AC Voltage and Current Inputs ................................... 126
  12.3.1 Input Configurations ........................................... 126
  12.3.2 Input Voltage .................................................... 126
  12.3.3 Input Current .................................................... 126
12.4 Volt-Amps (VA), Watts (W), Volt-Amp-Reactance (VAR) .... 126
12.5 Compensating Constants and Ratios ............................ 126
12.6 Input Frequency Range ............................................. 126
12.7 Input Connector Ratings ........................................... 127
12.8 Instrument Interface ............................................... 127
  12.8.1 Front Panel Indicators and Controls ....................... 127
## CONTENTS

12.8.2 External Interface Connections ........................................ 127
12.8.3 Programmable Contact Output Connections .......................... 127
12.8.4 Event Input Connections .............................................. 128
12.9 Flash Memory Data Storage .............................................. 129
12.10 DSP Configuration ..................................................... 129
12.11 IP Address ............................................................... 130
12.12 Ethernet (Physical) Address ........................................... 130
12.13 Measurement Specifications ............................................ 130
12.14 Power Quality Measurement Capability ................................ 131
  12.14.1 Harmonic Measurements ......................................... 131
  12.14.2 Power Interruptions ............................................... 131
  12.14.3 Flicker ............................................................... 131
12.15 Limit Alarms ............................................................. 132
12.16 System Control and Monitoring ....................................... 132
  12.16.1 System Time, Phase and Frequency ................................. 132
  12.16.2 Phasors .............................................................. 132
12.17 Synchronization ......................................................... 133
  12.17.1 GNSS Information .................................................. 133
  12.17.2 GNSS Antenna & Cable Characteristics .......................... 133
  12.17.3 Synchronization Output - IRIG-B ................................ 133
  12.17.4 Time Base Error .................................................. 134
12.18 Instrument Power Requirements ....................................... 134
12.19 General Specifications ................................................ 134
  12.19.1 Physical Specifications .......................................... 134
  12.19.2 Environmental Specifications .................................... 134

13 DNP 3.0 and MODBUS Data Structures ..................................... 135
  13.1 Introduction ............................................................ 135
  13.2 Definitions and Conventions ......................................... 135
    13.2.1 DNP 3.0 .......................................................... 135
    13.2.2 Modbus .......................................................... 135
    13.2.3 32-Bit Numbers & Little Endian ................................. 136
    13.2.4 Scale Factors ................................................... 136
  13.3 Voltage and Current Data Structure ................................ 137
  13.4 Power Data Structure ................................................. 138
  13.5 Frequency, Flicker and Relative Phase Data Structure .............. 139
  13.6 Harmonic and Harmonic Summary Data Structure .................... 141
  13.7 Individual Harmonic Voltages and Currents ......................... 142
  13.8 Energy Register Values ............................................. 143
  13.9 Trigger Status ....................................................... 144

14 Event Input Voltage Settings ............................................. 145
  14.1 General Information .................................................. 145
  14.2 Event Input Specifications .......................................... 145
  14.3 Standard Event Input Voltage, 24 – 240 Vdc ........................ 145
  14.4 Optional Event Input Voltage, 5 Vdc, Logic Level ................. 145
E.4  Sample 1133A Vorne Output ......................................................... 164

F  Uploading Firmware ................................................................. 165
   F.1  Introduction ........................................................................ 165
   F.2  Firmware Uploading Procedure ............................................. 165
## List of Figures

1.1 Packaging of Accessories ........................................ 2  
1.2 Attaching Rack-Mount Ears ........................................ 3  
2.1 Model 1133A Front Panel Description ............................. 4  
2.2 Model 1133A Rear Panel Description ............................. 6  
2.3 High Voltage Power Inlet ......................................... 7  
2.4 Low Voltage Power Inlet ......................................... 7  
2.5 Antenna Connector ................................................ 7  
2.6 Voltage Input Connector ........................................ 8  
2.7 Current Input Connector ........................................ 8  
2.8 Event Input Connector ........................................ 8  
2.9 IRIG-B Connector ................................................ 9  
2.10 Communication Ports Connectors ................................. 9  
2.11 Relay Contact Connector ....................................... 9  
3.1 Option 03 Power Supply Inlet Connector ....................... 10  
3.2 Option 04 Power Supply Inlet Connector ....................... 11  
3.3 Connection Diagram – DSP Notation, 1Ph2W1E .................. 13  
3.4 Connection Diagram – DSP Notation, 1Ph2W1.5E ............... 14  
3.5 Connection Diagram – DSP Notation, 1Ph3W2E ............... 15  
3.6 Connection Diagram – DSP Notation, 3Ph3W2E ................ 16  
3.7 Connection Diagram – DSP Notation, 3Ph4W2.5E ............... 17  
3.8 Connection Diagram – DSP Notation, 3Ph4W3E ............... 18  
3.9 Relay Contact Connector ....................................... 19  
3.10 Event Input Connector ........................................ 19  
3.11 IRIG-B Connector ............................................... 20  
3.12 RJ-11 Serial Cable Connector Pin Locations .................. 20  
4.1 Antenna Assembly for Mounting ................................ 22  
4.2 Antenna Mounting Bracket ....................................... 23  
4.3 Antenna Mounting with AS0044600 ............................. 23  
4.4 GNSS Surge Arrester ............................................ 24  
5.1 Initial Startup Screen ........................................... 28  
5.2 Copyright Startup Screen ....................................... 28  
5.3 GNSS Status Screen ........................................... 28  
5.4 GNSS Locked Screen ............................................ 29
<table>
<thead>
<tr>
<th>FIGURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.5</td>
<td>Voltage/Current Display</td>
</tr>
<tr>
<td>5.6</td>
<td>Freq./Time Dev. Display</td>
</tr>
<tr>
<td>5.7</td>
<td>Event Log Display</td>
</tr>
<tr>
<td>5.8</td>
<td>Status, Locked Display: GNSS or IRIG-B</td>
</tr>
<tr>
<td>5.9</td>
<td>Status, Location: Latitude and Longitude</td>
</tr>
<tr>
<td>5.10</td>
<td>Status, Date and Time</td>
</tr>
<tr>
<td>5.11</td>
<td>Status, 1133A Configuration</td>
</tr>
<tr>
<td>5.12</td>
<td>Status, 1133A Flash Memory</td>
</tr>
<tr>
<td>5.13</td>
<td>Status, Program Information</td>
</tr>
<tr>
<td>5.14</td>
<td>Status, Calibration Information</td>
</tr>
<tr>
<td>5.15</td>
<td>Status, Ethernet; Address and Subnet Mask – default shown</td>
</tr>
<tr>
<td>5.16</td>
<td>Status, Ethernet; TCP/UDP Port and Physical Address</td>
</tr>
<tr>
<td>5.17</td>
<td>Status, Serial Port Parameters</td>
</tr>
<tr>
<td>5.18</td>
<td>Power Key</td>
</tr>
<tr>
<td>5.19</td>
<td>Energy Key</td>
</tr>
<tr>
<td>5.20</td>
<td>Harmonics Key</td>
</tr>
<tr>
<td>5.21</td>
<td>Flicker Key</td>
</tr>
<tr>
<td>6.1</td>
<td>PSCSV Main Window</td>
</tr>
<tr>
<td>6.2</td>
<td>Main Toolbar</td>
</tr>
<tr>
<td>6.3</td>
<td>Connection Toolbar</td>
</tr>
<tr>
<td>6.4</td>
<td>Broadcast Toolbar</td>
</tr>
<tr>
<td>6.5</td>
<td>Configuration Toolbar</td>
</tr>
<tr>
<td>6.6</td>
<td>Flash Toolbar</td>
</tr>
<tr>
<td>6.7</td>
<td>Input Toolbar</td>
</tr>
<tr>
<td>6.8</td>
<td>Records Toolbar</td>
</tr>
<tr>
<td>6.9</td>
<td>Rear Panel Description</td>
</tr>
<tr>
<td>6.10</td>
<td>Connection List – shows Ethernet selected</td>
</tr>
<tr>
<td>6.11</td>
<td>Connection List – shows RS-232 selected</td>
</tr>
<tr>
<td>6.12</td>
<td>Security Features, Login Window</td>
</tr>
<tr>
<td>6.13</td>
<td>Security, User Permissions Window</td>
</tr>
<tr>
<td>7.1</td>
<td>Configuring COM1 Settings</td>
</tr>
<tr>
<td>7.2</td>
<td>Configuring Ethernet Settings</td>
</tr>
<tr>
<td>7.3</td>
<td>Measurement Parameters Configuration Screen</td>
</tr>
<tr>
<td>7.4</td>
<td>CT Cal. Points</td>
</tr>
<tr>
<td>7.5</td>
<td>Configure IRIG-B Settings</td>
</tr>
<tr>
<td>7.6</td>
<td>Selecting DNP in COM Port 1 Setting</td>
</tr>
<tr>
<td>7.7</td>
<td>Configuring DNP Settings</td>
</tr>
<tr>
<td>7.8</td>
<td>DNP 3.0 Class 0 Definition Selection</td>
</tr>
<tr>
<td>7.9</td>
<td>Selecting MODBUS in COM 1 Settings</td>
</tr>
<tr>
<td>7.10</td>
<td>PMU-1 Configuration</td>
</tr>
<tr>
<td>7.11</td>
<td>8-Cycle, Raised Cosine Rejection Plot and 6-Cycle Rolloff</td>
</tr>
<tr>
<td>7.12</td>
<td>Selecting Digital Channels in C37.118</td>
</tr>
<tr>
<td>7.13</td>
<td>Frequency Alert and Setup Window</td>
</tr>
<tr>
<td>7.14</td>
<td>Shows PMU-1 set to broadcast UDP</td>
</tr>
<tr>
<td>7.15</td>
<td>UDP Configuration Frame Mode and Interval</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>7.16</td>
<td>Configure Relay Parameters</td>
</tr>
<tr>
<td>7.17</td>
<td>Configure Pulse-Per-Hour Mode</td>
</tr>
<tr>
<td>7.18</td>
<td>Configure KYZ Mode</td>
</tr>
<tr>
<td>7.19</td>
<td>Configure KYZ Scale Factors</td>
</tr>
<tr>
<td>7.20</td>
<td>Configure Relays for Trigger Mode</td>
</tr>
<tr>
<td>7.21</td>
<td>Configure Relays for Manual Override Mode</td>
</tr>
<tr>
<td>7.22</td>
<td>Configure Position and Time</td>
</tr>
<tr>
<td>7.23</td>
<td>Configuring Scheduled Data Screen</td>
</tr>
<tr>
<td>7.24</td>
<td>Configuring Time Deviation Screen</td>
</tr>
<tr>
<td>7.25</td>
<td>Security, User Permissions Window</td>
</tr>
<tr>
<td>7.26</td>
<td>Configure Flash Window</td>
</tr>
<tr>
<td>7.27</td>
<td>Flash Status Window</td>
</tr>
<tr>
<td>7.28</td>
<td>Erase Flash Window</td>
</tr>
<tr>
<td>7.29</td>
<td>Create/Edit Configuration File Menu</td>
</tr>
<tr>
<td>7.30</td>
<td>Upload Configuration Window</td>
</tr>
<tr>
<td>8.1</td>
<td>DSP Trigger Setup Screen</td>
</tr>
<tr>
<td>8.2</td>
<td>Power Quality Trigger Setup Screen</td>
</tr>
<tr>
<td>8.3</td>
<td>Hysteresis Plot</td>
</tr>
<tr>
<td>8.4</td>
<td>Configure External Event Inputs Screen</td>
</tr>
<tr>
<td>8.5</td>
<td>Configure Data Logged Screen</td>
</tr>
<tr>
<td>8.6</td>
<td>Configure Logging Parameters Screen</td>
</tr>
<tr>
<td>8.7</td>
<td>Configure Data Items Screen</td>
</tr>
<tr>
<td>8.8</td>
<td>Configuring Event Notification Screen</td>
</tr>
<tr>
<td>8.9</td>
<td>Concluded Event Record Download</td>
</tr>
<tr>
<td>8.10</td>
<td>List of Event Records</td>
</tr>
<tr>
<td>9.1</td>
<td>Basic Data Selection Screen</td>
</tr>
<tr>
<td>9.2</td>
<td>Basic Data Summary Screen</td>
</tr>
<tr>
<td>9.3</td>
<td>Basic Data Spreadsheet Screen</td>
</tr>
<tr>
<td>9.4</td>
<td>Energy Data Summary Screen</td>
</tr>
<tr>
<td>9.5</td>
<td>Energy Data Spreadsheet Screen</td>
</tr>
<tr>
<td>9.6</td>
<td>Harmonic Data Summary Screen</td>
</tr>
<tr>
<td>9.7</td>
<td>Harmonic Data Spreadsheet Screen</td>
</tr>
<tr>
<td>9.8</td>
<td>Harmonic Data Summary Screen</td>
</tr>
<tr>
<td>9.9</td>
<td>Harmonic Data Spreadsheet Screen</td>
</tr>
<tr>
<td>9.10</td>
<td>Waveform Data Screen</td>
</tr>
<tr>
<td>9.11</td>
<td>Phasor Data Screen</td>
</tr>
<tr>
<td>9.12</td>
<td>Phasor-Frequency Plot Data Screen</td>
</tr>
<tr>
<td>9.13</td>
<td>Phase Summary Data Screen</td>
</tr>
<tr>
<td>9.14</td>
<td>Phase Spreadsheet Data Screen</td>
</tr>
<tr>
<td>9.15</td>
<td>Export CSV Format Data Screen</td>
</tr>
<tr>
<td>10.1</td>
<td>Flash Status Screen</td>
</tr>
<tr>
<td>10.2</td>
<td>Scheduled Data Download – Specify Range</td>
</tr>
<tr>
<td>10.3</td>
<td>Scheduled Data – Download Session</td>
</tr>
<tr>
<td>10.4</td>
<td>Scheduled Data – Summary View</td>
</tr>
</tbody>
</table>
10.5 Scheduled Data – Spreadsheet View ........................................... 107
14.1 Event Input Resistor Settings ...................................................... 146
15.1 Comparison Technique A ............................................................ 148
15.2 Comparison Technique B ............................................................. 149
B.1 AS0094500 Surge Arrester ............................................................ 153
B.2 Suggested Mounting of the AS0094500 ......................................... 155
C.1 IRIG-B Waveforms ................................................................. 156
List of Tables

2.1 Annunciator LED Definitions ........................................ 5
2.2 Fault Indications and Definitions .................................. 5
2.3 Command Key Definitions ............................................. 6

3.1 Fuse Chart ............................................................. 11
3.2 Serial Interface Connector Description .............................. 20

4.1 Antenna Mounting Bracket Parts List ................................. 22
4.2 GNSS Cable Data and Accessory Information ......................... 26

5.1 Fault Indications ..................................................... 35

6.1 Types and Uses of 1133A Serial Connections ....................... 43

7.1 Security Definitions ................................................. 71
7.2 Permanent Login Information ........................................ 71

8.1 System Triggers .................................................... 85

9.1 Broadcast Data Choices and Descriptions ............................ 92

11.1 Power & Energy Error Analysis ................................... 113
11.2 Signal Functions Available for Triggering ........................ 122
11.3 Trigger Channel Parameter Summary (32 channels) ............... 123
11.4 Schulz-Laios ......................................................... 123

12.1 1133A Standard Options ........................................... 125
12.2 Temperature and Humidity List ..................................... 134

13.1 Voltage and Current Register Values ............................... 137
13.2 Power Register Values ............................................. 138
13.3 Frequency, Flicker and Relative Phase Register Values .......... 139
13.4 Harmonic and Harmonic Summary Register Values ................ 141
13.5 Individual Harmonic Voltages and Currents ....................... 142
13.6 Energy Values ..................................................... 143
13.7 Trigger Status Values .............................................. 144

14.1 Event Input Specifications .......................................... 145
C.1 IRIG-B Code Designations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
E.1 Vorne 34 Output, Time Deviation Values . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
Chapter 1

Unpacking the 1133A

1.1 Introduction

This section will assist you with unpacking the 1133A from its shipping container; other parts and accessories shipped with the 1133A include:

- 1133A Power Sentinel (includes internal power supply)
- Antenna Cable, 50 feet with connectors (N/A with Option 07)
- GNSS Antenna (N/A with Option 07 – IRIG-B Input)
- Rack-Mount Ears, 2 ea.
- Instrument Manual
- Connector–1 ea., four-terminal for input voltage
- Connector–1 ea., six-terminal for input current
- Connectors–4 ea., three-terminal for contact outputs
- Connectors–5 ea., two-terminal for event inputs and IRIG-B output

1.2 Precautions

**Mechanical Shock.** Note that the GNSS antenna is small and smooth, and can be damaged if dropped. Use care when handling. Remember to store the antenna in a safe place before the final installation.

**Static Discharge.** Note that the Model 1133A is an electronic device and uses static-sensitive components in its operation. Use care when handling against static discharges. Generally, these components are protected in their normal situation, however they are accessible when the cover is removed.

**CAUTION** Timing Input Connector (GNSS or IRIG-B). Connect only the cable coming from the timing source. The timing-input connector leads to static-sensitive components, which could be damaged from high voltage or a static discharge.
1.3 Unpacking and Locating Accessories

The Model 1133A and included accessories are packed between two closed-cell foam shells. Carefully pull apart the two shells to extract the 1133A and accessories. Some of the accessories (i.e. antenna and rack-mount ears) are located in one of these shells for protection. In the diagram below, you can see how the GNSS antenna and rack-mount ears are located in the closed-cell foam marked with the label that reads,

ADDITIONAL PARTS INSIDE

Figure 1.1: Packaging of Accessories

Antenna cable, 1133A and setup guide are located between the two pieces of closed-cell foam. The rack-mount ears and antenna are embedded in the packing foam side labeled ADDITIONAL PARTS INSIDE.

1.4 Attaching Rack-Mount Ears to 1133A

Each Model 1133A comes with two rack-mount ears suitable for mounting in a 19-inch system rack. These ears have four mounting holes, two of which are used to attach them to the sides of the 1133A. Since it is required to remove the M25 screws which attach the cover to the chassis, it may be good to attach the ears after first making any configuration changes inside the 1133A. You will want to return to this section after making these changes.

Mounting Instructions

1. Using a Torx T25 driver or large slot screwdriver, remove the four M25 screws attaching the 1133A cover to the chassis. Use either a T-25 or large slot screwdriver.

2. With the ear facing out from the front panel (see Figure 1.2), match the lower set of holes of the ear to the cover/chassis and remount the M25 screws.

3. Repeat this procedure with the other side of the chassis and other ear.
NOTE: Before installing the rack-mount ears, you might want to determine if you need to configure anything inside the 1133A (e.g. Event Inputs). To install the rack-mount ears requires removal of the top cover screws, which if required would be a good time to make any changes. See Chapter 14, Event Input Voltage Settings, for information on making changes to any of the Event Input modules.
Chapter 2

Front and Rear Panels

2.1 Introduction

This section identifies the connectors, controls, and displays found on the front and rear panels of the Model 1133A. Review all of these items prior to connecting cables to and configuring the Model 1133A.

2.2 Front Panel Controls and Indicators

The Model 1133A front panel has a two-line by 20-character, back lit Liquid Crystal Display (LCD), four annunciator LED’s, and an eight-button keypad. All of the keys are informational only and cannot be used to configure the 1133A. Illustrated in Figure 2.1 are the displays and controls used to determine and configure the operating state of the 1133A.

![Model 1133A Front Panel Description](image)

Figure 2.1: Model 1133A Front Panel Description

Brief definitions for the annunciator LEDs are found in Table 2.1, and definitions for keys in Table 2.2. Accept for the STATUS key on the upper-right position, all of the keys switch the display to read the named electrical parameter(s). For example, press VOLTAGE/CURRENT to view all configured voltages and currents, including sequence components. Press the status key to view all of the main 1133A system details, like Receiver Status, Time and Date.
2.2 Front Panel Controls and Indicators

2.2.1 Annunciator LED Definitions

The four Annunciator LED’s provide a quick reference to the Model 1133A operating status. These LED’s should give you a basic idea if the 1133A is operating correctly.

<table>
<thead>
<tr>
<th>Annunciator LED</th>
<th>Color</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPERATE</td>
<td>Green</td>
<td>1133A is Powered ON</td>
</tr>
<tr>
<td>TIMESET</td>
<td>Green</td>
<td>Time is Stabilized when ON</td>
</tr>
<tr>
<td>UNLOCKED</td>
<td>Red</td>
<td>1133A Not Synchronized when ON</td>
</tr>
<tr>
<td>FAULT</td>
<td>Red</td>
<td>Internal Fault when ON</td>
</tr>
</tbody>
</table>

Table 2.1: Annunciator LED Definitions

The Operate and Stabilized LED’s are green and the Out-of-Lock and Fault LED’s are red. For normal operation, with the internal clock of the Model 1133A locked and accurate, both green LED’s should be ON and both red LED’s should be OFF. The following definitions apply to these indicators:

- **OPERATE**. Indicates that power is being supplied to the Model 1133A.
- **TIME SET**. When ON, indicates that the Model 1133A is locked, that the internal clock is synchronized to the GNSS or IRIG-B signal and that the time is at maximum accuracy.
- **OUT OF LOCK**. Illuminates when the Model 1133A has not yet synchronized, or has lost synchronization, with the GNSS or IRIG-B signal.
- **FAULT**. Illuminates when an internal fault occurs. Faults are listed below.

<table>
<thead>
<tr>
<th>Fault Indication</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Out-of-Lock</td>
<td>GNSS Receiver is not receiving satellite signals.</td>
</tr>
<tr>
<td>Receiver Failure</td>
<td>GNSS receiver is not communicating with the 1133A.</td>
</tr>
<tr>
<td>System Failure</td>
<td>A System Fault is active.</td>
</tr>
</tbody>
</table>

Table 2.2: Fault Indications and Definitions
2.2.2 Command Key Definitions

All command keys provide multiple messages. Press the specific key repeatedly to scroll through the various displays. For example, press the Voltage/Current key (upper left) to scroll through the configured voltages and currents, including sequence components. Note that these keys DO NOT allow you to configure any of the internal functions of the 1133A. Always configure the 1133A through PSCSV, the dedicated software application.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>VOLTAGE/ CURRENT</td>
<td>View all voltages and currents, including sequence components.</td>
</tr>
<tr>
<td>FREQ./TIME DEVIATION</td>
<td>View frequency, frequency deviation and time deviation.</td>
</tr>
<tr>
<td>EVENT LOG</td>
<td>View recorded sequential events.</td>
</tr>
<tr>
<td>STATUS/TIME</td>
<td><strong>Primary:</strong> View GNSS or IRIG-B information, position, time and date, system configuration and memory status. <strong>Secondary:</strong> View serial number, firmware dates, Ethernet settings and parameters, internal hardware address, serial port parameters.</td>
</tr>
<tr>
<td>POWER</td>
<td>View all power related parameters.</td>
</tr>
<tr>
<td>ENERGY</td>
<td>View all energy-related parameters</td>
</tr>
<tr>
<td>HARMONICS</td>
<td>View harmonic-related parameters</td>
</tr>
<tr>
<td>FLICKER</td>
<td>View all flicker-related parameters</td>
</tr>
</tbody>
</table>

Table 2.3: Command Key Definitions

2.3 Rear Panel Connectors and Identification

This section contains information to assist you in identifying where to connect all of the input and output cables on the Model 1133A. Figure 2.2 illustrates the 1133A rear panel.

Figure 2.2: Model 1133A Rear Panel Description
Wire Preparation
DO NOT tin with solder any bare wires connected to rear-panel terminals.

2.3.1 Power Inlet
To cover all of the possible inlet power conditions, Arbiter Systems offers two different power supplies: a low-range DC only and a high-range AC/DC supply. Please examine the paperwork you received with the Model 1133A, to make sure you have correctly identified the inlet power supply. Supply types are listed below:

**Option 03** inlet supply includes terminals with an inlet range of 86 to 264 Vac, 50 to 60 Hz and 110 to 350 Vdc and terminal power strip with surge withstand protect circuitry (illustrated in Figure 2.3)

![Figure 2.3: High Voltage Power Inlet](image)

**Option 04** inlet supply includes an inlet range of 10 to 60 V DC ONLY and terminal power strip with surge withstand protect circuitry (illustrated in Figure 2.4)

![Figure 2.4: Low Voltage Power Inlet](image)

2.3.2 Antenna or IRIG-B Input
A threaded Type-F, GNSS antenna input connector is located on the left of the power inlet connector and it supplies 5 volts to energize the antenna. For models with the Option 07, IRIG-B decoder, a BNC female connector replaces the Type-F connector.

![Figure 2.5: Antenna Connector](image)

Figure 2.5 illustrates the antenna connector. For further information concerning the operation, mounting or troubleshooting antenna problems, see Chapter 4, Antenna and Cable Information.
2.3.3 AC Voltage Inputs

The Model 1133A has a single, Phoenix-style, connector block that connects up to four different phase voltage inputs to the measurement section. Wires are anchored by set screws in the connector plug, and the connector plug is inserted into the connector block on the rear panel. The connector plug is anchored with screws. Figure 2.6 illustrates the connector block on the rear panel.

![Figure 2.6: Voltage Input Connector](image)

2.3.4 AC Current Inputs

The Model 1133A has a single, Phoenix-style, connector block that connects up to three different phase current inputs to the measurement section. Wires are anchored by set screws in the connector plug, and the connector plug is inserted into the connector block on the rear panel. The connector plug is anchored with screws. Figure 2.7 illustrates the connector block on the rear panel.

![Figure 2.7: Current Input Connector](image)

2.3.5 Event Inputs

The Model 1133A has four two-terminal connectors (illustrated in Figure 2.8) for timing external events based on the GNSS-synchronized time, of from an IRIG-B signal. Since events can range widely in voltage level, inputs may be configured for different ranges. See Chapter 14 for additional information on setting the event input voltage level.

![Figure 2.8: Event Input Connector](image)
2.3.6 **IRIG-B Timing Output**

The Model 1133A has one high-drive, unmodulated IRIG-B, timing output that uses a terminal connector as seen in Figure 2.9. This output may also be “Tee’ed” for parallel-connected loads. For more information concerning how to connect any timing output in parallel, for distribution, see Section 3.5 and Appendix C.

![Figure 2.9: IRIG-B Connector](image)

2.3.7 **Communication Ports**

The Model 1133A has two identical communication ports with your choice of RS-232, RS-485 or modem, and one Ethernet port (illustrated in Figure 2.10). Generally, for RS-232 communications, you will only need pins 2, 3 and 5 using a null-modem cable. For more information, see Chapter 3, Section 3.6.1 on the serial interface, Chapter 6 on page 42 for connecting basics, and Section 12.8.2 for specifications.

![Figure 2.10: Communication Ports Connectors](image)

2.3.8 **Form C Contacts**

The Model 1133A has four sets of Form C relay contacts (illustrated in Figure 2.11) that have three contact points: Normally Open (NO), Normally Closed (NC) and Common (C), where the "normal" condition means the 1133A powered OFF. For information on how to connect to them and their specifications, see Chapter 3, Section 3.3, Relay Contact Outputs.

![Figure 2.11: Relay Contact Connector](image)
Chapter 3

Connecting Inlet Power, Input and Output Signals

3.1 Introduction

This section should assist you with connecting all of the input and output wiring except for the GNSS antenna and cables. For antenna and cable information, please see Chapter 4.

Wire Preparation

*NOTE: DO NOT tin with solder any bare wires connected to rear-panel terminals.*

3.1.1 Connecting Inlet Power

To provide for a wide range of inlet power sources, the 1133A can be ordered with either of two different power supplies: a low-range DC only and a high-range AC/DC supply. Each of the power inlet module connectors are illustrated here and also in Chapter 2. Take time to examine the power inlet module connection on your Model 1133A to verify that it is correct according to your order. Make sure to check the inlet module before connecting power to the 1133A.

3.1.2 Option 03, 110 to 350 Vdc Terminal Power Strip, Surge Withstand

The power inlet connector for Option 03 is a 3-pole terminal strip and provides input surge protection for compliance with ANSI C37.90-1 and IEC 801-4. Input voltages are: 85 Vac to 264 Vac, 47 Hz to 440 Hz, or 110 Vdc to 350 Vdc, less than 20 Watts typical.

Figure 3.1: Option 03 Power Supply Inlet Connector
Option 03, Connecting Inlet Power

When wiring this power supply, make sure to first connect an earth ground wire to the terminal strip connector labeled “G” (for ground). Positive and negative terminals are marked on the terminals as “+” and “−”. After connecting a ground wire, connect the positive and negative leads from the station batteries to the corresponding Option 03 terminals. See Figure 3.1.

3.1.3 Option 04, 10 Vdc to 60 Vdc ONLY, Terminal Power Strip Surge Withstand

The power inlet connector for Option 04 is a 3-pole terminal strip and provides input surge protection for compliance with ANSI C37.90-1 and IEC 801-4. Option 04 operates from common low-voltage battery systems, including 12, 24, and 48 Vdc.

Figure 3.2: Option 04 Power Supply Inlet Connector

Option 04, Connecting Inlet Power

When wiring station batteries to this power supply, make sure to first connect an earth ground wire to the terminal strip connector labeled “G” (for ground). Positive and negative terminals are marked on the terminals as “+” and “−”. After connecting a ground wire, connect the positive and negative leads from the station batteries to the corresponding Option 04 terminals. See Figure 3.2.

3.1.4 Fuse Locations and Types

Use the fusing table below for identifying the correct fuse for your option power supply. Note that the fuse is located adjacent to the terminals as depicted in Figures 3.1 and 3.2.

<table>
<thead>
<tr>
<th>PS Option</th>
<th>Arbiter P/N</th>
<th>Fuse ID</th>
<th>Size, mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>03</td>
<td>FU0001816</td>
<td>F1AL250V</td>
<td>5 x 20</td>
</tr>
<tr>
<td>04</td>
<td>FU0001419</td>
<td>T2AL250V</td>
<td>5 x 20</td>
</tr>
</tbody>
</table>

Table 3.1: Fuse Chart

Replacing Fuses

To replace the fuse, first disconnect inlet power from the 1133A. Using a flat-blade screwdriver, turn the fuse cover counter-clockwise (CCW) and it should pop outward. Replace fuse with the same size and type.
Option 03 and 04 fuses are located in a separate threaded compartment (see Figures 3.1 and 3.2). To check the fuse, use a small flat-bladed screwdriver and turn the cover counter-clockwise. The cover and fuse should pop out. CAUTION: Replace fuse only with another of the same type and rating. See Table 3.1 for the correct fuse configured for your option.

3.2 Connecting Voltage and Current Signals

The following pages contain various diagrams that describe how to connect the 1133A to several common types of power system configurations. Please refer to this section for connecting currents and voltages.

3.2.1 AC Voltage Inputs

Do not exceed maximum voltage limit of 600 Vrms. Use extreme caution when working with high voltages. Attach voltage signal wires to the supplied 4-pin, female connector-plug using the compression screws. Insert the connector-plug into the male connector (shown at right) on the 1133A and tighten the safety locking screws.

Prior to applying the voltages to the AC Voltage Inputs, use DSP Mode to set up the input range of the 1133A. DSP Mode is found under “Configuring Measurement Parameters” in Section 7.4.

3.2.2 AC Current Inputs

Do not exceed the maximum current limit of 20 Arms. Use extreme caution when working with high voltages. Attach current signal wires to the supplied 6-pin, female connector-plug using the compression screws. Insert the connector-plug into the male connector on the 1133A and tighten the safety locking screws.

Prior to applying currents to the AC Currents Inputs, use DSP Mode to set up the input range of the 1133A. DSP Mode is found under “Configuring Measurement Parameters” in Section 7.4.

3.2.3 Electrical System Connection Diagrams

Listed on the following pages are six common electrical system connection diagrams that should provide additional assistance with connecting system wiring to the main electrical inputs on the Model 1133A.
1133A Single-Phase, Two-Wire, One-Element Circuits with Current and Potential Transformers

Figure 3.3: Connection Diagram – DSP Notation, 1Ph2W1E
1133A Single-Phase, Two-Wire, One and One Half Element Circuits with Current and Potential Transformers

![Connection Diagram - DSP Notation, 1Ph2W1.5E](image)

Figure 3.4: Connection Diagram – DSP Notation, 1Ph2W1.5E
1133A Single-Phase, Three-Wire, Two Element Circuits with Current and Potential Transformers

![Connection Diagram - DSP Notation, 1Ph3W2E](image)

- **A**, **B**, **C** = Phase inputs
- **1**, **2**, **3**, **4** = Current transformer outputs
- **1.2 MΩ** = Transformer impedance
- **Detection Circuitry** and **MUX**
- **Configure Internal Connections with PSCSV Software**

REAR PANEL VIEW

- **AC CURRENT INPUT**
  - **A**, **B**, **C**: 20 Arms MAX.
- **AC VOLTAGE INPUT**
  - **1**, **2**, **3**, **4**: 600 Vrms MAX.

*In PSCSV Software, connect to 1133A, choose Configure Measurement Parameters > Input Configuration > 1Ph 3w 2e

Figure 3.5: Connection Diagram – DSP Notation, 1Ph3W2E
1133A Three-Phase, Three-Wire, Two-Element Delta Circuits with Current and Potential Transformers

Figure 3.6: Connection Diagram – DSP Notation, 3Ph3W2E

= AC voltage and current input connectors

*In PSCSV Software, connect to 1133A, choose Configure Measurement Parameters > Input Configuration > 3Ph 3w 2e
1133A Three-Phase, Four-Wire, Two and One Half-Element Circuits with Current and Potential Transformers

Figure 3.7: Connection Diagram – DSP Notation, 3Ph4W2.5E
1133A Three-Phase, Four-Wire, Three-Element Circuits with Current and Potential Transformers

Figure 3.8: Connection Diagram – DSP Notation, 3Ph4W3E
3.3 Relay Contact Outputs

Do not exceed the maximum contact output ratings. For mechanical relays (standard), 250 Vac/125 Vdc, 8 A, 2 kVA/150 W max. For solid state relays (optional, KYZ) 350 Vac/Vdc, 0.12 A continuous, 0.36 A peak (100 ms).

Figure 3.9: Relay Contact Connector

Use extreme caution when working with high voltages. Each set of contact outputs is marked with a normally closed and normally open symbol as shown on the right, where “normally” refers to the 1133A powered OFF. Use care to select the appropriate side of these contacts for correct indication. Attach contact output wires to the supplied 3-pin, female connector-plugs using the compression screws. One, 3-pin female connector block is used for each set of contacts. Insert the connector-plug into the male connector on the 1133A. The contact output connectors lock in position, but do not have safety-locking screws to anchor the connector.

3.4 Event Inputs

Do not exceed the maximum Event Input ratings of 24-240 Vdc max. Event Inputs may be configured for 5 V logic level, and require a bias resistor change on the main board. See Chapter 14 for details on configuring the input voltages to 5 Vdc. Use extreme caution when working with high voltages.

Figure 3.10: Event Input Connector

Attach event-input wires to the supplied 2-pin, female connector-plugs using the compression screws according to the configuration diagram. Observe polarity markings. One, 2-pin female connector block is used for each event input. Insert the connector-plug into the male connector on the 1133A. The Event-Input connectors lock in position, but do not have safety locking screws to anchor the connector.

3.5 IRIG-B Output

IRIG-B outputs are 5-V, CMOS-level voltages used to synchronize any equipment that requires IRIG-B specific data format. The IRIG-B output is marked with polarity markings for correct connection. Attach IRIG-B output wires to the supplied 2-pin, female connector-plug according to the polarity markings shown in Figure 3.11. Use a BNC breakout to convert to coax.\(^1\)

For additional details on connecting and distributing IRIG-B, please see the material on IRIG-B located in the Appendix C of this manual, and documents on the Arbiter web site[3].

\(^1\)Pomona Electronics, www.pomonaelectronics.com, (800) 444-6785, (425) 446-6010, part no. 4969 and 4970.
3.6 Data Connections

Table 3.2 lists the electrical connections for the two serial ports on the Model 1133A. The section below also describes the Ethernet connector.

3.6.1 Serial Interface Connections

The 1133A has three standard communication ports: two RJ-11 serial and one RJ-45 Ethernet. The two RJ-11 serial interface connectors may be optionally configured for RS-232C, RS-485, or V.34bis Modem. Choose the serial port option at the time of order. Standard serial cable connectors are (normally) a DB-9F at the computer and RJ-11M at the 1133A. A standard phone cord and RJ-11 to DB-9F adapter work well connecting the 1133A to a computer. Modem connections may be a standard phone cable. Pin connections are shown below.

<table>
<thead>
<tr>
<th>RS232C Functions</th>
<th>DB-9F Pins</th>
<th>RJ-11 Pins</th>
<th>RS-485 Functions</th>
<th>Modem Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ground</td>
<td>5</td>
<td>1</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Transmit (Ring)</td>
<td>2</td>
<td>2</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>Receive (Tip)</td>
<td>3</td>
<td>3</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>–</td>
<td>N/C</td>
<td>4</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>

Table 3.2: Serial Interface Connector Description

3.6.2 Ethernet Interface Connections

One IEEE 10base-T interface connector (see Figure 3.12) allows connection of the 1133A directly to a network (Conforms to the IEEE 802.3i) using one RJ-45 connector. To configure the IEEE 10base-T Interface, see Configure Ports – Ethernet in Section 7.3.
Chapter 4

GNSS Antenna and Cable Information

The Model 1133A comes complete with the necessary hardware to be able to receive GNSS signals: 50-feet of RG-6 cable and a GNSS antenna. Longer cables are available up to 250 feet (75 meters).

This section should help you with installing the GNSS antenna and antenna cabling to the 1133A. It should also be a source of information if you should need to troubleshoot the antenna cable system. The Model 1133A achieves its accuracy by comparing the internal clock signal of the Model 1133A to the incoming GNSS or optional IRIG-B signal.

4.1 GNSS Antenna Installation

To properly receive GNSS signals, the GNSS antenna needs to be mounted clear of buildings and surrounding elements that would block the GNSS signals being transmitted by the satellites. For complete coverage, the antenna needs to have a clear view of the sky from 15 degrees above the horizon to directly overhead for all points of the compass. Minimal installations, where the antenna is mounted in a less favorable location, may work however reception may be somewhat limited during certain hours of the day.

4.1.1 Mounting the Antenna

To mount the antenna, you will need a short piece of gray, 3/4 inch plastic pipe nipple that can be attached to a solid fixture. The piece of pipe nipple should be threaded up into the antenna receptacle after connecting the antenna cable to the antenna. Arbiter Systems sells an antenna mounting kit (part no. AS0044600) that simplifies antenna installation for a variety of locations. Figures 4.1, 4.2 and 4.3 illustrate several components for a suggested mounting method.
Antenna mounting procedure:

1. Thread the RG-6 antenna cable through the plastic pipe
2. Tighten the Type F male connector to the antenna connector
3. Thread the plastic pipe into the antenna
4. Mount the plastic pipe and antenna/cable assembly to a fixture

4.1.2 Optional Antenna Mounting Bracket

The AS0044600 Antenna Mounting Kit (part no. AS0044600) is designed specifically for use with antennas shipped with the Model 1133A, Power Sentinel. The hardware included with the bracket allows installation of the antenna on a mast or pipe up to about 2” in diameter, and a different clamp may be substituted for use with a larger diameter pipe. Also, the bracket can be mounted to a wall, a roof, or any other flat surface.

For complete details on this product request Installation Instructions for Arbiter Systems GNSS Antenna Mounting Bracket on document number PD0024700A. All metallic hardware is stainless steel.

<table>
<thead>
<tr>
<th>Qty</th>
<th>Description</th>
<th>ASI P/N</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GNSS antenna mounting bracket</td>
<td>HD0052700</td>
</tr>
<tr>
<td>1</td>
<td>U-bolt, 1-1/8 inch, with 2 hex nuts</td>
<td>HP0014700</td>
</tr>
<tr>
<td>1</td>
<td>3/4 inch x 4 inch threaded pipe, PVC, schedule 80</td>
<td>HP0014800</td>
</tr>
<tr>
<td>1</td>
<td>Hose clamp, worm drive</td>
<td>HP0014900</td>
</tr>
<tr>
<td>1</td>
<td>Mounting bracket stabilizer</td>
<td>HD0054200</td>
</tr>
</tbody>
</table>

Table 4.1: Antenna Mounting Bracket Parts List
4.1 GNSS Antenna Installation

Figure 4.2: Antenna Mounting Bracket

Figure 4.3: Antenna Mounting with AS0044600
4.2 Verifying Antenna and Cable Operation

A two-color operate LED, located at the base of the antenna, indicates proper antenna operation. GREEN indicates proper operation (i.e. the antenna is getting the correct voltage); ORANGE indicates improper operation (i.e. the voltage is low).

4.2.1 Checking the Antenna Voltage

The Model 1133A provides +5 Vdc to the GNSS antenna, which is carried through the antenna cable. Nominal antenna current is 30 mA. Check the voltage at the antenna connector on the rear panel. Without the 5-volt signal, the clock will not synchronize with the Global Positioning System and will generate an out-of-lock alarm.

4.2.2 Power Supply Check

The Antenna Voltage test (above) actually tests the main power supply voltage of the Model 1133A. This signal should be between 4.9 and 5.1 Vdc.

4.2.3 Checking the Antenna Resistance

Checking the internal resistance of the Arbiter GNSS antenna is not as useful as verifying the antenna operation mentioned above. Antenna resistance measures several megohms with meter probes at one polarity and less so if you change the meter probe polarity.

4.3 GNSS Surge Arrester

Figure 4.4 illustrates the GNSS surge arrester kit (P/N AS0094500), which is mounted in line with the antenna cable. The surge suppressor has two female F connectors and a ground lug with hardware for connecting to a solid ground. The case is also ground.

![Figure 4.4: GNSS Surge Arrester](image)

4.3.1 Using the Antenna Surge Arrester

Before installation, review the documentation on this device found in Appendix B. The AS0094500 surge arrester is weatherproof except for the F connectors, which may be sealed with rubber port seals or GE Silicone II compound.
4.4 Technical Details on GNSS, Antennas and Cables

4.4.1 Antenna Cable

Length and Loss Considerations

Standard Antenna Cable

The standard antenna cable assembly included with the Model 1133A is constructed using a 15-meter (50-foot) length of RG-6 type low-loss coaxial cable, terminated with male Type F connectors. Optional lengths of RG-6 coax are separately available for longer runs; see Table 4.2, Cable Data and Accessory Information.

Effects of Cable Parameters

To receive GNSS signals and properly operate the 1133A, the type and length of the cable are important. Due to their effect on specific parameters described in the following paragraphs, any changes to the length and/or type of antenna cable should be made carefully. Damaged cables may also affect performance.

Cable Delay

Cable delay is the time required for the GNSS signal to travel from the GNSS antenna to the GNSS receiver inside the Model 1133A. The velocity factor, the length and type of cable determine the cable delay. In very precise laboratory applications it may be necessary to compensate for this delay. However in the Model 1133A, used for phasor and frequency measurement of power systems, it is not significant enough to require compensation as long as you stay within the cables mentioned in Table 4.2.

Attenuation

Attenuation depends upon the cable length, and the loss per unit length. The total attenuation must be limited to 21 dB (maximum) at the GPS L1 frequency of 1575.42 MHz. Loss up to 42 dB can be accommodated with the separately available 21-dB in-line preamplifier (AS0044700).

DC Resistance

The cross-sectional area and length of the conductors in the cable determine the dc resistance. Since power to the RF preamplifier in the antenna is supplied via the antenna cable, excessive dc resistance will degrade performance.

Available Antenna Cables and Accessories for Longer Runs

Arbiter Systems offers longer antenna cables for use with the Model 1133A Power Sentinel when the standard 15-meter (50-foot) cable is inadequate. For RG-6 cable runs greater than 250 feet, up to 500 feet, Arbiter offers a 21-dB in-line amplifier, P/N AS0044700. A larger RG-11 style cable is available (P/N WC0004900, 305-m / 1000-ft roll), that can be used for runs to 120 meters (400 feet) without the in-line preamplifier, or 240 meters (800 feet) with the AS0044700 amplifier.
<table>
<thead>
<tr>
<th>Part No.</th>
<th>Description</th>
<th>Delay, ns</th>
<th>Loss</th>
</tr>
</thead>
<tbody>
<tr>
<td>CA0021315</td>
<td>15-m (50-ft) cable, RG-6</td>
<td>60 ns</td>
<td>-5 dB</td>
</tr>
<tr>
<td>CA0021330</td>
<td>30-m (100-ft) cable, RG-6</td>
<td>119 ns</td>
<td>-9 dB</td>
</tr>
<tr>
<td>CA0021345</td>
<td>45-m (150-ft) cable, RG-6</td>
<td>177 ns</td>
<td>-13 dB</td>
</tr>
<tr>
<td>CA0021360</td>
<td>60-m (200-ft) cable, RG-6</td>
<td>236 ns</td>
<td>-17 dB</td>
</tr>
<tr>
<td>CA0021375</td>
<td>75-m (250-ft) cable, RG-6</td>
<td>295 ns</td>
<td>-21 dB</td>
</tr>
<tr>
<td>WC0004900</td>
<td>305-m (1000-ft) roll RG-11</td>
<td>3.92 ns/m</td>
<td>-17.5 dB/100 m</td>
</tr>
<tr>
<td>AS0044600</td>
<td>Kit, crimp tool and 25 connectors, RG-11</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>AS0044700</td>
<td>21-dB in-line amplifier</td>
<td>1 ns</td>
<td>+21 dB</td>
</tr>
</tbody>
</table>

Table 4.2: GNSS Cable Data and Accessory Information

**Physical Protection**

When routing the antenna cable, protect it from physical damage, which may result from closing doors, falling objects, foot traffic, etc. Also, when routing around corners, allow for sufficient bend radius to prevent kinks. Extra length should be allowed at both ends of the cable to prevent tension on the connectors, which could cause damage or failure. Extra length is useful as a service loop, in the event that a connector needs replacement.

Do not stretch the cable mid-air over any appreciable distance without support. Cable degradation or failure could result. Always leave a drip loop wherever the cable enters a structure, to prevent water from entering the structure via the cable jacket. The maximum temperature rating for the type of cable provided with the 1133A is 75°C (167°F). Exercise care when routing the cable near sources of heat to avoid cable damage.

**Adjacent Signals**

Although the standard RG-6 style cable is triple-shielded and has excellent shielding properties, be cautious when routing near high power RF sources or alongside cables carrying high power RF, such as transmitter cables. In these applications, consider using RG-11 style cable (P/N WC0004900). Its quad-shielded design provides even more isolation.

**Antenna Power**

The RF preamplifier within the antenna requires 5 Vdc at 30 mA maximum for operation. A power supply within the Model 1133A generates this voltage, which is applied to the antenna via the two conductors of the coaxial antenna cable. Avoid shorting the center conductor to the shield of the coaxial cable as it may damage the preamplifier. Conversely, a high-resistance connection or open circuit would deprive the preamplifier of power. Either a short- or open-circuit condition in the antenna cable will render the 1133A inoperable.

Prior to initial operation or if problems are suspected, perform the Antenna/Cable Operational Test described above in Section 4.2.
Connecting to the Antenna and the Model 1133A

The male Type F connector on one end of the antenna cable mates with the female Type F connector on the antenna. Avoid placing mechanical stress on the cable attachment to the antenna. The male Type F connector on the opposite end of the antenna cable connects to the female Type F connector on the rear panel of the Model 1133A.

User-Supplied Antenna Cables

Any RF cable meeting the requirements described above for loss (<21 dB at 1575.42 MHz) and dc resistance (<15 ohms total loop resistance) may be used with the Model 1133A. However, prior to using a non-standard antenna cable, verify proper antenna operation described in Section 4.2.

For additional technical details concerning the GNSS, GNSS antennas and antenna cabling see Chapter 12, Technical Details and Specifications.
Chapter 5

Startup Operation and Indication

5.1 Startup

This chapter addresses the startup and initial operation immediately following the application of inlet power to the Model 1133A. It addresses the activity of the specific annunciator LED’s and display indications, so that you will know what to expect when applying power. When you apply power to the Model 1133A, startup should begin with the Annunciator LED’s flashing briefly and the LCD display indicating some initial startup information as illustrated below.

5.1.1 Startup Display Indications

After applying inlet power to the 1133A, you should see the three specific LCD display indications shown below in sequence. Each should persist for several seconds before changing to the next. There should be no change after the third display indication until the GNSS begins tracking satellites and it will indicate that number. As the GNSS begins acquiring satellites, the tracking number will count up to a total possible satellites of twelve.

5.1.2 Locked Indication

Sometime after the 1133A indicates that it is tracking four satellites, at initial startup, the word “STARTUP” will change to “LOCKED.” This number of satellites is required to establish a new

Figure 5.1: Initial Startup Screen

Figure 5.2: Copyright Startup Screen

Figure 5.3: GNSS Status Screen
geographical position for the 1133A. After the 1133A has initially found its position, a subsequent startup may produce a LOCKED indication after tracking only one or two satellites. Other indications are “VCO LOCK ERROR” and “UNLOCK XX MIN,” where “XX” can be from 0 to 99 minutes.

5.1.3 Annunciator LED Startup Indications
Initially, the annunciator LED’s should all flash, and then the Operate and Unlocked LED should be ON; the Timeset and Fault LED’s should be OFF. After about 30 minutes of internal clock stabilization, the Unlocked LED should go OFF, and about five minutes later the Timeset LED should go ON. The Timeset LED serves to indicate that the internal clock is locked to the GNSS and the time is accurate to within the guaranteed specification (see Chapter 12).

5.1.4 Viewing Electrical Parameters
Pressing specific command keys reveals those specific averaged – once per second – electrical parameters. Details of these parameters and what you should see are explained in the next section, Overview of Command Keys.

5.2 Overview of Command Keys
Seven of the front-panel command keys enable you to view specific measured electrical parameters, and one key – the status key – provides details of the 1133A operational status. Command keys are not used to configure the Model 1133A.

5.2.1 Voltage/Current Key
Press the VOLTAGE/CURRENT key successively to view magnitude and phase angle for each measured line voltage and current. Phase voltages and currents are listed as “A”, “B”, “C”, “0”, “1” and “2,” “A”, “B”, and “C” label each of the voltage and current phases, and “0”, “1” and “2” are labels for each of the sequence voltages and currents. The first illustration below shows the “A” phase voltage and current, magnitude and phase angle. The second shows the 0 Sequence values.

Figure 5.5: Voltage/Current Display

| V: 117.147V | 0.9520A |
| 96.533° | 13.493° |

| O: 0.952V | 0.0020A |
| 133.516° | -2.352° |
5.2.2 Frequency/Time Deviation Key

Press the FREQ./TIME DEV key twice: once to view the measured line frequency and GNSS time; a second time to view the signed error in system frequency, and the integrated total time deviation. Resolution of time deviation is in milliseconds.

![Figure 5.6: Freq./Time Dev. Display](image)

5.2.3 Event Log Key

Press the EVENT LOG key successively to sequence through the events logged into the 1133A flash memory. Events are numbered and labeled according to type of event (e.g. over voltage) and “date and time stamped.”

![Figure 5.7: Event Log Display](image)

5.2.4 Status/Time Keys – Primary Functions

Press the Status/Time key to view any one of five, primary instrument status menus, which are given here in sequential order. Continue pressing this key to cycle to a previous Status/Time view. Press and hold the Status/Time key for approximately three seconds to access either the primary or secondary instrument status menus.

**Status, Receiver Condition**

Status, Receiver Condition – GNSS: Locked or Unlocked with number of satellites Visible and Tracked. IRIG-B: (Option 7) Locked or Unlocked with time quality indicator.

![Figure 5.8: Status, Locked Display: GNSS or IRIG-B](image)
5.2 Overview of Command Keys

Status, Location; Latitude and Longitude

Press the Status/Time key to reveal geographical position with no elevation. Location provides GNSS antenna position only, it is not available with IRIG-B input (Option 7).

![Figure 5.9: Status, Location: Latitude and Longitude](image)

**LAT 35° 35′ 50.18″**
**LOG 120° 41′ 34.83″**

Status, Date and Time - UTC or Local

Pressing the Status/Time key will display the date and time in UTC or Local time format. It also indicates the Julian Day. Use PSCSV to configure the time format for either UTC or Local. Time and Date information, in both UTC and Local format, accompanies all data, whether broadcast or recorded in Flash through an internal trigger or a data register.

![Figure 5.10: Status, Date and Time](image)

**LCL WED 02 OCT 2002**
**275 20:37:34**

Status, Mode, Range and Electrical Configuration

This status display includes the electrical configuration (e.g. 3 phase, 4-wire, 3-element), system frequency and input signal ranges.

![Figure 5.11: Status, 1133A Configuration](image)

**3φ4W3E 150V x1:C0**
**60HZ MAX2.5A x1:C0**

Status, Flash Memory

Indicates memory available in recording time, percent available and ROM error status.

![Figure 5.12: Status, 1133A Flash Memory](image)

**MEM 99DAYS 99% AVAIL
CONFIG ROM NO ERRORS**
5.2.5 Status/Time Keys – Secondary Functions

To view any of the secondary status functions, press and hold the Status/Time key for three seconds. It should shift to the second set of status functions. To return to primary status functions, press and hold the Status/Time key for three seconds.

Press the Status/Time key to view any one of five, secondary instrument status menus, which are given here in sequential order. Continue pressing this key to return to a previous Status/Time view.

Status, Program ROM Information

Press the Status/Time key to view the program ROM Serial Number and Date, and the DSP ROM Identification Date. To access this screen, see Section 5.2.5 notes.

Status, Calibration Information

Press the Status/Time key to view the calibration information – last calibration and calibration due date. To access this screen, see Section 5.2.5 notes.

Status – Ethernet, IP Address and Subnet Mask

Press the Status/Time key to view the IP address and subnet mask. See Section 5.2.5 notes to access this screen. To change any Ethernet communications parameter, see Section 7.3, “Configure Ports – Ethernet”. Once the IP Address is changed, the 1133A must be power cycled for the new IP address to take effect.
5.2 Overview of Command Keys

Status, Ethernet; TCP/UDP Port and Physical Address

Press the Status/Time key to view the TCP/UDP values and physical address. To access this screen, see Section 5.2.5 notes. Configure TCP and UDP values only from PSCSV – for details, see Section 7.3, “Configure Ports – Ethernet”. After changing the TCP or UDP values, power cycle the 1133A for the new values to take effect. In this example, BC-61-4E is the unit serial number in hexadecimal notation (in decimal it is 12345678).

![Figure 5.16: Status, Ethernet; TCP/UDP Port and Physical Address](image)

```
TCP:17000 UDP:17000
00-01-B3-BC-61-4E
```

Status, Serial Port Parameters

Press the Status/Time key to view the serial port communication settings for SERIAL 1 and SERIAL 2. See Section 5.2.5 notes to access this screen. To configure serial port settings, see “Configuring an 1133A Communications Port” in Section 7.2.

![Figure 5.17: Status, Serial Port Parameters](image)

```
1:38400,8,1,N RS232
2:38400,8,1,N MODEM
```

5.2.6 Power Key

Press the POWER key successively to view the four power screens. Each screen lists all of the available power information (kW, PF, kVA and kVAR) for one of the three phases and total (e.g. A, B, C and T).

![Figure 5.18: Power Key](image)

```
A:8.492 kW 0.9939 PF
  8.541 VA -0.49 VAR
```

5.2.7 Energy Key

Press the ENERGY key successively to view the four Energy screens. Each screen lists all of the available energy information (kWh, kVAh, and kVARh) for one of three phases and total (A, B, C and T).

![Figure 5.19: Energy Key](image)

```
2.031 kWh 2.084 kVAh
A: -0.213 kVARh
```
5.2.8 Harmonics Key

Press the HARMONICS key successively to view the harmonics data that applies to the measured electrical system. Each screen lists the total harmonic voltage and current, and THD for each of the measured phases.

![Figure 5.20: Harmonics Key](image)

A: 8.626V 0.0746A
THD 8.510% 7.774%

5.2.9 Flicker Key

Press the FLICKER key once to view voltage and current flicker measurements for all of the three phases.

![Figure 5.21: Flicker Key](image)

A:0.14  B:0.18  C:0.45
I:0.13    0.12    0.56

5.3 Unlocked and System Fault Indication

Should there be a System Fault with the operation of the 1133A, the Unlocked and/or Fault Annunciator LED may switch ON. A System Fault alarm occurs with hardware/firmware failures with the 1133A itself; it is *not a generated fault from the measured electrical system*. When the Unlocked LED switches ON, it indicates that the 1133A has lost synchronization with the GNSS satellites.

5.3.1 Unlocked Indication

Normally, throughout the day you should see the TRACK number change as satellites pass across the sky, in and out of view of the GNSS antenna. If there is a problem with the satellites, antenna, cable or GNSS receiver, there may be a time when it will indicate zero satellites tracked and the Unlocked LED will turn ON. It is a very remote possibility that there would be a problem with the satellites, however more likely that there is a problem with the antenna/cable combination. Most likely problems are installation problems, such as a bad cable/antenna connection, or that the antenna or cable was damaged or has failed.

If the Unlocked LED should not switch OFF at startup, or remain ON after the normal amount of time, it may indicate that there is a problem with the antenna/cable connection. To troubleshoot the antenna/cable system, please refer to Section 4.2, Antenna and Cable Testing.

5.3.2 Fault Indication

If the Fault LED should switch ON, you may be able to view the reason for the fault directly on the display. These faults are hardware-related faults that could occur due to problems with memory
overruns. If the fault is severe enough, it may not be possible for the display to provide a reason for the fault. Listed below are some of the possible reasons for a Fault LED switching ON.

<table>
<thead>
<tr>
<th>Fault Listed</th>
<th>Indication, LEDs ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-maskable interrupt error</td>
<td>Fault LED only</td>
</tr>
<tr>
<td>Stack overflow</td>
<td>Fault and Operate LED’s</td>
</tr>
<tr>
<td>Stack underflow</td>
<td>Fault and Timeset LED’s</td>
</tr>
<tr>
<td>Class B hardware error includes:</td>
<td>Fault and Unlock LED’s</td>
</tr>
<tr>
<td>- Undefined Opcode</td>
<td></td>
</tr>
<tr>
<td>- Protected Instruction Fault</td>
<td></td>
</tr>
<tr>
<td>- Illegal Word Operand Access</td>
<td></td>
</tr>
<tr>
<td>- Illegal Instruction Access</td>
<td></td>
</tr>
<tr>
<td>- Illegal External Bus Access</td>
<td></td>
</tr>
</tbody>
</table>

Table 5.1: Fault Indications

If the fault is not severe enough to lock out use of the LCD display or keypad, the display will indicate one of the faults listed in Table 5.1. These faults can normally be cleared by recycling power to the Model 1133A. A severe fault, that cannot be cleared by recycling power, should be immediately reported to Arbiter Systems technical support. If you do not see your fault listed here, call the factory for assistance. See page ii for contact information.
Chapter 6

PSCSV Basics – Starting, Connecting and Logging In

6.1 Introduction

6.1.1 Getting Started

This chapter was written to assist you in setting up and operating the 1133A Power Sentinel using PSCSV software. PSCSV provides direct and complete control over all of the features of the 1133A. No other tool is available to configure the 1133A, however other software applications may be used to collect data, especially with the new synchrophasor specification, C37.118.

Topics covered in this chapter include:

- Buttons, Windows, Toolbars and Menus
- Connecting with the 1133A
- Logging In

Opening a connection is the first step in successfully operating the 1133A. Prior to operation, however, determine what type of connection you need to configure. The 1133A provides several types of connection options: RS-232, RS-485, Modem and Ethernet (RJ-45). For more information on connections, see Connecting with the 1133A.

Security features provide administrative control over user permissions and various levels of access. For more information on Security, see 1133A Security.

6.1.2 Triggering from the DSP, Power Quality, and from I/O Connections

Set up to 32 different triggers based various DSP parameters, power quality conditions or event input conditions. For details on configuring triggers, see Working with Triggers and Downloading Event Data.

6.1.3 C37.118 Phasor Broadcast

Configure phasor broadcasts compliant with the IEEE Standard C37.118. For details, see Configure Ports – C37.118 Synchrophasor Protocol in Section 7.8.
6.1.4 Power Quality, DNP and Modbus

Poll specific data from the 1133A using either DNP or Modbus, from the two serial ports or Ethernet port. To configure any port for DNP or Modbus protocol, see Configuring DNP and Modbus in Sections 7.6 and 7.7. For specific DNP 3.0 and Modbus data codes, see Chapter 13.

6.1.5 Scheduled Data, Relays and KYZ Pulses

The 1133A comes configured with four SPDT Form C, multi-function relays. For configuring these multifunction relays see “Configuring Multimode Relays” in Section 7.10. If you want to use these relays for KYZ pulse metering, make sure to order Option 06, KYZ–Rated Solid-State Relays.

6.2 Menus, Toolbars, Buttons and Windows

The PSCSV main screen shown in Figure 6.1 provides access to its many features by assembling them together according to functional groups called menus, toolbars, function buttons and windows. Most of the functions are not available until a user is connected to a specific port and logged on using a specific user account. For information on connecting see “Connecting with the 1133A” in Section 6.4, for logging on and user accounts see Section 6.4.12 and for 1133A security see Section 7.14.

![PSCSV Main Window](image.png)

Figure 6.1: PSCSV Main Window

6.2.1 Moving and Viewing Features

Move any toolbar and dock it around the main window by selecting and holding one of the toolbar handles and dragging the toolbar to a preferred location. Use “View” on the main menu to switch toolbars ON or OFF depending on need and available space.
6.3 Toolbar and Button Definitions

6.3.1 Main Toolbar

Main Toolbar Items: Open a PSCSV file, Export to CSV File, Create a Snapshot, Copy, PSCSV Home page.

Open: Opens a specific 1133A file - has browse features.

Export to CSV File: Exports selected 1133A file records to CSV format for use with spreadsheets.

Create a Snap Shot: Opens the Save As window for saving current data to a separate file.

Copy: Copies selected records in a file under review in the main window of PSCSV.


6.3.2 Connection Toolbar

Connection Toolbar Items: Opens or closes a connection, , Login As, Connection window.

Open a Connection: Opens a new connection window for selecting a specific 1133A and selecting a serial or Ethernet port.

Close Connection: Immediately closes the current open connection (shown in the Connection Window) between the 1133A and a computer.

Login As: Opens the login window for entering user names and passwords.

Connection Window: Displays the current open connection by name.

6.3.3 Broadcast Toolbar

Clicking on one of the items in the Broadcast toolbar opens the specific Save As window for saving the chosen broadcast data. Select OK if you agree to the supplied file name or type in your own filename, and the broadcast should start.

Broadcast Toolbar Items: Stop All, Stop This, Pause, Basic, Energy, Harmonic, Harmonic Summary, Waveform, PMU-1, PMU-2, Relative Phase.

Stop All: Stops all broadcast data streaming from the 1133A.

Stop This: Stops the current broadcast data and leaves other broadcasts alone.
6.3 Toolbar and Button Definitions

Pause: Pauses the data from flowing into Main Window.

Basic Data: Initiates the flow of Basic data into the Main Window.

Energy Data: Initiates the flow of Energy data into the Main Window.

Harmonic Data: Initiates the flow of Harmonic data into the Main Window.

Harmonic Summary: Initiates the flow of Harmonic Summary data into the Main Window.

Waveform Data: Initiates the flow of Waveform data into the Main Window.

PMU-1 Data: Initiates the flow of PMU-1 data into the Main Window.

PMU-2 Data: Initiates the flow of PMU-2 data into the Main Window.

Phase Data: Initiates the flow of Relative Phase Data into the Main Window.

6.3.4 Configuration Toolbar

Figure 6.5: Configuration Toolbar

Configuration Toolbar Items: Unit Information, Configuration Ports Info, Configure Measurement, Configure Scheduled, Configure Trigger Parameters, Configure Kp Scaling, Configure Relays, Configure UDP.

Unit Information: Provides specific information of the 1133A, e.g. serial number, IP address, firmware version, calibration.

Configure Ports: Opens the configure ports window. Configuration includes all data ports in the 1133A.

Configure Measurement: Opens measurement parameters window. Configuration includes DSP parameters mode, CT/PT cal, XFMR loss and Anti-Creep.

Configure Scheduled: Opens the configure scheduled storage window. Includes all scheduled storage choices and frequency.

Configure Trigger Parameters: Opens trigger configuration window. Provides access into the various triggering setup functions and event notification.

Configure Kp: Configures Kp (KYZ) register scaling for selected measured quantities.

Configure Relays: Opens configure relays window. Provides access to the relay setup mode: Triggers, Pulse-per-Hour and KYZ pulse metering.

Configure UDP: Opens the UDP broadcasting window. Selects data to be broadcast over the Ethernet and broadcasts when clicking the Apply button.

6.3.5 Flash Toolbar

The Flash Toolbar provides a place for you to manage the flash memory module, and stored records in the flash module. The memory module is divided up into two adjustable sections: memory
allocated for scheduled records and memory allocated for event records.

Figure 6.6: Flash Toolbar

**Flash Toolbar Items:** (in order) Flash Memory Status, Configure Flash, Erase Flash, Download Scheduled, Erase Scheduled, Download Event, Erase Event.

**Flash Memory Status:** Opens flash memory status window. Provides a flash memory status summary, for scheduled and event data.

**Configure Flash:** Opens the configure flash window. Controls the partition size of available flash memory devoted to scheduled and event records.

**Erase Flash:** Opens the erase flash memory window. Selects all records to be erased.

**Download Scheduled:** Opens the download scheduled window. Selects scheduled records for download.

**Erase Scheduled:** Opens the erase scheduled window. Selects scheduled records to be erased.

**Download Event:** Opens the download event window. Selects event records for download.

**Erase Event:** Opens the erase event window. Selects event records to be erased.

### 6.3.6 Input Toolbar

Figure 6.7: Input Toolbar

**Input Toolbar Items:** (in order) Channel A Voltage (also B and C), Channel A Current (also B and C), Channel N (Neutral) Current, Increase Scale, Decrease Scale.

**Channel A-B-C Voltages:** Voltage channel input buttons turn ON or OFF (in the PSCSV window) the specific signal when broadcast waveform, or phasor data are present.

**Channel A-B-C Currents:** Current channel input buttons turn ON or OFF (in the PSCSV window) the specific signal when broadcast waveform or broadcast phasor data are present.

**Increase Vertical Scale:** Increase the vertical scale resolution when viewing phasor data.

**Decrease Vertical Scale:** Decrease the vertical scale resolution when viewing phasor data.
6.3 Toolbar and Button Definitions

6.3.7 Records Toolbar
The records toolbar allows you to move forward and backward through a PSCSV file for specific records. Records are noted with a date and time stamp shown in the window.

![Records Toolbar](image)

Figure 6.8: Records Toolbar

6.3.8 View Menu
Use the View Menu to control the appearance of data streaming from the Model 1133A. Items that can be controlled are:

- **Time Format**: Allows the time format accompanying data in either Local or UTC.
- **Data Filters**: Controls the data being viewed on the screen.
- **Waveform Smoothing**: Reduces discontinuities in waveform data.
- **Time Interval**: Changes the time scale for waveform and phasor data - similar to an oscilloscope – to expand or compress the horizontal scale. Certain values are only available under preset viewing conditions.
- **View As**: Allows you to view most data in real time or spreadsheet, harmonics also as vertical bars and phasors as a vector or frequency plot.
- **Toolbars**: Switch any (or all) of the toolbars ON or OFF.

6.3.9 Edit Menu

- **Copy**: Copies the selected data to the clipboard.
- **Select All**: Selects all of the data in the Data Window.
- **Preferences**: Allows you to select the Time as either Local or UTC, Daylight Saving Time changeovers, colors of the data (graphical or tabular), and font style and size.
6.4 Connecting with the 1133A

6.4.1 Introduction

There are two basic steps to connecting with the 1133A:

1. Make sure a physical connection exists between an 1133A port and a computer.\(^1\)
2. Open a specific communication port using PSCSV (e.g. RS-232, RS-485 or Ethernet).

6.4.2 Communication Ports

Connection options are (1) for SERIAL 1 and 2 including RS-232, RS-485 and Modem, and (2) IEEE 802.3I 10base-T, Ethernet. Available protocols include TCP/IP, Modbus, DNP 3.0 and IEEE Std C37.118.

Making a Physical Connection

Connectors for communications are at the left side on the rear panel. Three connectors are visible and identified as SERIAL 1, SERIAL 2 and 802.3I 10base-T as seen in Figure 6.9.

1. Identify the specific serial port to be used. If necessary, recheck documentation with your purchase order. Serial ports are located on the left side of the rear panel diagram.

2. Verify the serial port option. Identification boxes adjacent to the port labels are marked RS-232, RS-485, or Modem. Every 1133A has an IEEE 802.3I, 10base-T port as shown to the right of the two serial ports.

3. RS-232: Connect a phone cable to serial port 1 or 2 on the 1133A, depending on options. If necessary, connect the other end of the phone cable into a DB-9F to RJ-11 Adapter. Connect the adapter into the chosen COM port on the computer. See Table 3.2 in the operation manual for a list of wire connections.

4. RS-485: Connect the RS-485 cable (with RJ-11 connector) to serial port 1 or 2 depending on the options. See Table 3.2 in the operation manual for a list of wire connections.

5. Modem: Connect the phone cord from the telephone outlet to serial port 1 or 2 depending on the installed options. See Table 3.2 in the operation manual for a list of wire connections.

\(^1\)A physical connection could be an RS-232/485 cable between the 1133A and a computer, a 10base-T cable connection to a network, or a telephone line. Once the appropriate cable is in place, you can go to the next step of selecting an existing port configuration to open. After connecting, 1133A ports may be reconfigured for different purposes.
6. IEEE 802.3I: Connect the Ethernet cable from a hub into the RJ-45 connector (IEEE 802.3I port) at the rear of the 1133A. If you encounter problems see Appendix A, “Working with Ethernet Connections,” on page 151.

Serial Connection Summary

<table>
<thead>
<tr>
<th>Connector</th>
<th>Communication Standard</th>
<th>Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERIAL-1</td>
<td>RS-232, RS-485, Modem, DNP 3.0, Modbus</td>
<td>Trans/Rec</td>
</tr>
<tr>
<td>SERIAL-2</td>
<td>RS-232, RS-485, Modem, DNP 3.0, Modbus</td>
<td>Trans/Rec</td>
</tr>
<tr>
<td>IEEE 802.3I</td>
<td>TCP/IP, DNP 3.0, Modbus</td>
<td>Trans/Rec</td>
</tr>
<tr>
<td>IEEE 802.3I</td>
<td>UDP Broadcast</td>
<td>Trans</td>
</tr>
<tr>
<td>IRIG-B</td>
<td>IRIG-B000, Unmodulated</td>
<td>Trans</td>
</tr>
<tr>
<td>Contact Outputs</td>
<td>KYZ (SPDT, Form A/ Form B solid-state contact)</td>
<td>Trans</td>
</tr>
</tbody>
</table>

Table 6.1: Types and Uses of 1133A Serial Connections

6.4.3 Starting PSCSV

1. Verify that PSCSV is installed on the computer. If necessary download from www.arbiter.com/.

2. Start PSCSV. Select the shortcut on the desktop, or use the Windows desktop Start menu.

3. Check the buttons on the Main and the Connection Toolbars. Several of the buttons should be active, including the Folder, Question Mark and Open Connection.

6.4.4 Checking Communication Parameters on the 1133A

1. Press and hold the STATUS/TIME button on the 1133A for about three seconds and release when you see the display change to another set of menus.

2. Keep pressing the STATUS/TIME button until you view the desired communications port menu. To see a list of the various menus on the 1133A, see “Status/Time Button Secondary Functions” in Section 5.2.5.

6.4.5 Opening a Connection

To configure the 1133A and access any stored data on it, you must open a connection between your pc and the Model 1133A. The connection type can be RS-232, RS-485, internal modem and Ethernet. An open connection is signified by a connection name appearing in the Connection Window, and some new active icons.

Before attempting to make the software connection, make sure to connect a cable between the your pc and the 1133A. For RS-232, RS-485 and modem, the connector is RJ-11 using a common phone cord. For Ethernet, the connector is RJ-45 and using a CAT-5 cable.
1. Prior to connecting, the Main Toolbar and the Connection Toolbar should appear with several icon buttons active: Open a File, PSCSV Homepage and Open a Connection.

2. First-time users can open communications with the 1133A by selecting Connection > Open or by clicking the Open a Connection button.

3. Select a connection from the list as shown in the left pane of the Connection Window. Expand the connection type from the list shown in the left pane by selecting the “+” sign. This should expand the list to a specific COM port or IP Address.

**RS–232 and RS–485**

Select the desired COM port that appears in the left pane (either RS-232 or 485), and the communication parameters should appear in the right pane of the Communication window. Note that these communication parameters refer to the computer connected to the 1133A.

**Modem**

Select Modem on COM1 or COM2 and the selection window should provide a space to type in the phone number and initialization string. Parameters refer to the computer / modem connected to the 1133A.

**Ethernet TCP**

1. Select the “+” next to Ethernet TCP. If connecting for the first time, choose “Default,” and the parameters should be similar to those shown in Figure 6.10. Those listed are the default values installed at the factory. The IP Address is for the 1133A connected to the network.

2. Select OK and the port should open.

3. Later, you can add, remove or rename any of these connections. See Section 7.3 on page 50 for more information.
4. If successful, and a specific port is opened, then many more of the menu buttons will become active on the toolbars. These include all of the Broadcast Data Toolbar, the Close Connection button, the Login Key symbol and some of the flash memory buttons.

5. When the connection opens, you should be logged in with the Login Name “anon.” This account provides basic permissions. For advanced permissions, log in using a login name with these permissions. To configure the 1133A permissions, see “1133A Security” in Section 7.14.

**Ethernet UDP (Broadcast Only)**

Select Ethernet UDP to be able to receive a UDP broadcast from a Model 1133A. A UDP broadcast is only available if a UDP broadcast was first started in the 1133A. To start a UDP broadcast (in Arbiter protocol), see Broadcasting UDP Data in Section 7.9.1.

1. Select the “+” next to Ethernet UDP (Broadcast Only). If connecting for the first time, choose “Default,” and the parameters should be similar to those shown in Figure 6.10.

2. Enter the IP address of the 1133A from you wish to receive a UDP broadcast, and click the OK button.

3. Icons on the Broadcast toolbar should now be active. Choose the one which was set to broadcast as chosen in Section 7.9.1.

4. A SaveAs window should appear in which you can type in a name for the UDP data file. Type in a name and click the OK button.

5. Data should accumulate in the window and be saved to a file.

6. Switch UDP data OFF and ON by using the UDP window described in Section 7.9.1.

### 6.4.6 Adding a TCP or UDP Connection

You may add an Ethernet TCP or UDP connection to the to PSCSV in order to connect to additional 1133A devices To add another Ethernet connection:

1. Click Connection > Open or click the Open Connection button.

2. Expand the Ethernet TCP or UDP tree (by clicking the plus sign next to Ethernet TCP or Ethernet UDP.

3. Select the Default connection name and click the Add button. A new Default name should appear in the Connection window.

4. Select the new “Default” name and click the Rename button and edit the name.

5. Type in the new Ethernet IP address and Port number in the spaces.

6. Click OK to accept and open the new connection.
6.4.7 Renaming a TCP or UDP Connection

From the Connection window, select an Ethernet TCP or UDP connection name and click the Rename button. Type in the new name and press Enter to confirm the new name. Select OK to open the connection.

6.4.8 Removing a TCP or UDP Connection

From the Connection window, select an Ethernet TCP or UDP connection name and click the remove button; the connection should disappear.

6.4.9 Closing a Connection

To close an open connection, select Connection > Close or select the Close connection button and the port should close. Closing a communication port may deactivate certain Toolbar buttons as an indication of the port being closed.

6.4.10 Automatic Connection Closure

An open port that is inactive for 10 minutes will be closed automatically.

6.4.11 Special Note on 115200 Baud Rates

The default Win32 serial drivers are not capable of reliably sustaining baud rates of 115200. If PSCSV detects any hardware and or serial driver communication errors, a warning dialog will pop up and indicate Read and Write Errors. For more reliable communication, it is best to choose a slower baud rate. Downloading Scheduled data may be slower, however reliability will improve.

6.4.12 Logging In to the 1133A

Use the Login feature to increase the functionality in PSCSV. Initially, PSCSV opens with the login name “anon.” This allows anyone access to download broadcast data. If security is disabled, then all functions are available. The admin account provides permission to configure everything in the 1133A using PSCSV. The admin password may be changed but the Login Name “admin” is permanent.

Figure 6.12: Security Features, Login Window

1. Select Connection > Login As or select the Login As button on the Connection Toolbar to open the Login Window.
2. Type in the new login name and password. Click Login, or press ENTER, and the new functions should be visible with additional buttons becoming active.

3. PSCSV will issue a warning that the attempted login failed if either the login name or password was entered incorrectly.

6.4.13 Logging In Using admin

For complete control over user permissions, log in with the log in name “admin.” Normally, this procedure would be performed by a system administrator, who would set up user names with specific passwords. Initially, the 1133A gives this control by the default Login Name “admin” and the password “801n60”, which is case sensitive.

Figure 6.13: Security, User Permissions Window

Notice that the permissions window is divided into two sections: Basic Permissions and Advanced Permissions. For more information on 1133A Security and assigning user permissions, see Section 7.14.
Chapter 7

Configuring the Model 1133A

7.1 Introduction

This section covers configuring the 1133A and all of its functions. It is not possible to configure the 1133A from the front panel keypad. Configure the 1133A with PSCSV software. After configuring the 1133A, data may be retrieved using PSCSV or any other software tool that works with C37.118, DNP 3.0 or Modbus protocols.

7.1.1 1133A Configuration Options by Section

- Communication Port Settings
- C37.118 Synchrophasors
- Measurement Parameters
- 1133A Security
- Kp Register Scale Factors
- UDP Broadcasting
- Position and Time
- DNP 3.0 and Modbus
- Scheduled Data Storage
- Set Time Deviation
- Relays or Contact Outputs
- Flash Memory Management

7.1.2 Basic Configuration Requirements

1. Open a connection with the 1133A using PSCSV software. If necessary, see Section 6.4 for basic information on connecting.
2. Log in to the 1133A with permission to configure. See Section 6.4.12

Any time you wish to configure the 1133A, make sure to meet these two requirements. For information on opening a connection with the 1133A, see Chapter 6. If you do not have permission to configure, you will need to review 1133A Security in Section 7.14, or see your system administrator to set up permission.

7.2 Configuring an 1133A Communication Port

Use PSCSV to configure a port on the 1133A. “Configuring a Port” means setting up the specific communication parameters of a given communication port in the Model 1133A.

WARNING: Do not change the communication port parameters of the same port being used to communicate with the 1133A; an Invalid Data window will appear, and communications will be terminated.
7.2 Configuring an 1133A Communication Port

7.2.1 To view COM Port Settings on the 1133A

Press and hold the STATUS/TIME button for three seconds and release when menu item changes (it should indicate the Serial Number, ROM date and DSP date). Then, continue pressing the STATUS/TIME button until the port settings are in view. See Section 5.2.5 for details on the display indications.

7.2.2 Configure Ports – Communication Ports 1 and 2

Configure Communication Ports 1 and 2 in the same manner; they are both identical in structure in PSCSV, except that each port may be RS-232, RS-485 or Modem. When you configure a port on the 1133A, you are changing the port attributes, or settings. Do not change the port settings on the same port that you are connected. Doing so will disconnect you.

![Figure 7.1: Configuring COM1 Settings](image)

1. Make sure that you have permission to configure. If you are not sure, see Section 7.14.
2. Select Connection > Configure > Communication Ports (Shift + Ctrl + C) or click the Configure Ports button. Select Communication Port 1 or 2 on the left panel and you should see a list of port setting Descriptions and Values. See Figure 7.1.
3. Make sure to check the Protocol when first setting up the port settings. In this example, the Protocol is set to C37.118. Other Protocol selections are None, DNP, Modbus and Vorne.
4. If you are planning to collect Broadcast data using PSCSV, then it would be acceptable to set Protocol to “None.”
5. Make any other setting changes based on the type of Protocol as the values change with chosen protocol.

   (a) For C37.118 on Communication Port 1 or 2, make sure to check down to switch it to ON under C37.118 Phasor (at the bottom of the list on the left panel).
   (b) For DNP Protocol, make sure to check all of the settings under DNP Settings.
(c) For Modbus, make sure to select the Modbus RTU Mode below.
(d) For Vorne Output, make sure to check the Vorne Output. Select time zone and voltage phase: UTC AV, UTC BV, UTC CV, Local AV, Local BV, Local CV. See Appendix E

6. Click the OK button if you are finished configuring, otherwise continue configuring other options.

### 7.3 Configure Ports - Ethernet

This section describes setting up the basic values for the 1133A Ethernet port. This includes the IP address, subnet mask and Port Number. All of the different protocols are available except Vorne, which is not defined for Ethernet.

1. Begin configuring the Ethernet port by opening the Configure Ports window and selecting Ethernet on the left panel. **NOTE:** Power cycle the 1133A after configuring the IP Address, Subnet Mask, and Port Number or the new values will not be active. Prior to power-cycling, the front panel will reflect the new IP address, but the new connection parameters will not be activated without power cycling the unit.

2. It is best to use this window for two things: (1) viewing the Ethernet connection and (2) making Protocol changes. If you want to change the port settings on the active connection, you will still be connected at the previous settings. Only after power-cycling the 1133A will the new settings become active.

3. If the connection protocol is Modbus, choose ON or OFF for the desired action and then click the OK button.

4. If the connection protocol is DNP, choose ON or OFF for the desired action and choose a value for Max App Frag Size (see Section 7.6). Values range from 1 to 2048.

5. If the desired connection protocol is C37.118, then you will need to decide if you want to use PMU-1, PMU-2 or PMU-3 Ghost.
7.3.1 Additional Information on Ethernet Connections

Setting up an Ethernet connection may require some additional diagnostics. Listed below are System tools that may provide assistance. Generally, if there is a connection problem, it will either be a hardware problem, such as a bad or unconnected cable, or a setup problem in either the PC or 1133A. For extra help with configuring Ethernet settings, see Appendix A.

7.3.2 Check the Computer Network Settings with ipconfig

In Windows 2000 or XP, type “ipconfig” at the command prompt. It should list the DNS information, IP address, Subnet Mask and Default Gateway.

7.3.3 Ping the 1133A Port

One method of checking to see if a device has a valid connection through a network is to ping it to see if it responds. Below is an example of “pinging” an 1133A Ethernet port at IP address 192.168.0.232, on the same network as the computer.

C:\ping 192.168.0.232

Pinging 192.168.0.232 with 32 bytes of data:

Reply from 192.168.0.232 bytes = 32 time = 15 ms TTL=64
Reply from 192.168.0.232 bytes = 32 time = 4 ms TTL=64
Reply from 192.168.0.232 bytes = 32 time = 9 ms TTL=64
Reply from 192.168.0.232 bytes = 32 time = 12 ms TTL=64

Ping Statistics
Packets sent = 4, Received = 4, Lost = 0 (0% lost)
Approximate round trip times in milliseconds:
Minimum = 4 ms, Maximum = 15 ms, Average = 9 ms

If there is no connection, then the ping test will time out, four times. Other connection issues may be present, and results returned from the test. There must be a valid response from “pinging” the 1133A for it to communicate using PSCSV.

Additional information on trouble shooting Ethernet connections is given in Appendix A: Working with Ethernet Connections.

7.4 Configuring Measurement Parameters

Measurement Parameters include all of the values stored in 1133A for defining the measured electrical system, for calibration, to compensate for measuring the primary currents and voltages, and many other constants. These are depicted in Figure 7.3, which has a number of selection tabs described below.

◦ **DSP Mode:** Sets the measured electrical system values (e.g. voltage, current, system phase(s) and nominal frequency. See also Figure 5.11 on page 31 for display examples.

◦ **CTPT:** Sets calibration points for current transformers and potential transformers
- **Loss Compensation**: Compensates for copper loss and hysteresis in transformers.
- **Anti-Creep**: Thresholds set the minimum value at which the meter begins to “turn.”
- **Internal Calibration**: Sets the 1133A internal calibration constants; set by the factory.
- **Voltage Linearity Correction**: Helps compensate for non-linear variations in calibrated values.

![Figure 7.3: Measurement Parameters Configuration Screen](image)

1. Make certain that there is an open connection with the 1133A and that you are logged on with permission to configure. If you are not, see “Basic Configuration Requirements” in the introduction of this section.

2. From the PSCSV, select Connection > Configure > Measurement Parameters, or click the measurement parameters button. Choose DSP Mode to select the type of electrical system being measured. Allowed electrical systems are listed in each category drop-down list. See also Section 3.2.3 for additional details on electrical connections.

3. Select the CTPT tab to reveal the installation area, and type in the required values. *At the least, always enter a value in Calibration Point 1 for all phases.* The 1133A uses these as defaults for all cal points if all others are missing. Without this, the 1133A may represent current phase angles 180 degrees out of phase with the voltage. If you are not entering in a CT ratio, enter a value of “1” for CT calibration points based on input configuration as seen in the Figure 7.4. If out of phase by 180°, add 180 to “CT Error Phase 1” for each configured phase.

![Figure 7.4: CT Cal. Points](image)

4. Select Loss Compensation to install transformer constants for transformer secondary-side metering, if it is used.
5. Select Anti-creep to set the minimum meter recognition values; select one for each phase. To enable Anti-Creep, first select Anti-Creep ON under DSP Mode tab.
6. Do not select Internal Calibration. These are factory-installed, internal calibration values used to standardize the 1133A accuracy.
7. Click Apply to install these values and OK to close the window.

### 7.5 Configure Ports – IRIG-B

To configure the IRIG-B output from the 1133A requires only two settings be configured: set the Time Mode to UTC or Local, and select the 1344 Mode ON or OFF. The screen shot in Figure 7.5 illustrates where to adjust these settings. The 1344 Mode refers to the C37.118 specification for Phasors.

Click the Time Mode arrow and choose either UTC or Local. UTC stands for Universal Time Coordinated, based on the Prime Meridian that passes through Greenwich, England.

![Figure 7.5: Configure IRIG-B Settings](image)

**IEEE-1344 MODE ON**

Click the 1344 Mode arrow and select either Disable or Enable. When enabled, it turns on the CF (Control Function) portion of the IRIG-B code, which includes the following items: Year – two digits, Leap Second Pending (LSP) – 1 bit, Leap Second (LS) – 1 bit, Daylight Saving Pending (DSP) – 1 bit, Daylight Saving Time (DST) – 1 bit, Time offset sign – 1 bit, Time offset – 4 bits, Time Quality – 4 bits, Parity – 1 bit.

**IEEE-1344 MODE OFF**

When Disabled the IRIG-B time code is sent without the extra values in the Control Function group. Only the BCD (Binary Coded Decimal) and SBS (Straight Binary Seconds) are transmitted.
7.6 Configure Ports – DNP 3.0 Protocol

DNP 3.0 (Distributed Network Protocol) is a set of communications protocols used between components in process automation systems. It is mainly used by utilities such as electric and water companies. When configured, the 1133A will respond to Class 0 polling commands for data using DNP 3.0 protocol. These commands may originate from application software or devices programmed to poll the 1133A for Class 0 data.

While DNP data can be accessed through SERIAL 1, SERIAL 2, and the Ethernet port (using other software), DNP 3.0 is configured through the Configure Ports window shown below. This PSCSV interface allows you to configure all of the settings necessary for using your DNP 3.0 utility.

1. Make certain that there is an open connection with the 1133A and that you are logged on with permission to configure. If you are not, see “Basic Configuration Requirements” in the introduction of this section.

2. Select Connection > Configure > Communication Ports or click the Communication Ports button. In the left panel, select the port that you wish to configure. Figure 7.6 shows Communications Port 1 selected with the Protocol drop down list revealed.

3. Configure DNP scaling values from the same (Configure Ports) window, however move down the list on the left panel and select DNP. This will open another panel for DNP Settings. See Figure 7.7 for details on DNP Settings. Choose appropriate values and click OK.

Max App Frag Size refers to the size in bytes of application messages packaged into fragments, and may be up to 2048 bytes.

7.6.1 Configuring Class 0 Data

DNP Class 0 is a predefined data set, however some older relays are only able to poll for a limited set of Class 0 data. In a sense it is not really Class 0, once limited. However, to accommodate these older devices, you can alter the definition of Class 0 by selecting from the lists exactly the type...
of DNP 3.0 data required by your equipment. Selections include (1) Basic Data, (2) Frequency Data, (3) Harmonic Summary Data, (4) Harmonic Voltage and Current Data of all channels (to the fiftieth harmonic), and (5) Energy Register data. The selection window is shown in Figure 7.8 below.

![Figure 7.8: DNP 3.0 Class 0 Definition Selection](image)

1. Select Connection > Configure > DNP Class 0 Definitions.
2. Select the data category button, then each box identifying the required data.
3. Click the “Apply” button, then click “OK.”
4. DNP 3.0 Class 0 data should now be identified according to your requirement.
7.7 Configure Ports – Modbus

Modbus is a serial communications protocol published by Modicon in 1979 for use with its programmable logic controllers (PLC’s), and is now the most commonly available means of connecting industrial electronic devices. To configure the 1133A to communication using Modbus protocol, you will need to configure the desired port to use it and then set some simple configuration options.

The 1133A will respond to polling of specific Modbus commands, whether by a software application or specialize device. PSCSV does not communicate using Modbus.

1. Open the Configure Ports window and select the port you wish to use on the left panel. On the right panel choose Modbus protocol. The configuration screens for Communication Ports 1 and 2 differ somewhat from Ethernet. Communication Port 1 is selected in Figure 7.9. For Communication Port 1 and 2, select Protocol Modbus. For Ethernet, select Modbus ON.

![Figure 7.9: Selecting MODBUS in COM 1 Settings](image)

2. After selecting the protocol for the port, select the Modbus item on the left panel. Choose the Address value (See figure below) and click OK.

![Figure 7.9: Selecting MODBUS in COM 1 Settings](image)

3. Notice that in Figure 7.9 that RTU Mode is selected (next to arrow cursor). The other choice is ASCII Mode.
7.8 Configure Ports – C37.118 Synchrophasor Protocol

Purpose and Background

The purpose of this section is to provide specific details of how to configure the 1133A to respond correctly to C37.118 commands with synchrophasor data. PSCSV does not allow you to receive or record actual C37.118 data. Use a specific “C37.118” application for that. PSCSV can view C37.118-type phasor data, however certain elements are missing or added that support PSCSV protocol that do not comply with the C37.118 specification.

7.8.1 Setup

To set up the 1133A to communicate using C37.118, you will need to configure the port being used for C37.118, and set up some values used by C37.118. This will normally take two or three steps, which are outlined below.

Basic Steps in Configuring C37.118 Synchrophasors

- Use PSCSV to configure the desired 1133A port for C37.118 protocol.
- Use PSCSV to configure PMU-1, PMU-2, or PMU-3 Ghost.
- Start your PDC application, or C37.118 software.

Details

1. Connect to the 1133A using PSCSV software with permission to configure.
2. From the left panel in the Configure Ports window, select the desired port with which you wish to communicate – Communications Port 1, 2 or Ethernet. Select PMU-1, PMU-2 or PMU-3 Ghost; under Protocol select either TCP or one of the UDP modes.
3. For example, under PMU-1 C37.118 Protocol, choose TCP, and if desired choose the port number. Choosing one of the UDP modes provides additional settings (grayed out).
4. Next, you will need to configure each of the PMU’s. These are listed as PMU-1 C37.118, PMU-2 C37.118 and PMU-3 C37.118 Ghost. PMU-1 and PMU-2 are separate but identical in setup, however PMU-3 Ghost is really a pre-configured subset of Basic Data from PMU-1 or PMU-2. Data possibilities for Ghost PMU are explained on page 60.

7.8.2 PMU Setup Terms and Definitions

The definitions for the terms found in the PMU-1 and PMU-2 setup window are shown in Figure 7.10. Open the window by selecting Connection > Configure > Communication Ports, or by clicking the Configure Ports button and selecting PMU-1 or PMU-2.

Active means that PMU-1 or PMU-2 is poised and ready to send data - set to ON if you want it to be active. Set to OFF if you want it to be inactive (or unresponsive).

Station (or STN) is the station name, in 16 bytes in ASCII format, given to either of the two virtual PMUs. This field helps to identify the location of the equipment.
**ID** (or IDCODE) is the 16-bit integer, assigned by the user that uniquely identifies the device sending and receiving messages (in this case, the 1133A). Essentially, this means that no two devices can have the same ID on the same network.

**Header** contains additional information on any subject concerning the PMU, of 64 bytes in ASCII format. Type in the information and press the Enter key. This field could be used to identify the type of equipment.

**Input** allows you to select the type of signals you want to include in the C37.118 report or broadcast. This includes all phase voltages and currents, Positive Sequence, Negative Sequence, Zero Sequence components and Digital DSP Triggers. Turn them ON or OFF.

**Analog** allows you to select all of the power-related parameters (Watts, VARs, and VA) that you wish to view and turn them either ON or OFF.

**Window Length** sets the integer number of measurements averaged for stability; small values give faster, less stable readings; values range from 1 to 24 – *do not set to zero.*
7.8 Configure Ports – C37.118 Synchrophasor Protocol

**Estimated Rate, Hz**\(^1\) is the integer number of samples per second. Rate values are different for 50 Hz (1, 2, 5, 10, 25, 50) and 60 Hz (1, 2, 3, 4, 5, 6, 10, 12, 15, 20, 30, 60).

**Cycles Used** is a calculated value based on multiplying the Estimated Rate times the Window Length in cycles. Cycles used = \(20 \times 6 = 120\) in Figure 7.10. Cycles Used maximum values are determined by a maximum window length of 16 or less, depending on the value for Estimated Rate. Maximum cycles is 400 when combining PMU-1 and PMU-2.

**Data Format** allows you to set up the computation resolution, however it affects the speed of which the 1133A processor can send data.

**Nominal Frequency** – choose either 50 Hz or 60 Hz nominal

**Adaptive Tuning** is used to help eliminate the possibility of losing the signal due to filter rolloff effects by continuously adjusting the receiver center frequency. Adaptive tuning is disabled if the error exceeds the limit. Set to \(\pm 2, \pm 5\) or \(\pm 10\) Hz.

### 7.8.3 Window Functions

The Model 1133A offers a wide range of of window functions, which may optimize phasor output for individual applications. Specifically, two values, found in the setup window, combine to provide windowing function: Estimator Algorithm and Window Length in cycles.

Window functions all serve the same purpose (as a low pass filter) and work in the same basic way to filter higher frequency components. The main difference is the magnitude of the sideband lobes, which are peaks in the rejection band.

Window functions are also called “weighting functions” because they work by multiplying the input signal time record by an equal-length sequence of constants, or weighting factors.

**Estimator Algorithms** include nine types, as listed below.

- Raised Cosine
- Hann
- Hamming
- Blackman
- Triangular
- Rectangular
- Flat Top
- Kaiser
- Nutall 4 Term

To better evaluate the Window Functions, use the Window Function application\(^2\). WindowFunction.exe provides a graphical view of rolloff and rejection for the various curve selections, frequency and cycles. Plots of WindowFunction.exe are illustrated in Figure 7.11; these include two plots of Rejection and Rolloff. Window Function allows you to select Window Length and Estimator Algorithm.

For additional information on the different window functions please see the C37.118 Synchrophasor Specification and the WindowFunction.exe software tool.

**Digital Channels** assign the specific DSP Trigger information to be sent along with phasor data as seen in the configuration window shown in Figure 7.12. Check boxes allow the user to select for two values:

- **Normal State** tells whether the specific trigger is normally Active (checked) or Inactive (unchecked).
- **Triggered State** tells whether to show the Trigger (checked) or not (unchecked).

---

\(^1\)**Estimated rate restriction for the second PMU started.** Example: If PMU-1 was started before PMU-2, both PMUs set to maximum estimated rate, the estimated rate for PMU-2 is restricted to half the maximum rate due to processor limitations.

\(^2\)**http://www.arbiter.com**
PMU-3 C37.118 Ghost

PMU-3 C37.118 Ghost is a third IEEE C37.118 port configurable to any of three possibilities, plus OFF. The data provided by these selections are as follows:

1. Once per second broadcast of the standard 1133A analog quantities (55 numbers). Floating point (55 numbers, 238 bytes total message). Fixed configuration.
2. R1 per second, subset of PMU-1 data: Frequency, df/dt; Synchrophasor: Positive Sequence Voltage (V1, Real and Imaginary); Analog: Total Active (W) and Reactive (VAR) Power. At the same data rate R1 as PMU-1. Floating point (6 numbers, 42 bytes total message). Fixed configuration.
3. R2 per second, subset of PMU-2 data: Frequency, df/dt; Synchrophasor: Positive Sequence Voltage (V1, Real and Imaginary); Analog: Total Active (W) and Reactive (VAR) Power. At the same data rate R2 as PMU-2. Floating point (6 numbers, 42 bytes total message). Fixed configuration.
4. OFF.

Using both Virtual PMUs 1 and 2, plus the Ghost PMU, will still leave one virtual Ethernet port available for PSCSV and administrative duties. There is only one Ghost PMU, i.e. you cannot have more than one of these selections active at one time. C37.118 does not allow data streams at different reporting rates to be merged.

7.8.4 Setup Example – Ethernet

The following example should illustrate how to set up the 1133A using PSCSV for specific synchrophasor data type, using the data found in Figure 7.10. Before actually setting up the synchrophasor window, make sure to first configure the Nominal Frequency on the form.
1. Click Ethernet on the left panel of the form.
2. Check the port parameters, including protocol and port number. The available choices for protocol are UDP, TCP or Disabled.
3. On the left side of the Configure Ports form, select either PMU-1 or PMU-2.
4. Figure 7.10 shows PMU-1 selected. Start configuring at the top.
5. Make sure to select ON for “Active.” Otherwise, you will not see any data.
6. Give a name for “Station”, such as “1133A PMU-1”.
7. For Station ID (IDCODE) give a unique number to the 1133A, from 1 to 65535. This is the actual code that identifies this specific equipment. No two devices may share this number on the same network.
8. Though not required, you can type in some additional information in the “Header” field to further explain this particular equipment, location, situation, etc.
9. Under “Input,” enable all of the data types that you wish to see in the output; include “Analog” values as well. Set these values to either ON or OFF.
10. “Window Length” is an important setting, as it will control the stability of the reading. If you select a small value (e.g. 1) the readings may tend to jump around and appear unstable.
11. Set “Estimated Rate” to tell the 1133A to send the desired number of phasors samples per second. It is set to 20. In all cases, the rate is always a whole number factor of the nominal frequency.
12. “Cycles Used” (calculated by PSCSV) is a product of the “Estimated Rate” times the “Window Length”. Figure 7.10 this gives this value as follows: $20 \times 6 = 120$.
13. Choose the data format as either 32-bit floating point or 16-bit fixed point.
14. Choose “Adaptive Tuning” if needed to ±2Hz, ±5Hz or ±10Hz. Otherwise leave OFF.
15. Set the Estimator Algorithm according to the desired window filtering features of each filter type. See Window Functions on the previous pages for more information. To view the actual filter bandwidth, use the Window Function graphical software tool to plot out the specific Estimator Algorithm.

7.8.5 Audible Frequency Alert, from Phasor Display

PSCSV allows you to set an audible frequency alert while watching the frequency plot from the phasor display. Thus, when the frequency deviates from the conditions set up in this feature, PSCSV will play a WAV sound file of choice for a selectable period of time. The time period is in seconds from zero to one year. Figure 7.13 shows both the Frequency Plot display with the Alerts setup window. To set up a frequency alert, first select Frequency Plot during a Phasor Broadcast. Next, from the menu choose View > Alerts and configure alert variables.

Alert Definitions

- **Enable Alerts**: Check this box to enable the frequency alarm sound; uncheck to disable the frequency sound alarm.
- **Condition**: Set these values to configure the alarm conditions; choose either Frequency Deviation or $|\text{Frequency Deviation}|$. $|\text{Frequency Deviation}|$ is the absolute value of of Frequency Deviation, and may be used to set up a window comparison. Choose from four logic conditions: $\geq$, $\leq$, $>$, or $<$. Frequency Deviation condition range is between -10.00
and +10.00 Hertz.

- **Play Sound File**: Defines the alarm sound. Click the Browse button to select a WAV file to play during the alert.
- **Minimum Play Time**: Defines how long the sound will play after the alarm condition clears. Type in a value from 0 to 31,560,000 seconds.

### 7.9 Broadcasting UDP Data

The 1133A is set up to *transmit only* in UDP. There are two UDP functions covered in this section: (1) C37.118 synchrophasor data, and (2) Arbiter protocol: including Basic Data, Energy Data, Harmonics, Harmonic Summary, Waveform, PMU-1 and PMU-2. The first category broadcasts true C37.118 phasor data, and the second broadcasts according to Arbiter protocol.

#### 7.9.1 Transmitting UDP, Arbiter Protocol

Using the Arbiter UDP mode, the 1133A transmits data at the following rates: (1) Waveform data: 20 times per second (2) Arbiter synchrophasor data: according to Estimated Rate in PMU-1 or PMU-2 setup (see Figure 7.10), (3) all the other data types: once per second. To start any of these broadcasts, you will need to open the window in Figure 7.14 (select Connection > Configure > UDP Broadcast or click the UDP Broadcast button), select the data item and click Apply or OK. To stop any UDP broadcast, you will need to open the UDP window, deselect the item and click Apply or OK.
7.9.2 Broadcasting UDP, C37.118 Synchrophasor Data

The 1133A was designed to transmit only in UDP; i.e. you cannot connect using UDP in the 1133A. Therefore, to configure the 1133A to broadcast C37.118 synchrophasor data, or to start or stop a C37.118 UDP broadcast, use a separate TCP connection. This is unlike any of the Autonomous (Auto) UDP modes, which will begin broadcasting immediately after being configured in PSCSV. Figure 7.15 illustrates CFG-2 Mode and CFG-Interval, which allows you to configure the UDP broadcast to send a configuration frame with the data UDP data. There are three choices: (1) OFF, (2) Send configuration frame once at the beginning of the broadcast, and (3) send the frame at the beginning of the frame and at minute intervals thereafter.

Procedure

1. Connect with the 1133A and log on with permission to configure. For assistance, see “Basic Configuration Requirements” in Section 7.1.2.
2. Select Connection > Configure > Communication Ports > Ethernet and select the Protocol drop-down window; choose one of the UDP modes listed above.
3. Also, you will need to select the UDP port values and destination IP address of the device receiving the broadcast. Click the Apply button and OK to close.
4. For Broadcast, the data will flood the network; for Unicast, the data will go to the target IP address; for Multicast, the data will go to the target IP addresses. C37.118 data needs a TCP connection to start or stop UDP data; for any of the Autonomous modes, data begins immediately upon application, no TCP connection is required.
5. C37.118 phasor data may be viewed only from a device that communicates C37.118 protocol. PSCSV cannot start or stop C37.118 phasor data broadcasts in TCP or UDP modes.
7.10 Configuring Multimode Relays

Configure the four multimode relays using the Configure Relay Parameters window. Connect to these relays at the rear panel of the 1133A at the location labeled “Contact Outputs.” You may manually switch relays in two modes: (1) User Schedule, Override and (2) Communications. For additional detail on relays, see Chapters 3 and 12.

There are seven configuration choices available: Inactive (default), User Schedule No Override, User Schedule Override, Communications, One Pulse Per Hour, Trigger and KYZ.

To open the Configure Relays window, click the Configure Relays button or select Connection > Configure > Relay Parameters. Select one of the four Relays to select the mode. In Figure 7.16, Relay 1 Mode is selected as “User Schedule, No Override.”

7.10.1 Configuring User Schedule Mode

1. In the User Schedule mode, relays are activated by timed events that are defined by first selecting the User Schedule button for the specific relay and then selecting “User Schedule” to specify the times, date, and ON / OFF conditions.
2. Select a relay (e.g. Relay 1 Mode) and select one of the User Schedule modes.
3. Select User Schedule from the left panel at the bottom; if nothing is scheduled, the right panel will be blank.
4. Click the Add button to add a new schedule to the relay. Click the UTC Date to open a selection calendar. Select the relay to which it applies and specify whether the relay is scheduled ON or OFF.
5. Repeat the previous step to add new or remove unnecessary scheduled relay events.
6. When finished scheduling relays, click Apply then OK to close the window.

### 7.10.2 Configuring Pulse-Per-Hour Mode

1. Select Pulse Per Hour mode by first selecting the relay and checking “One Pulse Per Hour” in the right panel. See Figure 7.16
2. Now, click the + sign to the left of the desired relay and choose “Pulse Per Hour” in the tree below the relay. On the right panel, adjust the offset if desired. Click OK when finished. See Figure 7.17.

![Figure 7.17: Configure Pulse-Per-Hour Mode](image)

### 7.10.3 Configuring KYZ Pulse Metering

1. Select KYZ mode by selecting the specific relay and choosing “KYZ Only.” See Figure 7.18. Click the + sign to expand the sub-tree to reveal the modes. Select “KYZ Output” under the relay and then select the energy value for recording.

![Figure 7.18: Configure KYZ Mode](image)

2. Click OK to install KYZ Outputs configuration and close the configuration window.
3. To scale the KYZ Register Scale Factors, select Connection > Configure > Kp Register Scale Factors or click the Kp button. Kp register scaling is explained below under Kp Register Scale Factors.

4. Under “Value,” select the (Scheduled) Value corresponding to the Description and type in the scaling constant (see Kp Register Scale Factors below for details).

5. Click Apply to install the value(s) and click OK to close.

**CAUTION:** Solid-State KYZ relays (Option 06) should be ordered and installed prior to configuring KYZ outputs. Standard mechanical relays are not rated for KYZ operation.

### 7.10.4 Kp Register Scale Factors

Correct Kp register scale factors are necessary for accurate KYZ pulse metering. Use the “Configure Kp Register Scale Factor” interface shown in Figure 7.19 to set these.

![Configure KYZ Scale Factors](image)

Kp Register Scale Factors are expressed in basic units (e.g. Watt Hours per Pulse) and should be set up to not exceed 20 pulses per second, the limit of the 1133A. To arrive at the minimum Scale Factor value so not to exceed this threshold, take the maximum value of the basic unit being measured and divide by 72,000. This should give you the absolute limit (minimum value) for a Kp scale factor. Practical scale factors should exceed this minimum value so not to unnecessarily lose information.

For example, if the maximum input value (including CT-PT ratios) is 240 kWh, then the minimum scale factor for Watt Hours should be greater than 3.3333333 (240,000 ÷ 72,000 = 3.333 ...). The value produced is the Kp Register Scale Factor (e.g. 3.333 Wh per pulse). Scale Factors are directly proportional to each measured value. Therefore, greater measured values require greater minimum Scale Factors.

Kp Over-Range Condition: An over range input condition will exceed the 20/second output capability of 1133A, causing KYZ pulses to stabilize at that rate. If this is the case, for momentary periods, the accumulator in the 1133A will store these counts and not degrade the Model 1133A 0.025% accuracy. If data has accumulated in the 1133A, then when the signal has dropped below
7.11 Configuring Position and Time

100% (by Kp Scale Factor) the output will put out the additional pulses until the accumulated overage is gone.

7.10.5 Configuring Relays for Trigger Mode

In the Configure Relay Parameters window, select “Triggers” to link one of the four relays to a specific trigger. Thereafter, when the specified event occurs, it will actuate that relay. Figure 7.20 illustrates “Triggers” selected for Relay 4, with User Trigger 1 as the triggering mechanism. Triggers may be User (DSP), Power Quality or System Triggers.

![Figure 7.20: Configure Relays for Trigger Mode](image)

7.10.6 Configuring and Using Communication Mode

1. Select a relay and select Communications Mode button on the right panel.
2. When ready to manually switch the relay, select Manual Override Relay at the bottom of the left panel. Click either Open or Close to switch the relay as shown in Figure 7.21.

![Figure 7.21: Configure Relays for Manual Override Mode](image)

7.11 Configuring Position and Time

Use the Position and Time window to set up Time Preferences, and to assist the GNSS receiver during initial start up. See Figure 7.22. *Time preferences are for the 1133A front panel display*
All timing of measured data (whether exported or stored) is according to UTC.

1. Make certain that there is an open connection with the 1133A and that you are logged on with permission to configure. If you are not, see “Basic Configuration Requirements” in Section 7.1.2.

2. Select Connection > Configure > Initial Position and Time and a window will appear holding the position settings and time references. No menu button exists for this function.

3. For first time startup only, select in the Latitude or Longitude window to enter approximate geographical positions. For example (as latitude) N:035:00:00:000.
   (a) Latitude values are specified as North or South:Degrees(0 - 90):Minutes(0 - 59):Seconds(0 - 59) milliseconds(0 - 999).
   (b) Longitude values are specified as East or West:Degrees(0 - 180):Minutes(0 - 59):Seconds(0 - 59) milliseconds(0 - 999).

4. Select in the Local Time Offset window to select the time difference between UTC and the Local time zone. For example, Pacific Standard Time is normally set to -8:00; Eastern Standard Time is normally set to -5:00.

5. Select the Time Display radio buttons for either UTC or Local; this sets the display on the 1133A to either UTC or Local.

6. Select the drop-down button for Daylight Saving Mode and set to either ON or OFF. Currently, the “Auto” mode does not correctly adjust the time due to the recent government changes in DST. To view the correct local time on the front panel of the 1133A, you will need to adjust the daylight saving setting manually ON or OFF.

7. Change Over sets the time when Daylight Saving is automatically implemented. It is not effective without using the Auto setting (see notes above).

8. Click Apply to install preferences and then OK to close the window.

7.12 Configuring Scheduled Data

Use this function to define the types of scheduled data to be saved to flash memory. This menu also includes the measurement interval. See “Working with Scheduled Data” in Chapter 10 for a
1. Make certain that there is an open connection with the 1133A and that you are logged on with permission to configure. If necessary, see “Basic Configuration Requirements” in Chapter 6.
2. From the main menu, select Connection > Configure > Scheduled Data or click the Configure Scheduled button to access the configuration window shown in Figure 7.23.

3. Select from the list of values, the items to be stored as “scheduled” in flash memory. Access the six scheduled categories using the buttons at the top of the configuration window.
4. For each set of items (e.g. Energy) select the measurement interval window, which is the recording rate. Choices include 1, 5, 10, 15, 30 and 60 minutes. Do this for each category.
5. Click Apply and a new template will be created in flash memory for storing scheduled records.
6. Click Apply and OK to close the Configure Scheduled window.

NOTE: After selecting OK, a message will inform you that the flash partition used to store scheduled records will be erased.

7.13 Configuring Time Deviation

The 1133A calculates the electrical system time deviation, in seconds, by comparing it to GNSS time. It also displays the electrical system frequency and compares it to a reference 60 Hz signal within the 1133A. These are all displayed on the front panel using the FREQ./TIME DEV. button. If it is necessary to offset the system time with a value equal to a known deviation, configure it using this function.

Select Connection > Configure > Set Time Deviation to access the Time Deviation window, shown in Figure 7.24. Type in the required value in seconds and click Apply and then OK.
For information on Frequency and Time Deviation, see “Frequency / Time Deviation Key” in Section 5.2.2. To view the time deviation from the front panel, press the FREQ./TIME DEV. key.

7.14 1133A Security – Setting Up User Accounts and Permissions

7.14.1 Introduction

Read this section to understand and use the various aspects of 1133A Security. This includes setting up and managing User Accounts and granting permissions. Security information is divided into two parts: Overview of Security, and Using Security.

7.14.2 Security Features

- Up to 14 user login names can be added
- Up to 8 character, case-sensitive login names and passwords
- Each login name can have any combination of permissions listed below
- When connecting, PSCSV initially logs in using the login name ‘anon’.

7.14.3 An Overview of 1133A Security

In order to protect the operating performance of the 1133A and the proprietary nature of data stored within the 1133A, PSCSV provides users with several security features. 1133A Security allows the administration of up to 14 separate user accounts, and provides oversight in configuring them on the 1133A Power Sentinel.

Since the Model 1133A allows access to its various features based assigned permissions, a system administrator can make sure each user has the appropriate access necessary to perform each task. There are two components that grant the user access to the various features in the 1133A; these are a Login Name, and a Password. To grant specific privileges to each user, Permissions are granted within a protected configuration interface. Any user with Administer Permission can set up user accounts.

PSCSV does not automatically open a connection with the Model 1133A when it starts. It is up to the user to choose and open a specific communication channel. Once PSCSV has started, you must attempt to open one of several connection types for the 1133A to operate correctly. If PSCSV is successful in opening a connection, it initially logs on to provide basic functionality with the 1133A. It is then up to the user to log in with another user name and password, which provides the required functionality.

Initially, PSCSV logs in to the 1133A under the Login Name “anon,” which allows only the downloading of Basic Data. At the other extreme, you can administer new permissions and gain full access, using the Login name, “admin”. Admin allows the highest level of security. Details of these two permanent accounts follow. Once logged in under user name “admin” the user can set up new, edit or delete user accounts.

If Security is not an issue, please see “How to Disable Security” in Section 7.14.9 for information on how to edit security settings so that everything is available upon initial connection. Thus, when initially logging on, all functions are available.
7.14.4 Security Specifications

<table>
<thead>
<tr>
<th>Function Permission</th>
<th>Allowed Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Take up a communication channel. If this is not set, none of the others are relevant.</td>
</tr>
<tr>
<td>Receive Data</td>
<td>Receive all broadcast messages and query messages</td>
</tr>
<tr>
<td>Download Scheduled</td>
<td>Download all or specified Scheduled</td>
</tr>
<tr>
<td>Erase Scheduled</td>
<td>Erase all Scheduled</td>
</tr>
<tr>
<td>Configure</td>
<td>All configurations that are not security related</td>
</tr>
<tr>
<td>Administer</td>
<td>Add/Edit/Delete users - all other functions</td>
</tr>
</tbody>
</table>

Table 7.1: Security Definitions

<table>
<thead>
<tr>
<th>Login Name</th>
<th>Default Operations</th>
<th>Default Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>Everything</td>
<td>801n60 (can be changed)</td>
</tr>
<tr>
<td>anon</td>
<td>Log in, Receive Data</td>
<td>********* (can be changed, but only recognizes this password when initially logging on).</td>
</tr>
</tbody>
</table>

Table 7.2: Permanent Login Information

7.14.5 Using Power Sentinel Security

When connecting to the 1133A, PCSV always logs in initially to the 1133A under the user name, “anon.” anon allows the most basic level of operation, giving permission to download any of the Broadcast Data items listed. If other functions are needed, then the user must log in under another Login Name and Password that grant permission to use them.

7.14.6 Changing the admin Password

1. Select Connection > Login As, or select the Login As button (key symbol) on the Connection Toolbar to open the Login Window.
2. Type the word admin in the Login Name window. Tab to the Password and type 801n60 - note that all of the values in 1133A security are case sensitive. Click Login. All permissions are now granted, including Administer.
3. Select the Connection > Configure > User Logins to open the Configure User Logins window. Tab to the Password window and type in the new password, up to eight characters. Remember that passwords are case sensitive.
4. When finished, select Apply to install the new admin password, and OK to close the Edit User window.
Setting Up New User Accounts

To set up user accounts and permissions, you will need permission to administer. To get permission to administer, you will need to open the Configure User Logins screen.

1. Select Connection > Login As, or select Login As (the key symbol) on the Connection Toolbar to open the Login window. Type in the Login Name, admin (or other Login Name with Administer permission).
2. Tab to the Password window and type in 801n60 (or the new Login Name and Password with permission to administer).
3. Select OK, and the desired functions should be available, seen by the buttons activating (changing color). Select Connection > Configure > User Logins to activate the Configure User Logins window seen in Figure 7.25.
4. Select New to start a new user account. PSCSV will supply a default Login Name that may be changed. Type in the new Login Name and Password in the windows provided. Check the appropriate boxes to enable / disable the desired permissions. Repeat this step to add any other accounts.
5. Select Apply to install these new accounts, and click OK when finished to close the Edit User window. All of the new Login Names and Passwords should now be installed into the 1133A with which you were communicating.

KEEP AN ACCURATE RECORD OF THE NEW USER NAMES AND PASSWORDS.

Deleting User Accounts

1. Select Connection > Login As, or click the Key symbol, to activate the Login window. Log in with an account that grants permission to administer. (All of the icons in the PSCSV window should appear.)
2. Select Connections > Configure > User Logins to activate the Configure User Logins window. Select the drop-down window under Login Name. Select the user account-name to be deleted, and click Delete. In the same manner, delete any other accounts if needed. The user name(s) will be deleted.

3. Click the Apply button to update the 1133A account list and click OK to close the Configure User Logins window.

7.14.9 How to Disable 1133A Security So That Everything is Available

If security is not an issue, the 1133A can be configured to allow total accessibility.

1. Open a connection between the 1133A and a computer. Login with an account that grants permission to administer.
2. Select Connection > Configure > User Logins, and select the Login Name “anon.”
3. Under Advance Permissions, select Administer (all other permissions will be selected). Click the Apply button and PSCSV will update the 1133A, then update itself with the new security information from the 1133A. Click OK to close the Configure User Login window.
4. Test out the new login name by logging in under the user name, anon; everything should be available.

7.15 Flash Memory Management

7.15.1 Introduction

This section should guide you through the basics of managing flash memory in the 1133A. Each 1133A has 32 megabytes of flash memory set up to store Scheduled Data and Event Data records. Flash memory in the 1133A is contiguous, but the user may determine the partition sizes for each of two categories. One reason for this approach is so that pure Scheduled data (that is regularly downloaded for billing) is not mixed with event data.

7.15.2 Flash Memory Functions

Listed below are all of the flash-related functions in the Model 1133A that are controlled through PSCSV. The details of working with each of these functions are listed below or referred to elsewhere in this chapter.

- Flash Memory Security
- Configuring Flash Memory for Scheduled and Event Storage
- Checking Flash Memory Status
- Erasing Flash Memory
- Downloading Scheduled Data
- Erasing Scheduled Data
- Downloading Event Data
- Erasing Event Data
7.15.3 Flash Memory Security

To access 1133A flash memory features, permission must first be granted through 1133A security. Security features protect the integrity of and guard access to records stored within the 1133A flash memory module. It also guards against the inadvertent reprogramming of the 1133A. Administrators can setup various security levels to limit access to memory and the 1133A configuration. Since records can readily be erased, it is important to understand and set policies for the usage of flash memory in the 1133A. For more information on granting permissions, see “1133A Security.”

7.15.4 Configuring Flash Memory

The Configure Flash window is only available with permission to configure; it is otherwise unavailable from the Connection menu or from the User Login button.

![Figure 7.26: ConfigureFlash Window](image)

1. Open connection between the 1133A and computer using PSCSV. Log on to the 1133A with permission to configure. If necessary, see “1133A Security.”
2. Select Connection > Flash Memory > Configure from the main menu or click the Configure Flash Memory button to open the Configure Flash menu.
3. Click and hold the sliding pointer to increase or decrease the percentage of memory allocated for Scheduled and Event data. Actual percentages are given above the pointer.
   **NOTE:** Even though the available memory is given as a percentage of the total flash module, it is incremented in discrete, 64-Kbyte steps.
4. Select the desired procedure in the event that Flash Memory is full - for either partition. PSCSV allows you two options when the section of flash memory is full. Make this choice in the radio buttons at this time.
   - to overwrite existing data, or
   - to stop writing data
5. Click Apply and OK when finished configuring flash.

   **NOTE:** Anytime flash memory is configured the contents are erased.

7.15.5 Checking Flash Memory Status

Check the Flash Memory Status prior to configuring Scheduled data in case data being stored there may need to be saved. It may be advisable to download existing data prior to configuring flash for any reason, as configuring flash memory will erase any existing data. See Figure 7.27.
7.15 Flash Memory Management

7.15.6 Erasing Flash Memory

To erase the entire contents of flash memory in the 1133A, click the Erase Flash button or select Connection > Flash Memory > Erase ALL. The erasing process should normally take a few minutes with a full memory module. No partial erasures are allowed. See Figure 7.28.

7.15.7 Downloading Scheduled Data

To download scheduled data, click the Download Scheduled button, or select Connection > Flash Memory > Download Scheduled. Download time depends on the type and quantity of records,
7.15.8 Erasing Scheduled Data

To erase the contents of flash memory allocated to scheduled data, click the Erase Scheduled button or select Connection > Flash Memory > Erase Scheduled. The process should normally take of few minutes with a full memory module. For more information, see “Erasing Scheduled Data” under “Working with Scheduled Data in Chapter 10.”

7.15.9 Downloading Event Data

Downloading Event Data involves the same process as downloading Scheduled Data mentioned above. During this process, records first collect under their assigned category. Then, each group is accessed from the primary window for saving to a separate file. For more information, see “Working with Triggers and Downloading Event Data” in Chapter 8.

7.15.10 Erasing Event Data

To erase the section of flash memory allocated to event data, or select Connection > Flash Memory > Erase Event. The process should normally take a few minutes with a full memory module. For more information, see “Erasing Event Data.” The information for erasing Event Data is very similar to erasing scheduled data and the window dialog is the same.

7.16 Uploading a Configuration

Before you upload a configuration, you must create a configuration file to upload. A feature in the Connection menu allows you to create or edit a file, which you can then upload to another unit. To better facilitate this process, it would be best to go through all of the configuration options in a working and configured unit first, so that you have all of the items at hand for reference. Then, as you create a file, you can check for any problems.

7.16.1 Create/Edit Uploadable Configuration

Step one is to locate “Create/Edit Uploadable Configuration” so that you can start a configuration file – see Figure 7.29. PSCSV does not necessarily need to be connected to a working unit, to generate a configuration file. However, it may be to your advantage to be connected to a configured unit and compare its configuration with the file you are creating.
7.16 Uploading a Configuration

1. Select Connection > Open (or click the Open Connection button) and select Create/Edit Uploadable Configuration.

2. Expand the menu below this by clicking the plus sign, and select Default. On the right, you will see a window with a suggested configuration file name and location. Alter the file name to your liking and browse to a suitable location for storage.

### 7.16.2 Configure Choices

Step two is to configure choices in PSCSV to change overall operation of the 1133A. At least one item must be changed to generate a configuration file. The name in the connection window will say, “Default-pseudo”. Select Connection > Configure > any of the available choices to configure.

After completing any changes to the configuration, you must close the open (i.e. Default-pseudo) connection by either selecting Connection > Close or click the Close Connection button. A configuration file is generated when you close the connection.

### 7.16.3 Uploading the New Configuration

The third step is to upload the new configuration file into an 1133A.

1. Make sure to have the 1133A powered ON and be connected through one of the ports. Select Connection > Upload Configuration – see Figure 7.30.

2. Choose Browse for Configuration File to select the new configuration file to upload. When selected, you will see some configuration items appear in the top of the window.

3. Click the Upload to Unit button to upload all the configuration items in the file to the 1133A. When the file has finished uploading, click the Close button to quit.
Figure 7.30: Upload Configuration Window
Chapter 8

Working with Triggers and Downloading Event Records

8.1 Introduction to Triggers and Events

Triggering in the Model 1133A allows you to capture and store transient conditions of any measured signal and DSP value for up to 32 separate triggers. Besides recording the exact time and date of a power-line disturbance, all of the measured data parameters may also be recorded. Thus, you have a complete record of the conditions surrounding the recorded event. Trigger records are normally stored in flash memory but may also be transmitted over one of the data connections as they occur.

**NOTE:** If you are configuring any triggers for the first time, please read through this entire section, and make sure that some flash memory has been partitioned for event data. Any time you change the trigger configuration, the entire flash memory partition devoted to Triggers will be erased.

1. Make certain that there is an open connection with the 1133A and that you are logged on with permission to configure. If you are not, see “Basic Configuration Requirements” in Section 7.1.2.

2. To partition flash, click the Configure Flash Memory button and move the slider to set the partition size. Click OK to accept or Cancel to decline.

3. From the main menu of PSCSV select Connection > Configure > Trigger Parameters or click the Configure Trigger Parameters button.

The Model 1133A subdivides triggers into two main groups: User Triggers and Power Quality Triggers. Another group of triggers, called “System Triggers,” gives you a method to monitor the 1133A systems themselves. Finally, the 1133A can measure external triggers to any of the four event input connectors.

8.2 Configuring User (DSP) Triggers

Configuring triggers in the Model 1133A involves setting up the triggering conditions and the type of data you want recorded when the event occurs. When a triggering event occurs, the selected electrical parameter meets the triggering conditions and the trigger is considered Active. When
the triggering event no longer meets the conditions, the trigger is considered Inactive. Use the Configure Triggers window to set up all of these conditions.

8.2.1 User Trigger Parameter Definitions

**Input Signal.** Consists of the measured signals and parameters, such as Voltage, Current, Watts, VARS, which are compared to the limit.

**Channel.** The phase of input signal, noted as A, C, B and Ave, or other values, such as frequency or phase deviation, as uniquely required.

**Limit Type.** The logical condition used to compare the Limit and the Input Signal \((x)\); \(x > limit\), \(x < limit\), \(|x| > limit\), \(|x - ref| > limit\).

**Limit.** A floating point value to which the Input Signal \((x)\) is compared.

**Reference.** A floating point value used with the Limit Type, \(|x - ref| > limit\), for the value of “ref”. Can be used in a window comparison.

**Dependency.** Selects the Master Trigger state. Values are Off, ActiveMaster, InactiveMaster; “Off” turns off the Master Trigger feature. Use the other two values to set up the Master Trigger condition.

**Master.** Assigns the specific Trigger number (1 - 32) as the Master Trigger. Set up the Master Trigger prior to the dependent trigger or the Master Trigger number will not be available.

**Dwell Time.** Defines the interval in seconds during which the measured signal meets the triggering condition (i.e. true) before the trigger becomes Active.

**MaxLogTime.** Sets the time in seconds that the 1133A will log data after the trigger becomes Active. Time is from 0 to 65535 seconds.

**PostFault.** Sets the time in seconds that the 1133A will log data after the trigger has become Inactive. Time is from 0 to 65535 seconds.

8.2.2 User Trigger Setup Procedure

1. To configure any User (or DSP) Trigger, click the plus sign to the left of “Triggers”, then select User Triggers. This should expand the User Triggers configuration window, shown in Figure 8.1.

![Figure 8.1: DSP Trigger Setup Screen](image)
2. Under “Input Signal”, select the adjacent drop-down arrow and choose the desired parameter on which you want to trigger.

3. Under “Channel,” select the measurement channel (e.g. A, B, C, Ave., etc.), or relevant value according to the Input Signal type.

4. Select Limit Function \((x > \text{limit}, x < \text{limit}, |x| > \text{limit}, |x| < \text{limit}, |x - \text{ref}| > \text{limit})\) for the specific trigger. For example, to trigger for an event when the input signal \((x)\) drops below the assigned limit, select \(x < \text{limit}\).

5. For Limit, type in a floating point value.

6. If using a reference value, click the Reference box and type in the floating point value. Normally, you would use a reference value when the selected Limit Function was \(|x - \text{ref}| > \text{limit}\). In this example, ‘ref’ could be the nominal value, like 60 Hz.

7. Configure Dependency if you want one trigger to become Active only if another condition becomes Active or Inactive. *Always configure the Master channel first.* For example, if you want Channel 2 to trigger only if Channel 1 increases above a set limit, set up Channel 1 (the Master channel) first.

8. Select a master channel number (1 – 32) under Master to set the dependency relationship. For example, if in the previous step the dependency was ActiveMaster and the master trigger was 1, then set Trigger 2 Dependency to “ActiveMaster”, and set Trigger 2 Master to “1”.

9. Select the Dwell Time column to set the time that the triggering conditions must be true before the trigger becomes Active. This could be used to help reduce false triggers. Allowable values are from 0 to 3267.75 seconds.

10. Repeat steps 2 – 9 to set up any other triggers, especially if there are master trigger channels and dependencies.

11. Move on to the next step in Section 8.5, Configuring Data Logged.

### 8.3 Configuring Power Quality Triggers

In the 1133A, Power Quality triggers conform specifically to methods and definitions in IEC 61000-4-30, section 5.4, Supply–Voltage Dips and Swells. While Power Quality triggers are set up in a manner very similar to User (DSP) Triggers, and are part of the shared pool of 32 triggers, they are different than User Triggers due to the methods and definitions of IEC 61000-4-30.

#### 8.3.1 Power Quality Parameter Definitions

**Channel:** AV, AI, CV, CI, BV, BI, NI - includes all of the input voltages and currents, including neutral current.

**Limit Type:** \(x > \text{Limit}, x < \text{Limit}\).

**Limit:** A floating point value, constantly being compared to the measured, input channel value \((x)\) in order to capture an event trigger.

**Limit Fmt:** (Limit Format) Absolute or Percent; choose the limit format that suits your application. For Absolute, the limit is the same number as the value entered in for Limit. For Percent, the measured value is compared to a percentage of the measured signal, and must be entered as a decimal value (e.g. 90% entered as 0.9).

**Ref Fmt:** (Reference Format) Absolute or Sliding; Absolute means that the reference value is
compared directly. Sliding means that Reference value is not fixed (or absolute) and can change slowly, such as with a gradually rising or dropping voltage. See additional details on following pages.

**Hysteresis**: Floating point value; reduces extraneous records from accumulating when a measured value is dithering around a limit or reference.

**Hysteresis Format**: Absolute or Percent; Absolute refers to a fixed value for hysteresis, and Percent refers to a percentage of the measured value. As the measured value increases or decreases, so the hysteresis will change according to the given percentage of hysteresis. Percent must be entered as a decimal value (e.g. 90% entered as 0.9).

**Multiphase**: B, C, BC or OFF; means that the Trigger parameters will also apply to B phase, C phase or both B and C phase, without defining another trigger.

### 8.3.2 Power Quality Trigger Setup Procedure

To set up the 1133A to trigger on Sags and Swells, you will need an open connection between the 1133A and your computer; you may need to verify the settings on the 1133A. For more information on opening a connection, please see “Basic Configuration Requirements” in Section 7.1.2. For definition of Sags and Swells terminology, please read preceding pages in this chapter.

![Power Quality Trigger Setup Screen](image)

Figure 8.2: Power Quality Trigger Setup Screen

1. At the top of the Power Quality setup screen are windows for typing in the Reference values: voltage and current. Install any of these values if you are choosing “Sliding” as the Reference Mode.
2. Choose a trigger Channel from the following: AV, AI, BV, BI, CV, or CI
3. Choose a Limit function: \( x > \text{Limit} \) or \( x < \text{Limit} \).
4. Type in a numerical value for Limit.
5. Select the Limit Mode as Absolute or Percent.
6. Select the Reference Mode as Absolute or Sliding (see step 1 above).
7. Type in a value for Hysteresis, if desired, other than zero.
8. Select a Hysteresis Mode: Absolute or Percent.
9. Select Multiphase if you want to log data on the other phase(s) with a trigger from Phase A.
10. Type in an integer value for Dwell (in half cycles of nominal frequency).
8.3 Configuring Power Quality Triggers

**Hysteresis**

Hysteresis allows the user to set up triggering conditions to reduce the tendency for a varying signal (e.g. voltage) to generate unnecessary triggers. The figure below illustrates a voltage varying around about 130 Vrms, which is the set Limit for a trigger. To avoid unwanted triggers occurring at points A, B, C and D, a hysteresis value of 2 was chosen. This prevents a trigger from occurring unless the voltage drops at least 2 volts below the Trigger Limit. For the trigger to again become Active (i.e. after point E), Va would need to again cross the 130-Vrms Limit.

![Figure 8.3: Hysteresis Plot](image)

**Power Quality Reference**

For Power Quality Triggers with a sliding reference, install the Power Quality Reference value, for each required channel, across the top of the Power Quality trigger setup window. In this case, Reference refers to an initial, numerical voltage/current value, which is preloaded into the Sliding Reference register.

**Sliding Reference**

Set the Reference Format to Sliding when you want to allow daily variations in voltage or current that do not require a trigger unless the variation changes suddenly. For example, if due to usage requirements the line voltage sags during the day and swells during the night, you might want to use a sliding reference to avoid unnecessary triggers. A sliding reference would generate a trigger only if the voltage unexpectedly sags or swells at a rate greater than expected.

**Calculating a Sliding Reference Voltage**

Per the specification IEC61000-4-30, the sliding reference voltage is calculated by Equation 8.1, a first-order equation with a one-minute time constant.

\[
U_{sr(n)} = 0.9967 \times U_{sr(n-1)} + 0.0033 \times U_{(10/12)rms}
\]

Where
\[ U_{sr(n)} \] is the present value of the sliding reference voltage;

\[ U_{sr(n-1)} \] is the previous value of the sliding reference voltage; and

\[ U_{(10/12)} \] is the most recent 10/12-cycle r.m.s. value.

Note that even though the specification defines the input signal (U) as a voltage, Arbiter Systems has applied the specification to include measured input currents as calculated using the same formula.

### 8.4 Triggering from External Events

The Model 1133A has four event input connectors on the rear panel. Trigger from any or all of the external event inputs by connecting signals to any one of the four event input connectors on the rear panel, and configuring the 1133A by through PSCSV. This section covers how to configure these specific inputs for event triggering. Additionally, before connecting any input signals to these connectors, please review the event input specifications in Figure 2.8, Section 12.8.4 and Event Input Settings in Chapter 14.

Each of the event input ports is identical and waits for a voltage level shift of 24 to 240 Vdc, or 5 Vdc by modification. When the voltage changes, the 1133A records the event in flash memory, records specific signal data at the time of the event, and may also notify you from either serial port or Ethernet port.

To configure, make sure that the 1133A is powered on and that you have an open connection between your computer and the 1133A. Also, make sure that you are logged on with permission to configure.

1. Select Connection > Configure > Trigger Parameters, or click the Configure Trigger Parameters button.
2. Select Data Logged on the left panel of the Configure Triggers window and click the System Triggers button near the bottom of the window (see Figure 8.4).

![Figure 8.4: Configure External Event Inputs Screen](image)

3. Select External Event Input 1, 2, 3 or 4 making sure that the appropriate boxes are checked.
8.5 Logging Data when Triggers Occur

If you want to separate the logging parameters for each External Event Input, then select the different Channel buttons at the top of the window and repeat the process above.

4. See Figure 8.6 to continue setting up the data to be logged when an external trigger occurs.
5. Finish the external trigger setup on any other external triggers you may require.
6. When you click the OK button, PSCSV will indicate that it is going to erase memory. Click the Yes button.
7. Recheck the external triggering signals to verify that the voltage is within the specification. If it is a logic level (i.e. 0 to 5 Vdc), make the changes specified in Chapter 14.

8.5 Logging Data when Triggers Occur

The “Data Logged” menus allow you to set up how the 1133A records data when an event occurs. Also, to allow better control over which data is recorded with specific triggers, there are eight channels to separate them. Using Channels, one trigger could be used to start logging basic data and another trigger could be used to start logging phasor data. Logging Data is easily set up as follows:

1. Specify the Channel and Trigger(s) – User and/or System – associated with the Channel.
2. Specify the Logging Parameters – data type and logging time.
3. Specify the data items recorded – based on data type.
4. Repeat the above three steps with other triggers.

NOTE: No actual data will be logged in the event of a trigger without configuring the steps contained in this section.

Configuring System Triggers

Click the System Triggers button in the Data Logged window to open the list of dedicated triggers available for the 1133A. System Triggers are mainly used to monitor the health of the 1133A. See Table 8.1 for a list of system triggers.

<table>
<thead>
<tr>
<th>GNSS Lock</th>
<th>Power Interruption</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Event Inputs – 4 ea.</td>
<td>Event Memory Overflow</td>
</tr>
<tr>
<td>Scheduled Memory Overflow</td>
<td>Event Memory Nearly Full</td>
</tr>
<tr>
<td>Scheduled Memory Nearly Full</td>
<td>System Configuration</td>
</tr>
<tr>
<td>Event Memory Erasure</td>
<td>Scheduled Memory Erasure</td>
</tr>
<tr>
<td>Oscillator Tuning Voltage, Out of Range</td>
<td>Leap Second Adjustment</td>
</tr>
<tr>
<td>GNSS Time Differs from Clock Time</td>
<td>GNSS Time Sync Adjustment</td>
</tr>
<tr>
<td>Communication Port Fault – 2 ea.</td>
<td>Ethernet Port Fault</td>
</tr>
</tbody>
</table>

Table 8.1: System Triggers
8.5.1 “Data Logged” Procedure Details

Follow the instructions below to set up how the 1133A will log data when a specific trigger becomes Active.

1. In the Configure Trigger Parameters window select Data Logged. See Figure 8.5.

![Figure 8.5: Configure Data Logged Screen](image)

2. With the cursor, select the desired trigger(s) for each channel. Right click on the selection(s) and choose “Check Selected” in the pop-up window.

3. Select the System Triggers button (if required) and select the required system triggers for the selected channel.

4. Click the Logging Parameters button to access the logging parameters for each channel. Select the Data Type – None, Basic, Harmonic, Harmonic Summary, Phasor and Waveform – according to requirement. See Figure 8.6

![Figure 8.6: Configure Logging Parameters Screen](image)

5. For Waveform Prefault Time, select from 0 to 6 in seconds; available for waveform only – provides a prefault recording any time a fault is triggered.

6. For Maximum Log Time, of recorded data after the trigger becomes Active (triggered mode), select from 0 to 65535 seconds.
7. For Postfault Time, of recorded data after the trigger becomes Inactive (non-triggered mode),
select values from 0 to 65535 seconds.

8. Click the Data Items tab to select the type of data logged once an event is triggered. Items
change with each type of data selected under “Logging Parameters.” See Figure 8.7.

![Figure 8.7: Configure Data Items Screen](image)

9. Click on any data type and right-click to increase selection capability. Click OK to install
new values and close.

**NOTE:** Multiple triggers in one channel are “OR’ed.” For example, if selecting two triggers
for Channel 1, it will record an event if one or both triggers become Active. This is true for all
triggers, User or System Triggers.

## 8.6 Configuring Schulz-Laios Settings

The 1133A includes special logic to implement Schulz-Laios settings, which are designed to detect
power system anomalies such as oscillatory transients. Six channels are dedicated to performing
this function in the 1133A.

For technical details concerning Schulz-Laios Settings in the 1133A, see “Detecting Oscillatory
Transients and Other Anomalies” in Section 11.28.

1. Select Schulz-Laios in the left panel to access those settings. Select Input Signal for the
specific channel number to define the signal measured by Schulz-Laios logic.

2. Select the Input Channel column to define the selection (e.g. A-phase voltage).

3. Select the Reset Threshold column and type in the desired value.

4. Select the T1 filter time constant and type in the desired value. For additional information,
see Table 11.4.

5. Select the T2 oscillator-detector time constant and type in the desired value.

6. Repeat the steps 1 – 5 for any of the other channels you wish to set.

7. Click Apply to install these values in the 1133A, and then OK to close.

**NOTE:** Changing any of the trigger parameters will cause the event partition of flash memory
to be erased.
8.7 Configuring Event Notification

Triggered event data needs a destination for recording purposes, and PSCSV provides a method of assigning trigger data to one or more destinations. In the destination window below are both User and System Triggers (unseen in window). These destinations are:

- Flash Memory — events are always recorded in flash memory
- Communications Port 1
- Communications Port 2
- Ethernet Port, UDP
- Four Relays, called Contact Outputs on the rear panel (see also Configuring Relays)

1. Select “Event Notification” to reveal a list of User and System triggers that may be assigned to the event reporting channel, including signaling one of the four relay contacts.

2. Select the trigger(s) required for each destination, right click on the selection(s) and choose “Check Selected.” If you desire to globally send all of the triggers to flash memory, right click on the destination window and select Check All.

3. Repeat step 2 to assign triggers for each required destination.

4. Continue on to configuring Schultz-Laios settings if needed. Otherwise, click OK to install the triggers and close the Configure Triggers window.

5. To configure one of the relay contacts to actuate with a specific event (either User or System Trigger), please see Configuring Relays.

**NOTE:** Changing any of the trigger parameters will cause the event partition of flash memory to be erased. If necessary, make sure to download important event records first.

8.8 Downloading Triggered Events from Flash

When properly set up, the Model 1133A will store event records in the flash module, which can then be downloaded and viewed on your computer. Records are subdivided into different types, including the record of the event, and the actual data recorded at the time of the event. In this section, the emphasis will be on retrieving the event record and also the data record from the flash memory module.
For User (DSP), Power Quality and System Triggers, the downloading process is the same, and very much like Downloading Revenue Data.

1. Make certain that there is an open connection with the 1133A and that you are logged on with permission to download events. For additional information, see “Connecting with the 1133A” and “1133A Security.”

2. Click on the Download Event button or select Connection > Flash Memory > Download Event to open the Download Event selection window.

3. Determine range of the event log data that you wish to download, and choose either the “Select All” or the “Select Range” button to determine. If choosing “Select Range”, use the two windows to select the event data range according to date and time.

4. Select “OK” and the Save As window will appear for you to choose a file name for the downloaded data. A default name is supplied. Click “Save” and the selected event data categories will begin filling the Download Session window. A progress meter will also indicate the total number of event records have been transferred to file. Notice in event records are separated into a list in Figure 8.9.

5. When the downloading of event data is complete, close the progress meter window, and the Download Session window should remain. To view the event records themselves, click on the desired event data type in the Session window and the Save As window will again appear. Type in the file name, click “Save,” and the data should fill a spreadsheet window in PSCSV. Notice in Figure 8.10 that the various events are tagged by the date and time, trigger number and whether the trigger is Active or Inactive.

6. If you want to download the actual data recorded at the time of the event, you must have selected this when configuring the trigger (see Section 8.5). If you did configure the “Data Logged” feature, then there should be a line on Figure 8.9 that indicates a specific type of data. In Figure 8.9 the line is named “PSCSV Event Basic”. Select this line to download the recorded data.

7. The downloaded basic data records from the “PSCSV Event Basic” line in Figure 8.9 should look very similar to those in Figures 9.2 and 9.3.

![Figure 8.9: Concluded Event Record Download](image-url)
Figure 8.10: List of Event Records

<table>
<thead>
<tr>
<th>UTC Time</th>
<th>OTL Local Time</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>03-04-08 23:57:20</td>
<td>2008-Mar-05 00:57:20</td>
<td>User Trigger 2: Active</td>
</tr>
<tr>
<td>03-04-08 23:57:24</td>
<td>2008-Mar-05 00:57:24</td>
<td>User Trigger 2: Inactive</td>
</tr>
<tr>
<td>03-05-08 00:03:51</td>
<td>2008-Mar-05 01:03:51</td>
<td>User Trigger 2: Active</td>
</tr>
</tbody>
</table>
Chapter 9

Working with Broadcast Data

9.1 Introduction

All seven, broadcast data types referred to in this section are depicted on the Broadcast toolbar. Broadcast data may be received directly in PSCSV software or through other software tools that are compatible with C37.118 Phasor or Ethernet UDP.

Data logged in PSCSV may be saved in 1133A format and exported in CSV and PQDIF formats. To facilitate data reception by multiple devices, the 1133A provides various options, including RS-485 and Ethernet.

9.1.1 Filter Data Selection Tool

PSCSV provides a filtered view function so that you can limit the number of items in the viewing window. Let’s suppose you want to view A-phase voltage and current and nothing else. When you first start the Basic broadcast, you will see all data items that will more than fill up the viewing window. To limit the number of parameters, follow the guidelines below. Also, you may arrange the order of viewed parameters. See Figure 9.1

Figure 9.1: Basic Data Selection Screen

- From the PSCSV Toolbar, Select View > Filter Data, and you will see a window similar to that shown in Figure 9.1.

- By default, all of the data items are selected, i.e. in the “Currently Viewed” side. Select the items you do not want in this category and click the left-pointing arrow to move them into “Available in Document” side, and click OK.
Note that the data file always contains all of the available data, and you are just restricting what is displayed in the viewing window.

### 9.1.2 Broadcast Data Choices

To acquire Broadcast Data (see Section 6.3.3) there must be an active connection between the 1133A and the computer. To learn about opening a connection between the 1133A and a computer, see Chapter 6, “Connecting with the 1133A.”

Short descriptions of the eight data types are listed in Table 9.1.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
<th>No. Items</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>Voltage, Current, Power, Frequency, Time Deviation, Flicker</td>
<td>55</td>
<td>1/sec.</td>
</tr>
<tr>
<td>Energy</td>
<td>Watt-hours, VAR-hours, Volt-Amp-hours, Q-hours</td>
<td>40</td>
<td>1/sec.</td>
</tr>
<tr>
<td>Harmonics</td>
<td>Voltage and Current, magnitude and phase, up to 50th harmonic</td>
<td>600</td>
<td>1/sec.</td>
</tr>
<tr>
<td>Waveform</td>
<td>Voltages and Currents, mag. and phase</td>
<td>6</td>
<td>20/sec.</td>
</tr>
<tr>
<td>Phasor PMU-1</td>
<td>Many data types according to C37.118 Synchrophasor Spec.</td>
<td>50</td>
<td>varies</td>
</tr>
<tr>
<td>Phasor PMU-2</td>
<td>Many data types according to C37.118 Synchrophasor Spec.</td>
<td>50</td>
<td>varies</td>
</tr>
<tr>
<td>Relative Phase</td>
<td>Voltage and Current, all phases and sequences</td>
<td>24</td>
<td>1/sec.</td>
</tr>
</tbody>
</table>

Table 9.1: Broadcast Data Choices and Descriptions

### 9.2 Logging Basic Data

Basic Data includes all measured voltages, currents, sequence components, power values, flicker, frequency and time deviation values. Basic Data are synchronized to the GNSS, sent real-time at a rate of once-per-second and simultaneously saved in a file of choice. See Figures 9.2 and 9.3.

1. Make certain that there is an open connection with the 1133A. If you are not connected, see “Connecting with the 1133A” on page 42.

2. From the main menu select Connection > Acquire Broadcast > Basic Data, or click the Basic Data button on the Broadcast toolbar to initiate viewing basic data.

3. Note that PSCSV will download all measured data to the Basic Data window.
9.3 Logging Energy Data

Energy Data includes all of the values shown in the Broadcast Data windows seen in Figures 9.4 and 9.5 below. Data includes Watt-hours, VAR-hours, VA-hours, Q-hours, for all phases delivered and received and totals. Energy data are synchronized to the GNSS, sent real time at a rate of once-per-second and simultaneously saved to a file of choice.
1. Make certain that there is an open connection with the 1133A. If you are not connected, see “Connecting with the 1133A” on page 42. Only basic permission required.

2. From the main menu select Connection > Acquire Broadcast > Energy Data, or click the Energy Data button on the Broadcast toolbar to initiate viewing energy data.

3. When the Save As window appears, use the default file name or type in your own file name. Also, use the browse feature to locate files.

4. Click Save and all available energy data should begin streaming into the specific broadcast data screen at a rate of once per second. Data is synchronized with the 1 PPS signal from the GNSS receiver and simultaneously saved to file.

5. Pause or Stop the data stream by clicking the Stop or Pause button. If “Paused”, the buffered data will continue but not appear on the screen. Later, when Pause is removed, the buffered data will fill the screen. The “Stop This” button will only terminate the stream of data on top. The “Stop All” button will terminate all data being broadcast from the 1133A.

6. Use the Filter Data tool to limit the data parameters visible in this window. See Filter Data Selection Tool on page 91 for more information.
9.4 Logging Harmonic Data

Harmonic Data includes all of the voltage and current magnitudes and phase angles, from the fundamental to the 50th (most of which are not visible in Figures 9.6 and 9.7). All available harmonics are delivered to the chosen window, whether in summary, spreadsheet or graphical form. Harmonic data are synchronized to the GNSS, sent real time at a rate of once-per-second and simultaneously saved in a file of choice.

1. Make certain that there is an open connection with the 1133A. If you are not connected, see “Connecting with the 1133A” on page 42. Only basic permission required.

2. From the main menu select Connection > Acquire Broadcast > Harmonics, or click the Harmonics button on the Broadcast toolbar to initiate viewing harmonic data.

3. When the Save As window appears, use the default name or type in your own file name. Also, use the browse feature to locate files.

4. Click OK and the data should begin streaming into the specific broadcast data screen at a rate of once per second. Data is synchronized with the 1 PPS signal from the GNSS receiver and simultaneously saved to file.

5. Pause or stop the data stream by clicking the Stop or Pause button. If “Paused”, the data will accumulate in the computer buffer but not print to the screen. Later, when Pause is
removed, the buffered data will fill the screen. The “Stop This” button will only terminate
the stream of data on top. The “Stop All” button will terminate all data being broadcast
from the 1133A.

6. Use the Filter Data tool to limit the data parameters visible in this window. See Filter Data
Selection Tool on page 91 for more information.

9.5 Logging Harmonic Summary Data

Harmonic Summary Data includes RMS THD, RMS K, THD F, THD T and K-Factor (see
Figures 9.8 and 9.9). All harmonic summary values are delivered to the open window. Harmonic
Summary data are synchronized to the GNSS, sent out real time at a rate of once-per-second and
simultaneously saved in a file of choice.

![Figure 9.8: Harmonic Data Summary Screen](image)

![Figure 9.9: Harmonic Data Spreadsheet Screen](image)

1. Make certain that there is an open connection with the 1133A. If you are not connected, see
“Connecting with the 1133A” on page 42. Only basic permission required.

2. From the main menu select Connection > Acquire Broadcast > Harmonic Summary, or
click the Harmonic Summary button on the Broadcast toolbar to initiate viewing harmonic
summary data.
3. When the Save As window appears, use the default name or type in your own file name. Also, use the browse feature to locate files.

4. Click OK and the data should begin streaming into the specific broadcast data screen at a rate of once per second. Data is synchronized with the 1 PPS signal from the GNSS receiver and simultaneously saved to file.

5. Pause or Stop the data stream by clicking the Stop or Pause button. If “Paused”, the data will accumulate in the computer buffer but not print to the screen. Later, when Pause is removed, the buffered data will fill the screen. The “Stop This” button will only terminate the stream of data on top. The “Stop All” button will terminate all data being broadcast from the 1133A.

6. Use the Filter Data tool to limit the data parameters visible in this window. See Filter Data Selection Tool on page 91 for more information.

### 9.5.1 Harmonic Summary Values

**RMS THD**, RMS Total Harmonic Distortion, is the rms value of all of the harmonics $2 - 50$ and has the same units, volts or amps. RMS THD is calculated from the following equation:

\[
RMS \text{ THD} = \sqrt{V_2^2 + \cdots + V_n^2}
\]

where $V_2$ is the $2^{nd}$ harmonic rms voltage, and $V_{50}$ is the $50^{th}$ harmonic rms voltage.

**RMS K** is the square of the sum of all of the harmonic energy, including the fundamental (i.e. $1 - 50$), with each harmonic multiplied by the the harmonic number. It has the same units as the signal, i.e. volts or amps. For a clean signal, it will be almost exactly equal to the fundamental value.

\[
RMS(K) = \sqrt{(V_1 \times 1)^2 + \cdots + (V_{50} \times 50)^2}
\]

where $V_1$ is the fundamental rms voltage and includes all the harmonics up to the $50^{th}$ ($V_{50}$).

**THD F**, Total Harmonic Distortion, is compared to the fundamental and expressed as a percentage. THD F is calculated from the following:

\[
THD(F) = \frac{\sqrt{V_2^2 + \cdots + V_{50}^2}}{V_1} \times 100\%
\]

where $V_1$ is fundamental voltage, and $V_{50}$ is the highest measured harmonic voltage.

**THD T**, Total Harmonic Distortion, voltage is compared to the Total voltage (fundamental plus harmonics) and expressed as a percent. THD T is calculated from the following:

\[
THD(T) = \frac{\sqrt{V_2^2 + \cdots + V_{50}^2}}{\sqrt{V_1^2 + \cdots + V_{50}^2}} \times 100\%
\]
where the denominator now includes the sum of rms harmonic voltages plus the fundamental.

**K–FACTOR** is a weighting of the harmonic load currents according to their effects on transformer heating, as derived from ANSI/IEEE C57.110. A K–Factor of 1.0 indicates a linear load (no harmonics). The higher the K–Factor, the greater the harmonic heating effects. It is calculated based on the following equation:

\[
K – Factor = \frac{(V_1 \times 1)^2 + \cdots + (V_{50} \times 50)^2}{V_1^2 + \cdots + V_{50}^2}
\]

where each component is multiplied by the harmonic number (e.g. 1, 2, ⋯, 50), called a weighting factor.

### 9.5.2 Harmonic Load Currents

Harmonic load currents significantly affect power distribution system design. Harmonics create additional losses through the skin effect at high frequencies and through higher RMS load currents. By specifying K–Rated transformers and using other techniques, power distribution systems and customer equipment should have lower failure rates.

### 9.5.3 Harmonic Summary Data

Harmonic Summary data returned from the 1133A can be a strong indicator of what harmonics are being returned to the distribution system location by users with non-linear loads. Harmonic content is potentially damaging both to the power company and the user. If adequate protection is not taken, equipment will experience early failure and also lower overall efficiency.

### 9.6 Logging Waveform Data

Waveform Data includes all of the values shown in the Broadcast Data window. When activated, the window allows individual selection of current or voltage using the Input Toolbar buttons. Waveform data are synchronized to the GNSS, broadcast at a rate of 640 samples per second and simultaneously saved in a file of choice. See Figure 9.10.

![Waveform Data Screen](9.10: Waveform Data Screen)
1. Make certain that there is an open connection with the 1133A. If you are not connected, see “Connecting with the 1133A” on page 42. Only basic permission is required.

2. From the main menu select Connection > Acquire Broadcast > Waveform, or click the Waveform button on the Broadcast toolbar to open the Save As window.

3. When the Save As window appears, choose to save the Waveform file to the default filename, or type in a new file name and click Save.

4. The Waveform window should appear and display the configured phase voltages and current waveforms.

5. Click any one or group of the buttons on the Input toolbar to select individual currents or voltages of the three phases (AV, AI, BV, BI, CV, CI) and switch them ON or OFF.

6. To terminate the broadcast, click the “Stop This” button or Select Connection > “Stop This” from the main menu.

7. Review previously recorded waveform data by opening any recorded file by selecting File > Open or clicking the Folder button. Data may be “paged through” by using the slider and right and left arrow buttons.

### 9.7 Logging Phasor Data

Phasor Data includes all of the individual voltages and currents defined in “Input Configuration” (see “Configuring Measurement Parameters, DSP Mode”), and are broadcast from the 1133A at rates set up in the Configure Ports > C37.118 PMU-1 (or PMU-2) > Estimated Rate Hz (see Section 7.8.2). Phasor Data may be displayed in either vector format or as a frequency plot. When viewed as Phasor Vectors, each phase voltage and current may be selected for viewing from the view buttons in the PSCSV main window. As a Frequency Plot, the display records the deviation from the system frequency (either 50 or 60 Hz) over time. See Figures 9.11 and 9.12.

To review previously recorded phasor data, and move through the record file, use the slider and right and left arrows on the record toolbar.

1. Make certain that there is an open connection with the 1133A. If you are not connected, see “Connecting with the 1133A” on page 42. Only basic permission required.

2. From the main menu select Connection > Acquire Broadcast > Phasor, Absolute or click the Phasor button on the Broadcast toolbar to start logging data.

3. When the Save As window appears, click Save to save the Phasor file to the default filename, or type in a new file name.

4. The Phasor window should appear and display the voltage and current phasor(s). The number of phasors is determined by the system choice from the DSP selection.

5. Click any one or group of the Input buttons on the Input toolbar to switch ON or OFF individual currents or voltages of the three phases (AV, AI, BV, BI, CV, CI).
6. To terminate this broadcast session, click the “Stop This” button, or select Connection > Stop Broadcast.

7. Click the Close button on the Phasor window when finished viewing the phasor broadcast.

9.8 Logging Phase Data

Use Phase Data to compare any voltage or current phase angle using A-phase voltage or A-phase current as the reference. When selected, all phase data from every input signal is delivered to the Relative Phase window. Phase Data are synchronized to the GNSS, sent out real time at a rate of once-per-second and simultaneously saved in a file of choice. See Figures 9.13 and 9.14.

1. Make certain that there is an open connection with the 1133A. If you are not connected, see “Connecting with the 1133A” on page 42. Only basic permission required.

2. From the main menu select Connection > Acquire Broadcast > Phase, Relative (Control + R) or click the Phase Data button.
3. Choose the default filename, or type in a file name to store the incoming data, and click Save. Relative phase data should begin streaming into the window.

4. To terminate the relative phase broadcast data, click the “Stop All” or “Stop This” button, or select Connection > Stop All Broadcasts, or Connection > Stop This Broadcast.

5. Use the Filter Data tool to limit the data parameters visible in this window. See Filter Data Selection Tool on page 91 for more information on filtering data.

6. Relative phase readings may be displayed in either Summary or Spreadsheet format, as shown in Figures 9.13 and 9.14. To select these formats, choose View > View As > Real Time (or Spreadsheet), or simply click the Summary or Spreadsheet tab at the bottom of the window.

### 9.9 Exporting Data in CSV Format

1133A formatted data is not compatible with spreadsheet programs and must be converted into a compatible format, such as Comma Separated Variable (CSV). CSV extensions are accepted in most spreadsheet programs. Use this utility to convert selected records to .csv files and save them for use in most spreadsheet programs. See Figure 9.15.

1. Open a connection between the 1133A and computer using PSCSV. 1133 data must be currently downloading from an 1133A, or viewed from an opened file from a previous recording.
2. For data currently being downloaded, use your cursor and select the lines of data to be converted.

3. If the data are from a file, open the file using the Open button, or use File > Open from the main menu, and highlight the lines of data to be converted.

4. The CSV button should now be active. Select File > Export CSV or click on the CSV button and type in a name to save the converted file, or use the default name.

5. Click Save and the data should be converted to CSV format and saved under the .csv extension into the chosen directory. At the conclusion of the conversion process, PSCSV will ask if you want to open the newly-converted data in your resident spreadsheet program.

6. CSV data may then be opened (imported) in most all spreadsheets

### 9.10 Exporting Data in PQDIF Format

1133A formatted data is not compatible with PQDIF applications and must be converted into a compatible format with a PQD extension. Use this utility to convert selected records to PQD files and save them for use in applications that use PQD formats.

1. Open a connection between the 1133A and computer using PSCSV. To export data to PQDIF format, it must be opened in PSCSV either from a saved file, or data currently being downloaded from an 1133A.

2. For data currently being downloaded, use your cursor and select the lines of data to be converted.

3. If the data are from a file, open the file using the Open button, or use File > Open from the main menu, and select the lines of data to be converted.

4. The Export PQDIF menu item should now be active. Select File > Export PQDIF and type in a name to save the converted file, or use the default name.

5. Click Save and the data should be converted to PQDIF format and saved under the PQD extension into the chosen directory.
Chapter 10

Working with Scheduled Data

10.1 Introduction

Scheduled data is defined as energy usage, measured over a specific time interval, stored in the Model 1133A flash memory for revenue purposes. Scheduled data may be specified at different intervals defined by the user, every fifteen minutes being common. Since the 1133A partitions flash memory between scheduled data and event data, it is up to the user to set the amount of storage required ahead of time. To do this, see Flash Memory Management in Chapter 7.

10.1.1 Topics Addressed in this Section

- Protocols
- Checking Status
- Configuring
- Downloading
- Erasing

10.1.2 Protocols

Currently, there are several protocols available for scheduled data in the Model 1133A: Arbiter’s PSCSV software, DNP 3.0 and Modbus. KYZ is also used to meter scheduled data and is supported in the 1133A. To set Kp Register Scale Factors used with KYZ Pulse Metering, see Section 7.10.3. Another major protocol used to receive scheduled data from various metering devices is MV90. At this time the 1133A does not comply with MV90, however Arbiter Systems is working on being MV90 compliant.

10.1.3 Registered or Scheduled Data

The 1133A uses the standard 32 megabyte flash memory module to store scheduled data and uses FRAM to store Scheduled data in counter registers. FRAM uses ferrite technology to store data for up to 10 years and has no write speed limitations like other storage devices. It is ideal for nonvolatile memory applications requiring frequent or rapid writes.
10.1.4 Downloading Scheduled Data with PSCSV

The 1133A always stores scheduled data in a 32 megabyte flash memory module for later review and downloading. Users can download scheduled data through a network, over a modem, or on site through one of the serial ports. Additionally, the 1133A can trigger on an imminent full-memory condition to prevent data loss.

10.1.5 Logging Data with KYZ Pulse Metering

Featuring four, multimode contacts, the 1133A permits seven different operational modes, including KYZ pulse metering. Once KYZ relays are configured and system power is connected to the voltage and current inputs, the relays will start logging data.

For KYZ pulse metering, specify optional KYZ relays (Option 6) instead of standard mechanical relays. See Section 3.3 for details on relay options. Relay specifications are located under “Programmable Contact Output Connections” in Chapter 12. To configure KYZ pulse metering, see “Configuring KYZ Pulse Metering” in Section 7.10.

10.2 Logging Scheduled Data using Other Protocols

10.2.1 DNP 3.0 and Modbus Protocols

Logging scheduled data under DNP 3.0 and Modbus requires additional, third party software designed to connect to devices that use these protocols and communicate using a serial port or the Ethernet. Prior to actually retrieving any scheduled data it is essential to configure the 1133A communications ports for the desired protocol. Use PSCSV to configure the 1133A for DNP 3.0 or Modbus. For information on configuring these ports for DNP or Modbus protocols see “Configuring the 1133A”, and “Configuring DNP 3.0 Protocol” or “Configuring Modbus Protocol” starting in Section 7.6.

Once configured, the third party software will need to open the specific port on the 1133A to establish communications. After establishing communications, determine the codes that specify data items that you are seeking to download. To identify the codes that correspond to these data items, consult the tables in Appendix A, DNP 3.0 and Modbus Data Structure.

10.2.2 Checking the Flash Memory Status

Flash memory in the 1133A is set up so that it can be configured to store two types of data: Scheduled and Event. To store scheduled data, the scheduled partition of the flash memory module must have some space allocated to it through PSCSV. PSCSV allows you to partition the entire flash module as a percentage of the whole for Event data and Scheduled data. A slider in the PSCSV Flash Memory Configuration window provides this means of changing the size of the flash partitions. See Figure 10.1.

Prior to actually configuring the flash module partitions, it would be good to check the flash memory status for any data that may be residing in flash, in case it needs to be downloaded from flash to a computer.
10.3 Downloading Scheduled Data using PCSV

Procedure

1. Click the Flash Memory Status button, or select Connection > Flash Memory > View Status, to see if flash memory has data that needs to be downloaded.

2. Click the OK button to close the window.

3. If scheduled data needs to be downloaded, go to the next section, Downloading Scheduled Data using PCSV.

4. If event data needs to be downloaded, go to the section entitled, “Working with Triggers and Event Data.”

5. After old event and scheduled data is safely downloaded, you may proceed to configure flash memory. If old data does not need to be downloaded, it will be erased when flash memory is reconfigured.

10.3 Downloading Scheduled Data using PCSV

To download scheduled data stored in the 1133A, use PCSV application software. Use any of the communication ports to download scheduled data. The following steps describe that process.

1. Make certain that there is an open connection with the 1133A and that you are logged on with permission to download scheduled data. If you are not, see “Connecting to the 1133A” in Chapter 6 and “1133A Security” in Chapter 7.

2. Determine where you want to store the incoming scheduled data. If necessary, create a directory or file folder in the desired location.

3. From the main menu, select Connection > Flash Memory > Download Scheduled or click the Download Scheduled button, and the Download Scheduled window will appear. Choose either Select All or Select Range. If selecting range, type in the time and date conditions.
4. Click OK and the Save As window will appear. Choose the default file name or type in a new file name and click Save.

5. The Downloading Data window will appear and indicate the progress of the download.

6. After the download is complete, choose one of the lines of data (e.g. Energy) and select it. A Save-AS window will appear allowing you to choose a filename and save-as location. Click OK and data will fill the new window.

7. When the download is complete, click Cancel to close the progress window. Scheduled Data will be stored in the chosen file location and will appear in categories in the Download Session window.

8. To view the specific data, click one of the record groups (e.g. Energy) in the Scheduled Data window. When a Save As window appears, browse to choose a file location, click Save, and data will begin to fill a new spreadsheet window and be saved to file.

9. To convert the 1133A file to CSV format, highlight the data to be converted, click the CSV button and save to the desired filename and directory.

10. Click the Close button when finished with the downloading process.
10.4 Configuring Scheduled Storage

Configuring Scheduled Storage includes selecting the types of data from the included list and setting up the storage time interval.

For information on using DNP 3.0 or Modbus to access scheduled data, see “Configuring DNP 3.0 Protocol” and Appendix A.

**WARNING:** Save current data before configuring. Configuring Scheduled Storage in the flash memory module will cause all scheduled data stored in flash memory to be deleted.

1. Open a connection between the 1133A and computer using PSCSV and log on using an account with permission to configure. If necessary, see “1133A Security.”

2. From the main menu, select Connection > Configure > Scheduled Data or click the Configure Scheduled Storage button.

3. Select, from the list of values in each category, the items to be stored as scheduled in flash memory. These categories include Energy, Voltage, Frequency Variation, Flicker (Pst\(^1\)) and Harmonics. Right click with the mouse to increase the selection options.

4. For each set of items (e.g. Energy) select the storage interval in the window at the bottom, which is the recording rate. Allowable values are every 1, 5, 10, 15, 30 and 60 minutes.

5. Click Apply and then OK to close the configuration menu. PSCSV warns you prior to deleting previous scheduled data. Click Yes to proceed or No to quit.

---

\(^1\)For Pst flicker, always select “Store this data every 10 minutes”; see Section 7.12
10.5 Erasing Scheduled Data Using PSCSV

If you wish to delete the existing records stored in the Scheduled partition of the flash memory module, follow these instructions. Erasing the scheduled partition of flash memory is a complete, one-step process where all of the scheduled-data records residing in flash memory are deleted. No partial deletions are possible.

1. Open a connection between the 1133A and computer using PSCSV and log on using an account with permission to erase scheduled. If necessary, see “1133A Security.”

2. Make certain that no downloading of scheduled data is in process.

3. Select Connection > Flash Memory > Erase Scheduled from the main menu or click the Erase Scheduled button on the Flash Toolbar.

4. While erasing flash memory, a progress window will appear.

5. When the erasure is complete, a message will appear that states that the erasure was successful. Click OK to close the window. Otherwise click the “Close This Dialog Upon Completion” box. If the erasure was not successful, you will receive a message.

6. To check Flash Memory Status for a percent saved condition, select from the main menu Connection > Flash Memory > View Status, or click the Flash Status button.

10.6 1133A Scheduled Data Values

10.6.1 Energy Values

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Values Included</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A WH DEL</td>
<td>Watt-hours, Delivered</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>B WH REC</td>
<td>Watt-hours, Received</td>
<td>A, B, C Phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>A VARH Q1</td>
<td>VAR-hours, Q1, Q2, Q3, Q4</td>
<td>A, B, C phase and Total</td>
<td>16</td>
</tr>
<tr>
<td>B VAH DEL</td>
<td>Volt-Amp-hours, Delivered</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>C VAH REC</td>
<td>Volt-Amp-hours, Received</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>B QH DEL</td>
<td>Q-hours, Delivered</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>C QH REC</td>
<td>Q-hours, Received</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>Total Values</td>
<td></td>
<td></td>
<td>40</td>
</tr>
</tbody>
</table>

10.6.2 Voltage Values

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Values Included</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A VH</td>
<td>Volt-hours</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>A V2H</td>
<td>Volt-Squared-Hours</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>B AH</td>
<td>Amp-Hours</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>B A2H</td>
<td>Amp-Squared-Hours</td>
<td>A, B, C phase and Total</td>
<td>4</td>
</tr>
<tr>
<td>Total Values</td>
<td></td>
<td></td>
<td>16</td>
</tr>
</tbody>
</table>
10.6.3 Sequence Values

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Values Included</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>VH, V2H</td>
<td>Sequence Voltages and Currents</td>
<td>0,1,2VH, 0,1,2V²H</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0,1,2AH, 0,1,2A²H</td>
<td></td>
</tr>
</tbody>
</table>

10.6.4 Frequency Variation Values

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Values Included</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq Var Ave Err</td>
<td>Freq. Variation Ave. Error</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Sudden Freq Var</td>
<td>Sudden Frequency Variation</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

10.6.5 Flicker

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Values Included</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flicker AV</td>
<td>Voltage Flicker</td>
<td>A, B, C phase</td>
<td>3</td>
</tr>
<tr>
<td>Flicker BI</td>
<td>Current Flicker</td>
<td>A, B, C phase</td>
<td>3</td>
</tr>
</tbody>
</table>

10.6.6 Harmonics

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Values Included</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>AV 2</td>
<td>Voltage Harmonic</td>
<td>A, B, C phase, fund. - 50th</td>
<td>150</td>
</tr>
<tr>
<td>BI 3</td>
<td>Current Harmonic</td>
<td>A, B, C phase, fund. - 50th</td>
<td>150</td>
</tr>
<tr>
<td>AV RMS THD</td>
<td>Volt. Total Harm. Distortion</td>
<td>A, B, C phase</td>
<td>30</td>
</tr>
<tr>
<td>Total Values</td>
<td></td>
<td></td>
<td>330</td>
</tr>
</tbody>
</table>

10.7 How Energy is Totalized in the Model 1133A

When scheduled data are downloaded from the 1133A, it is organized according to individual phase and also by the totals of all phases. Also, it is further divided according to its direction of flow – whether delivered (DEL) or received (REC) by the power company. Therefore, energy is recognized as bi-directional as far as the 1133A is concerned and separated into those categories. Lastly, there are two measurement times to consider: the instrument interval (20/second) and a measurement period set by the user called Frequency. While the measurement interval was chosen to provide accurate analysis of the power, the Frequency provides a period of time over which power is measured and recorded, as energy accumulates in a register. At the end of the measurement period, the accumulated values for scheduled energies are copied to the 1133A flash memory module. Also, the registers are cleared to zero for the next cycle.

Suppose that the measurement period for a three-phase system is set to five minutes. During the next five minutes, the 1133A will measure the active power for each phase and calculate totals for all the phases. If the active power is negative, then it is regarded as received and added to the REC register. If the active power is positive, then it is regarded as delivered and added to the DEL register. For a three-phase system, all phases are added algebraically to produce the total. If the total is positive, it is placed in the Total Wh DEL register. If the total is negative, it is placed in the Total Wh REC register. When the timer reaches five minutes, the contents of each register is copied into a flash memory location and cleared for the next scheduled period. When downloaded, all energy is displayed as positive, but separated in to their respective REC or DEL columns.
10.7.1 Example, Totalizing Energy

1. For the first minute, A = +4 kWh. B = +2 kWh. C = -3 kWh. Total Energy = +3 kWh
   \((4 + 2 - 3)\)

<table>
<thead>
<tr>
<th>Phase</th>
<th>Delivered (DEL)</th>
<th>Received (REC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Total</td>
<td>3</td>
<td>0</td>
</tr>
</tbody>
</table>

2. For the second minute, A = B = C = +10 kWh.

<table>
<thead>
<tr>
<th>Phase</th>
<th>Delivered (DEL)</th>
<th>Received (REC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>14</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>12</td>
<td>0</td>
</tr>
<tr>
<td>C</td>
<td>10</td>
<td>3</td>
</tr>
<tr>
<td>Total</td>
<td>33</td>
<td>0</td>
</tr>
</tbody>
</table>

3. For the third minute, A = B = C = -5 kWh.

<table>
<thead>
<tr>
<th>Phase</th>
<th>Delivered (DEL)</th>
<th>Received (REC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>14</td>
<td>5</td>
</tr>
<tr>
<td>B</td>
<td>12</td>
<td>5</td>
</tr>
<tr>
<td>C</td>
<td>10</td>
<td>8</td>
</tr>
<tr>
<td>Total</td>
<td>33</td>
<td>15</td>
</tr>
</tbody>
</table>

4. For the fourth minute, …

5. For the fifth minute, …

Lastly, Net energy values for each phase and total can be computed at any time, once the data are located in the computer. For example, if the net energy per phase is required for phase A, then the REC entry may be subtracted from the DEL entry to get the net energy for that phase for that period. Suppose the following values are recorded for the end of the fifth period:

<table>
<thead>
<tr>
<th>Phase</th>
<th>Delivered (DEL)</th>
<th>Received (REC)</th>
<th>Net*</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>14</td>
<td>11</td>
<td>+3</td>
</tr>
<tr>
<td>B</td>
<td>17</td>
<td>5</td>
<td>+12</td>
</tr>
<tr>
<td>C</td>
<td>10</td>
<td>8</td>
<td>+2</td>
</tr>
<tr>
<td>Total</td>
<td>33</td>
<td>16</td>
<td>+17</td>
</tr>
</tbody>
</table>

* Calculated by user.

The net energy for phase A is 14 - 11 = 3 kWh
Chapter 11

Functional Description

11.1 Overview

The Arbiter Systems Model 1133A Power Sentinel consists of several blocks. They are: GNSS receiver and synchronization; voltage and current inputs; programmable-gain amplifiers, multiplexers, and analog-to-digital converter; digital signal processor; host processor; display and keyboard; I/O functions; and power supply. The button features of the instrument and its measurement functions are described in the sections, which follow.

Two microprocessors are required to handle the many tasks being performed each second in such a highly integrated instrument. A Texas Instruments TMS320C32 floating-point DSP unit performs the digital signal analysis tasks. Instrument I/O functions and interface to the “real world” are handled by an SGS-Thomson ST10F167 16-bit micro-controller. Both of these processors have significant additional processing power, which is not used in the initial version of the 1133A. This will allow for the future expansion of features, which is sure to come, with a minimum amount of upset; indeed, many future enhancements should be possible with only a firmware upgrade.

11.2 GNSS Synchronization

To provide accurate time synchronization for power measurements, the 1133A uses a twelve-channel global positioning system (GNSS) receiver and proprietary technology developed by Arbiter Systems and refined in several generations of GNSS timing products. By comparing the internal 10-MHz crystal oscillator to the 1-PPS output of the GNSS receiver, the 1133A can maintain its frequency at any time within a few parts in $10^{10}$, and time within one microsecond. All of the internal timing signals are derived from this accurate time-base.

11.3 Current Inputs

A three-phase, current input section is designed to be accurate to a few ppm over time and temperature (see “Error Analysis”). This current input section uses a two-stage process, similar to a two-stage current transformer except that the first stage is dc-coupled. Each of these two stages has an accuracy of a few tenths of one percent; together, they have an accuracy of a few parts per million.
11.4 Voltage Inputs

The voltage inputs use low-TC (temperature coefficient) voltage-divider resistor networks as signal attenuators. Voltage inputs may be configured as a three-phase, three-element input, with four connections (A, B, C, and N), or configured as a two-element input, with independent connections to each element (A+, A–, C+, and C–, for example).

11.5 Self Calibration

Designed to provide exceptional stability over time and temperature, the input sections use several high-performance and higher-priced components. Drift and temperature sensitivity are reduced, in the programmable gain amplifiers (PGA’s) and analog-to-digital converter (ADC), by use of an internal, continuous self-calibration process. The inputs to the PGA’s are multiplexed, each to four different signals: the three current (or voltage) inputs, and a calibration signal generated by a special source built in for the purpose. This enables the PGA’s and ADC’s to make use of lower-cost components, since their drifts and initial errors are removed by self-calibration.

11.6 Error Analysis

All identified sources of error in the 1133A have been quantified using worst-case manufacturers’ performance data. These have then been combined using a root-sum-of-squares (RSS) method to yield a performance estimate. Effects due to initial calibration, measurement noise, temperature, and aging are all included. The reason for using RSS analysis is beyond the scope of this paper. However, we have found in our many years’ experience building calibration instruments that this method yields the most realistic estimate of actual worst-case performance, provided that numerous errors contribute significantly to the overall performance (i.e., no one error dominates), and provided that worst-case actual data is used for the analysis.

The error analysis, used for the 1133A power or energy measurements, is shown in Table 6-1. Similar analyses have been performed for the other functions of the instrument, and include most of the same factors shown here.

11.7 Signal Sampling

The signals, representing the scaled voltage and current inputs and the calibration signal, are time-multiplexed into a two-channel ADC. Each signal is sampled at a rate of 10,240 samples per second. The current and voltage signals for each phase are sampled simultaneously to eliminate errors in power calculation, which would occur with non-simultaneous sampling. The sample clock in the 1133A is synchronized to UTC-USNO (GNSS) within one microsecond, allowing measurements of phase angle across a power grid to be compared directly, and ensuring that revenue is billed at the correct rates.

11.8 Power and Energy

Power and energy are determined by making twenty separate measurements per second of the cross product of voltage and current for each phase. Each measurement uses 1024 samples (i.e., it takes
<table>
<thead>
<tr>
<th>Temperature Errors, 0–50°C</th>
<th>Error, ppm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current input, resistor TCR</td>
<td>63</td>
</tr>
<tr>
<td>Voltage input, resistor ratio</td>
<td>50</td>
</tr>
<tr>
<td>Voltage reference (x2)</td>
<td>50</td>
</tr>
<tr>
<td>Cal. source, resistor ratio (x2)</td>
<td>25</td>
</tr>
<tr>
<td>Time Stability, 1 year</td>
<td>–</td>
</tr>
<tr>
<td>Current input, resistor</td>
<td>25</td>
</tr>
<tr>
<td>Voltage input, resistor ratio</td>
<td>&lt;20</td>
</tr>
<tr>
<td>Voltage reference (x2)</td>
<td>36</td>
</tr>
<tr>
<td>Cal. source, resistor ratio (x2)</td>
<td>&lt;40</td>
</tr>
<tr>
<td>Measurement Noise</td>
<td>10</td>
</tr>
<tr>
<td>Total RSS Error, Basic</td>
<td>117</td>
</tr>
<tr>
<td>Calibration Errors</td>
<td>–</td>
</tr>
<tr>
<td>Cal. artifact, Rotek MSB-001A</td>
<td>50</td>
</tr>
<tr>
<td>Traceability to National Standards</td>
<td>50</td>
</tr>
<tr>
<td>Total Error, RSS</td>
<td>136</td>
</tr>
<tr>
<td>Specification (0.025%)</td>
<td>250</td>
</tr>
</tbody>
</table>

Table 11.1: Power & Energy Error Analysis

data from a 100 millisecond window), yielding a 50% overlap.

Apparent power (VA) and reactive power (VAR) are determined from the results of the voltage and current magnitude measurements (see next section), using standard identities. The active power measurements and reactive power measurements are then compensated for PT and CT corrections (see below) using a complex multiplication, and corrections are performed for transformer iron and copper losses, if enabled.

At this point, two different things are done with the resulting measurement data. First, a determination is made of the quadrant in which this data should be registered (Wh delivered or received, VARh delivered or received.) The results of each measurement cycle (20/sec) are then added to the proper set of registers. These registers are stored periodically, and accumulation restarted from zero. The user may configure the unit for different intervals to register energy.

The second thing that is done with the data is to determine the actual power level. This number will be displayed on the front panel (as Watts or VARs), and it will be returned via the serial interface if a simple request for “power” is made. This result is calculated by averaging the 20 power measurements made during each second. Therefore, the update rate for this quantity is once per second. This data is not registered separately depending on the quadrant, as the energy data is; therefore, it is theoretically possible, if the direction of power flow changes periodically, that the sum of measurements reported over the serial interface may gradually depart from the registered energy data. This is due to the loss of information in the averaging process; the registered data
are the most accurate. The averaged data are provided primarily as a convenience or for system control purposes; it is not intended for billing purposes.

11.9 Voltage and Current

Voltage and current are measured in a similar fashion to power, using overlapping 1024-point measurements. In this case, however, the cross product is replaced with the square of the voltage or current samples. The square root of the resulting sum is proportional to the rms voltage or current value during the measurement interval. This value is corrected for the CT and/or PT correction factors before further use. The 1133A uses the resulting data to correct the energy measurements, as described above. It also provides data to the host system by averaging it over one-second intervals.

11.10 CT and PT Compensation

To correct for the inaccuracies of the CT’s and PT’s used in the metering setup, CT and PT compensation may be enabled. Since the system voltage is relatively constant, the PT compensation factor is a single, complex (i.e., magnitude and phase, or real and imaginary) correction factor.

CT compensation is more complicated than PT compensation. Due to the fact that magnetizing currents in CT’s are not exactly proportional to the load current, a matrix is used. This allows the entry of several different compensation factors measured at different current levels. The 1133A interpolates between the numbers in this table (also complex) to determine the correction factor to be used.

Correction for energy is performed using the (complex) product of the PT and CT factors. Correction for voltage or current is performed using the magnitude of the appropriate factor. Correction for phase angle is made using the phase of the appropriate component, i.e. the arctangent of the complex value. The actual calculation performed may be different than this description, due to computational considerations (a complex multiplication is far faster than a trigonometric operation such as an arctangent, for example); however, the end result will be as described.

11.11 Transformer Compensation

There are two different types of transformer compensation. They are used to correct for the losses in a transformer when primary-side metering is used to meter the energy delivered to a customer at the secondary of the transformer.

Copper compensation is used to correct for the $I^2R$ losses in the transformer windings due primarily to their (non-zero) resistance. As you would expect, this effect is primarily active (resistive), although there may be minor reactive effects, and it is proportional to the current squared. This factor allows the user to correct for these losses. It is a complex factor, providing both Watts and VARs correction, and is proportional to current squared; i.e. so many watts and VARs are to be subtracted from the registered amounts per ampere squared of load current.

Iron losses (also called core losses) are due to magnetizing currents (the small amount of current required to generate the flux in the core, which is unrelated to the load current) and eddy current losses in the core material. These are approximately proportional to the square (watts) or 4th
power (vars) of the voltage, and the compensation is performed using the same basic method as described above for copper loss.

11.12 DC Offsets

DC offsets may be present in the signals applied to the input of the 1133A, although this is unusual. More commonly, small dc errors in the measurement circuit result in non-zero average of the samples.

This potential source of error must be corrected to obtain maximum accuracy, since the 1133A makes wideband measurements of power, voltage, and current. Components at any frequency within the measurement bandwidth, including dc, will affect the measurement. Therefore, part of the measurement process is to average the (windowed) data, measuring the dc component. The effects of dc offsets are then subtracted from the results.

11.13 Phase and Frequency

As a part of its measurement process, the 1133A performs a fast Fourier transform (FFT) of the windowed voltage and current samples. In accordance with IEC 61000-4-7, this process is performed twenty times per second, using overlapping 1024-sample Hanning window data. This yields new FFT results twenty times per second for each voltage and current input, for a total of 120 FFT’s per second. Phase angle may be determined from the relationship between the real and imaginary component of the fundamental-frequency bin of the FFT. (Since the window is 100 ms wide, each bin is 10 Hz apart; therefore, this is bin 5 for 50 Hz and bin 6 for 60 Hz.)

So long as there is significant measured energy in the bin, frequency offsets do not affect the measured phase angle. This is true as long as the signal being measured is the main source of energy in the bin; i.e. there is minimal leakage from adjacent bins, and minimal noise. Provided that the frequency is anywhere near nominal (within 10 Hz or so), the phase measurement is perfectly usable.

The phase measurements may be compared to determine phase angle between voltages and currents or between any two voltages or currents. Because the sampling process is synchronized via GNSS to UTC, absolute phase angle measurements may be made and compared between two units located at some distance from one another.

Frequency is measured by taking the difference in phase angle between subsequent measurements, based on the identity \( f = \frac{d\phi}{dt} \). Frequency is averaged over one second prior to being displayed or made available for output.

The 1133A is the first product to make absolute (i.e. relative to UTC time) phase-angle measurements available in an economical unit which will be widely applied. Measurements of phase angle have been available before, but most products have not offered accurate time synchronization, and therefore most users are not experienced with the concept of absolute phase. All phase angles in the 1133A are reported as absolute phase angles, relative to UTC (USNO) top-of-second. A phase angle of zero degrees is defined as corresponding to the positive maximum of a cosine wave being coincident with 1PPS-UTC(USNO). Relative phase angles, for example between phases, or between a voltage and a current, may be calculated by subtraction. Relative phases of harmonics may also be found by subtraction; however, the harmonic number prior to subtraction must multiply the
fundamental, absolute phase. This is because the subtraction is actually one of time; the purpose
being to re-align the reference point to correspond to zero degrees on the fundamental. The phase
angle corresponding to this time shift is proportional to the frequency.

11.14 Harmonics

Harmonics are measured using overlapping Hanning window FFT’s of 1024 samples and 100 ms
window length. Based on the instantaneous frequency, the location of the bins containing significant
energy for each harmonic are determined. This is a total of three bins, one approximately centered
on the harmonic and those two adjacent to it. Then, the energy in those three bins is totaled,
resulting in the energy for that harmonic. This can then easily be expressed as a percent of the rms
signal level, or in whatever form is required. While there is a closed-form correction, which can be
employed to find the harmonic magnitude in the presence of frequency errors, this approximation
was chosen because it is much faster and gives adequate performance.

There is an error in this approximation, due to the fact that there will be a small amount of
energy leakage into nearby bins, which will not be included in the three measured bins. This is
generally of little consequence when the frequency is close to being accurate (which is most of the
time), since the amount of energy outside of the three bins summed is so low. Finally, with the
Hanning window, there is no signal at all outside of these three bins if the frequency is exact.

In the real world, however, the frequency will be off somewhat, and it is reasonable to ask
how large the error can be. For small frequency errors, say 0.01 Hz, the 50th harmonic will be
0.5 Hz from the center of the nominal bin. This results in an error of about 0.005%, which is
insignificant. The worst-case error will occur when a harmonic is very nearly centered between two
bins. In this case, the algorithm described above will miss a bin containing a signal with amplitude
of about 17% of the actual harmonic amplitude. The energy contained in this bin is then \((0.17)^2\) or
about 2.9% of the total energy, resulting in a measured energy 0.971–times what it should be. The
measured harmonic amplitude will then be \(\sqrt{0.971}\) or about -1.5% in error. This is well within the
specification limits (5%) of IEC 61000-4-7. This worst-case error would occur for the 50th harmonic
with a fundamental frequency error of 0.1 Hz. At lower harmonics, the frequency error must be
progressively greater; for example, to result in a -1.5% error in measuring the 9th harmonic would
require a fundamental frequency offset of 0.556 Hz.

The phase angle of the harmonics is determined by taking the arctangent of the real and
imaginary components of the bin closest to each harmonic. This information cannot be used,
however, in the averaging process described in IEC 61000-4-7, because this specification requires
the rms average of a series of measurements. This, by definition, requires magnitude data only.
Therefore, there are two different harmonic tables available from the unit. The averaged harmonic
data, in accordance with IEC 61000-4-7, is provided in a 300-element array (6 channels x 50
harmonics), averaged over the interval specified by the user (typically 10 or 15 minutes). The
harmonic magnitude and phase data are provided in a 600-element array, once per second. The
harmonic magnitude is the rms value over the preceding second, and the phase angle is the
instantaneous, absolute (based on a 100 ms window centered at top of second) phase angle, as
described in the preceding paragraph.
11.15 Flicker

Flicker is measured in accordance with IEC 61000-4-15, the successor standard to IEC 868. Unlike the other measurements described above, flicker measurement is a continuous process. This process is performed using a sample rate of 640 samples per second (sps). Anti-alias (decimation) filtering is performed on the 10240–sps data stream, and the resulting samples are further processed following the block diagram suggested in IEC 61000-4-15. The resulting measurements of flicker perceptibility are classified using a 256-level logarithmic classifier at the full 640–sps rate. Pst is then determined every ten minutes (or as specified), as described by the standards.

Although no standards currently require it, the 1133A also measures flicker on the current inputs. This information can be useful in determining whether a customer’s load is causing flicker on the power system, or whether the customer is being subjected to flicker from other sources. It is unrealistic to penalize a utility for poor power quality at a customer’s load when the cause of the problem is the load itself.

11.16 Interruptions

Interruptions are monitored on the voltage inputs by comparing the 20-per-second voltage measurements with a user-supplied threshold. Events are triggered when the voltage dips below the preset threshold. These can cause the logging of pre-fault and post-fault data, contact closure, or any of the other actions described under “Event Logging.”

11.17 Voltage Fluctuations

Voltage fluctuations are monitored by classifying the 20-per-second voltage data, per phase, with a 256-step linear classifier covering a range of ± 20 percent of nominal voltage. These data are then summarized as a cumulative probability table over a specified interval – typically 15 minutes. In addition, the minimum, maximum, mean and standard deviation are calculated. The data may be recorded in flash memory either continuously or on demand. Voltage fluctuations corresponding to system stability events may also be monitored and a trigger generated using Schulz-Laisos filtering of the voltages.

11.18 System Time Deviation

System time deviation, which is the accumulated error of a clock using the system frequency as its reference, compared to an absolute reference such as UTC, is determined from the 20-per-second phase data described earlier. System time deviation is accumulated as integer cycles of error plus fractional phase, and is converted to seconds as needed. The positive-sequence voltage phase angle is used for this measurement. Since this is an integrated value, the constant of integration (initial time offset value) must be specified by the user.

11.19 Phasor Measurements

Phasor data are formatted and output in accordance with IEEE Synchrophasor Standard C37.118. Phasors consist of the real and imaginary component of magnitude for the voltages and currents
at a particular point in a power distribution system, along with suitable time synchronization fields and other information. This information is available in real time, and is based on the measured fundamental voltage, current, and phase angle described above, at a variable rates based on system frequency. There is a measurement delay due to the data acquisition delay of 50 ms, signal processing time of approximately 15 ms, and data transfer time which depends on the data rate.

11.20 Phase Balance

The 1133A measures phase balance by calculating the symmetrical sequence components (positive, negative, and zero sequence) for the three-phase voltage input. Normally, if the unit is connected properly, the positive-sequence voltage will be equal to the line voltage and the negative- and zero-sequence voltages will be approximately zero. In the event that a user-specified limit on the imbalance (See “Triggering,” later in this section) is exceeded, an event will be recognized. In addition, the sequence components are averaged over a user-specified interval (typically 10 or 15 minutes) and may be logged if desired. These calculations are performed using the voltage magnitude and phase information, at the rate of 20/second.

11.21 Load Balance

Load balance is calculated in much the same way as phase balance, except on the customer’s load current. Both of these measurements may be used to identify serious power system problems, such as a dropped phase, which could cause serious damage to both the utility’s and the customer’s equipment.

11.22 Flash Memory and Event Logging

The Model 1133A has 32 megabytes of standard flash memory for recording, including registered quantities, event data and system status events. Registered quantities are recorded on a fixed schedule and may include many more items than a typical energy meter, including just about any function the instrument can measure. The event data are logged on the occurrence of an event designated to initiate logging. System status is used for advanced monitoring and control of the operation of the 1133A and the system node to which it is connected.

Events are defined as any measured quantity exceeding a user-specified threshold, an external trigger, or an internal state of the 1133A (low flash memory, for example). In addition, an event may trigger a dial-up modem call to be initiated, reporting the event; and/or a relay contact may be closed (or opened).

There is a great deal of flexibility as to what may be recorded in flash memory at the time an event is recognized. Recorded information may include any of the following:

- Time of event
- Type of event
- State of measured quantities
- Pre- and post-event data
- Any of the measured quantities - e.g. voltage, power, waveform, etc.
The 1133A must be configured in advance to specify the events being recognized and actions to be taken.

To maximize usage of flash memory, it is important to distinguish registered quantities from event log data. The amount of memory needed to record a certain number of registered items for a certain period can be determined exactly, whereas the amount of memory required to log events depends on the number and type of events, and the number of items to be recorded for each type. Since the number and type of events cannot be known a priori, the amount of memory required also cannot be stated with certainty. The 1133A handles this by allocating sufficient memory as required for the registered quantities over the specified period of time, and then making whatever memory is left available for event logging. To deal with low register or event memory conditions, the 1133A can be configured to initiate an auto-dial call or contact closure when the condition is met. Memory is allocated in 64-kbyte blocks, which is the block size of the flash memory.

Flash memory must be erased in blocks, and data cannot be over-written until its block is completely erased. Therefore, the normal process will be to first read out the desired data, and then erase the blocks, making them available for re-use. All blocks of data are password-protected, having two levels of security from separate permissions: one to access the data, and a second to clear it from memory. This means that registered data and event data each have their own sets of permissions. This would normally be used to separate billing data from operational data.

In addition to the password security, the flash memory is located on a separate module, mounted internally to the 1133A. In the event of a failure or sabotage to the instrument itself, the memory module may be removed and read on a separate 1133A mainframe, preventing the loss of critical billing information and other data.

11.23 Contact Outputs

Four contact outputs may be used to report events recognized by the 1133A, or they may be controlled remotely, by command. They may also be operated on a schedule, which may be downloaded for up to 30 days in advance. In addition to reporting events, these contacts may be used to synchronize external equipment or to operate load-control switchgear.

11.24 Event Inputs

Four external event inputs are also provided. These are optically isolated and accept dc signals at levels from 24 to 240 volts (an internal modification will allow 5 volt logic-level inputs). Application of a signal to one of these inputs will be time-tagged to one microsecond resolution. Resultant actions from an event input are described above under triggering using event inputs, Section 8.4.

11.25 Serial Channels

Two standard serial channels can be configured at the time of order with RS-232 or RS-485 drivers, or with a V.34bis 33.6k modem. Each channel can have access to all functions of the 1133A. Alternatively, certain functions (such as the ability to clear the revenue registers) may be enabled or disabled independently. Each serial channel has a RJ-11 (6-position) modular connector useful for connecting with a standard phone cable. Use a RJ-11 to DB-9F adapter at the end of the phone
cable to connect the 1133A to a computer. These adapters may be rewired in the field to match interface requirements.

Both serial channels, and the Ethernet channel, may be operated simultaneously, each serving different hosts with separate access authorization and information channels.

11.26 Ethernet MMS Interface

An Ethernet (10base–T) interface, supporting the emerging MMS standard for substation automation, will connect via a RJ-45 (8-position) modular connector. This interface will not be available initially, but the hardware is included, to allow future expandability when this capability is added. Contact the factory for more information on this feature.

11.27 Triggering in the Model 1133A

The digital signal processor (DSP) in the 1133A Power Sentinel measures dozens of different parameters of the applied input signals, in many cases at a rate of 20 measurements per second. Most of these parameters may be used to trigger an alarm condition, based on preset thresholds and conditions.

Triggering in the DSP works as follows. First, there are 31 different measurement types that may be selected for processing by the trigger algorithm (Table 6-2). For each of these, there are (typically) four different measurement channels, A, C, B and either average, total, or maximum (of A, C, and B). Thus, there are a total of 124 different signals (corresponding to individual measurement results) which can be selected.

Second, there are 32 trigger channels, which may be configured for use concurrently (Table 11.3). Each of these may be set to use any of the 124 signals as their input. For each channel, there is a limit, which may be set by the user, as well as a reference value, which may be used by the trigger logic. The limit function logic may be set to any of four modes: \( x > \text{limit} \); \( x < \text{limit} \); \( |x| > \text{limit} \); or \( |x - \text{ref}| > \text{limit} \). In addition, each trigger channel may be made dependent on the results of another channel. It may be set so that the channel requires the other trigger to be either active or inactive before proceeding with its own comparison. Comparisons are made at the 20 per second rate for all channels, even for input signals, which change more slowly.

Each channel also has a dwell time, or delay time, register. Before it will generate a trigger, the specified signal must exceed its limit condition for a number of comparisons equal to this register (plus one). The register is a 16-bit unsigned integer, having a range of 0 to 65535 cycles. Since comparisons are performed 20 times per second, this corresponds to a range of dwell time of 0 to 3276.75 seconds. A value of 0 allows the trigger to be recognized at any time the corresponding condition is true; a value of 1 (0.05 seconds) requires the trigger condition to persist for two consecutive comparisons, and so on.

Considering all of the different input signal possibilities, along with the different limit modes and inter-channel dependencies, there are an almost limitless number of possible combinations of settings for each trigger channel.
11.28 Detecting Oscillatory Transients and Other Anomalies

Special logic is included in the 1133A to implement the algorithms described by Schulz and Laios [1], which are designed to detect power system anomalies such as oscillatory transients. There are six channels dedicated to performing this function in the 1133A (Table 6-4). Each of these may have any of the 124 signals described above as its input. Each channel has three outputs: a low-pass-filtered (bound) output, a rate-of-change output, and an oscillation-detector output. Each channel also has three control parameters (in addition to the input signal selection): the rate-of-change filter time constant (T1 in [1]); the oscillation-detector time constant (T2 in [1]); and the oscillation-detector reset threshold, also described in [1]. These parameters control only the operation of these signal-processing blocks, and do not in themselves generate any triggers. To generate triggers, select one of the three outputs of one of the channels in this block. This serves as an input to one of the 32 trigger channels. As recommended by Schulz and Laios, the input filtering for this block is the BPA #1 low-pass, described in [2], which is a 12-point Hanning-weighted FIR low-pass filter having a group delay of 0.3 seconds at a 20-per-second sampling rate.
### 11.28.1 Signal Functions Available for Triggering

<table>
<thead>
<tr>
<th>ID No.</th>
<th>Function</th>
<th>Update Rate</th>
<th>Channels Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>1</td>
<td>Voltage</td>
<td>20/sec</td>
<td>A, C, B, Average&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>2</td>
<td>Current</td>
<td>20/sec</td>
<td>A, C, B, Average&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>3</td>
<td>Active Power (Watts)</td>
<td>20/sec</td>
<td>A, C, B, Total&lt;sup&gt;c&lt;/sup&gt;</td>
</tr>
<tr>
<td>4</td>
<td>Reactive Power (VARs)</td>
<td>20/sec</td>
<td>A, C, B, Total&lt;sup&gt;c&lt;/sup&gt;</td>
</tr>
<tr>
<td>5</td>
<td>Apparent Power (VA)</td>
<td>20/sec</td>
<td>A, C, B, Total&lt;sup&gt;c&lt;/sup&gt;</td>
</tr>
<tr>
<td>6</td>
<td>Power Factor (PF)</td>
<td>20/sec</td>
<td>A, C, B, Total&lt;sup&gt;c&lt;/sup&gt;</td>
</tr>
<tr>
<td>7</td>
<td>Sequence Voltage Components</td>
<td>20/sec</td>
<td>Zero, Pos., Neg.</td>
</tr>
<tr>
<td>8</td>
<td>Sequence Current Components</td>
<td>20/sec</td>
<td>Zero, Pos., Neg.</td>
</tr>
<tr>
<td>9</td>
<td>Phase Balance Ratio, derived from</td>
<td>20/sec</td>
<td>Zero/pos., Neg./Pos. for both voltage &amp; Current</td>
</tr>
<tr>
<td></td>
<td>sequence components</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Frequency and Time</td>
<td>20/sec</td>
<td>Frequency, F, df/dt, T</td>
</tr>
<tr>
<td>11</td>
<td>THD, Voltage</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>12</td>
<td>THD, Current</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>13</td>
<td>Harmonic VRMS</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>14</td>
<td>Harmonic IRMS</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>15</td>
<td>K-Factor, voltage</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>16</td>
<td>K-Factor, current</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>17</td>
<td>Flicker, instantaneous, voltage</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>18</td>
<td>Flicker, PST, voltage</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>19</td>
<td>Flicker, instantaneous, current</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>20</td>
<td>Flicker, PST, current</td>
<td>1/sec</td>
<td>A, C, B, max (A, C, B)&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>21-25</td>
<td>Reserved</td>
<td>TBD</td>
<td>TBD</td>
</tr>
<tr>
<td>26-31</td>
<td>Transient detector channels 0 - 5</td>
<td>20/sec</td>
<td>Bound, rate/change, osc.</td>
</tr>
</tbody>
</table>

Table 11.2: Signal Functions Available for Triggering

<sup>a</sup>Average or maximum of 3 voltage channels in Φ4W3E and Φ3W2E input mode, 1 channel in 1Φ2W1E mode, and 2 channels in other modes. In Φ3W2E mode, the voltage VAC is derived internally by point-by-point calculation after A/D conversion. The voltage VB, synthesized internally in Φ4W2-1/2E mode, does not correspond to an actual physical quantity and is not included in the analysis, although measurements can be made on the synthesized signal.

<sup>b</sup>Average or maximum of 3 current channels in Φ modes, 1 channel in 1Φ2W3E mode, and 2 channels in other modes. In Φ3W2E mode, the current IB is derived internally by point-by-point calculation after A/D conversion.

<sup>c</sup>Total of 3 elements in Φ4W3E and Φ4W2-1/2E modes, 1 element in 1Φ2W1E mode, and 2 elements in other modes.
11.28.2 Trigger Channel Parameter Summary

Function | Range or Options
---|---
Input Signal | 0 – 31, per Table 11.2 above (set to 0 if not used)
channel | 0 – 3, per right column in table above
Trigger dependency | 0 – 2, Off, Active, Inactive
master channel | 0 – 31, any other trigger channel
Limit type | 0 – 3; x > limit, x < limit, |x| > limit, |x – ref| > limit
Dwell (delay) time | 0 – 65535, 50 ms/count; 0 to 3276.75 seconds
Limit value | Floating point, in measurement units (volts, watts, . . .)
Reference value | Floating point, in measurement units (volts, watts, . . .)

Table 11.3: Trigger Channel Parameter Summary (32 channels)

11.28.3 Schulz-Laioes Transient Detector Values

Function | Range or Options
---|---
T1 | High pass (rate detector) time constant, seconds, minimum 0.05 seconds, typical 0.5 seconds
T2 | Oscillatory detector low pass time constant, seconds; minimum 0.05 seconds, typical 5.0 seconds.
Oscillatory detector reset threshold | Threshold in measurement units Set to any negative number to disable reset
Input Signal | 0 – 31, per Table 11.2 above; 0 - 3, per right column in Table 11.2 above

Table 11.4: Schulz-Laioes Transient Detector Algorithm Control (6 ch.) [1]
Chapter 12

Technical Specifications and Operational Parameters

12.1 Scope

This section includes all of the technical specifications and operational characteristics of the 1133A, including:

- Standard Options
- Receiver Characteristics
- AC Current and Voltage Inputs, Other Inputs & Outputs
- Instrument Interface
- Flash Memory Data Storage
- Accuracy Specifications
- Power Quality Measurement Capability
- System Control and Monitoring
- Synchronization through GNSS or optional IRIG-B
- Power Requirements
- General - Physical & Environmental Performance

NOTE: Specifications are subject to change without notice.

A built-in Global Positioning System (GNSS) satellite receiver synchronizes the 1133A to within 1 μs of Coordinated Universal Time (UTC). Optionally, an IRIG-B decoder replaces the GNSS receiver and synchronizes 1133A to the accuracy of the IRIG-B time source. The GNSS receiver can simultaneously and continuously track up to twelve satellites. Results from all tracked satellites are averaged for better accuracy using least-squares estimation. No Position-Hold function is used. Standard three-phase voltage and current inputs allow for revenue metering, power quality and system control monitoring.

32 megabytes of standard flash memory are used to record revenue data, power quality, internally detected faults, alarms, and various events. Download any registered and event data, or broadcast current data for analysis using PSCSV software. Other supported protocols include DNP, Modbus and PQ-DIF.
Four, Form-C (SPDT) contact outputs may be used to report events recognized by the 1133A, or they may be controlled remotely, by command. Schedule contact outputs for up to 30 days in advance to synchronize external equipment or to operate load-control switchgear. Contacts may also be configured for KYZ pulse metering when used with Option 06.

Four, optically-isolated event inputs are provided and accept dc signal levels of 24 – 240 volts, or 5-V CMOS-level voltages with modification (see Appendix B). Upon application of a signal to one of these inputs, the event will be time-tagged to one microsecond resolution and recognized as an event. These events may cause any of the actions described under “Event Logging.”

One IRIG-B Unmodulated output is provided for synchronizing relays, digital fault recorders, and other power monitoring equipment that rely on the IRIG-B time code format.

Three communication ports are available: SERIAL 1, SERIAL 2 and one IEEE 802.3I 10base-T. SERIAL 1 and 2 may be configured as RS-232, RS-485 or Modem.

### 12.2 Standard Options

<table>
<thead>
<tr>
<th>Option Part Number</th>
<th>Option Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1133opt02 - standard</td>
<td>32 MB Flash Memory Option</td>
</tr>
<tr>
<td>1133opt03</td>
<td>Standard Power Supply</td>
</tr>
<tr>
<td>1133opt04</td>
<td>Low Voltage Power Supply</td>
</tr>
<tr>
<td>1133opt05</td>
<td>Standard Mechanical Relay</td>
</tr>
<tr>
<td>1133opt06</td>
<td>KYZ-Rated Solid State Relay</td>
</tr>
<tr>
<td>1133opt07</td>
<td>Replace GNSS Input with IRIG-B Input</td>
</tr>
<tr>
<td>1133opt10</td>
<td>RS-232 Port, Port 1</td>
</tr>
<tr>
<td>1133opt11</td>
<td>RS-422/485, Port 1</td>
</tr>
<tr>
<td>1133opt12</td>
<td>Modem, Port 1</td>
</tr>
<tr>
<td>1133opt20</td>
<td>RS-232 Port, Port 2</td>
</tr>
<tr>
<td>1133opt21</td>
<td>RS-422/485, Port 2</td>
</tr>
<tr>
<td>1133opt22</td>
<td>Modem, Port 2</td>
</tr>
</tbody>
</table>

Table 12.1: 1133A Standard Options
12.3 AC Voltage and Current Inputs

AC Voltage and Current Input connectors allow for connecting to most common electrical systems. All other values — such as power and energy — are derived from these measurements and the internal GNSS-synchronized or IRIG-B synchronized clock. Possible input configurations and ranges are specified below.

12.3.1 Input Configurations

3 Phase (3Φ)  3-element, 2 1/2-element, 2-element
1 Phase (1Φ)  2-element, 1 1/2-element, 1-element

12.3.2 Input Voltage

Range (3Φ/1Φ)   0 - 75, 150, 300, or 600 Vrms, selectable (phase-to-phase for 2 element, phase-to-neutral for 2 1/2 and 3 element).
Over range     88, 175, 350 or 700 Vrms, nominal

12.3.3 Input Current

Range (3Φ/1Φ)   2.5, 5, 10, or 20 Arms selectable, per element
Over Range      2.9, 5.9, 11.7, or 23.5 Arms, nominal (maximum continuous input current: 20 Arms per element)

12.4 Volt-Amps (VA), Watts (W), Volt-Amp-Reactance (VAR)

Range         Product of rated voltage and current ranges and number of elements (for input configuration, see Section 7 – “Configuring Measurement Parameters, DSP Mode”)

12.5 Compensating Constants and Ratios

CT and PT       Nominal ratios, magnitude and phase compensation, CT uses quadratic spline curve model (see “Configuring the 1133A, Measurement Parameters”)
Transformer     Both iron and copper compensation

12.6 Input Frequency Range

Range:          45 – 65 Hz, for specified accuracy;
Harmonics:      To 3 kHz
12.7 Input Connector Ratings

Connections Removable screw-clamp terminal block, accepting 0.2 – 4 mm² (AWG 24-10) solid or stranded conductors
Insulation 400 V, nominal, to neutral/chassis, surge voltage class III
600 V, nominal, to neutral/chassis, surge voltage class II
Contact factory for more detailed information

12.8 Instrument Interface

12.8.1 Front Panel Indicators and Controls

Status LEDs Operate (green)
Time Set (green)
Unlocked (red)
Fault (red)

Display 2 X 20 character LCD display

Keypad 8 button, for status only (for configuration, see Chapter 7)

12.8.2 External Interface Connections

Serial Two, RS-232 or RS-485 half-duplex or modem (V.34bis, 33.6k) optionally available for each port

Connectors Two, RJ-11 modular;
One, RJ-45 modular Ethernet: 10base-T per IEEE 802.3I

12.8.3 Programmable Contact Output Connections

Two types of programmable relays are offered with the 1133A: standard mechanical, Form-C (SPDT) and optional solid-state, Form-C for use with KYZ pulse metering. Use protective measures when using optional KYZ-rated contacts to guard against surges that will damage the contacts if ratings are exceeded. See “Configuring Multimode Relays” in Section 7.10, for details on configuring contacts.
Standard Mechanical Relays

- **Type & Number**: Four, Form-C (SPDT) contact sets
- **Connections**: Pluggable 12-pole 5-mm terminal strip, with 4, 3-pole mating connections
- **Rating**: 250 Vac/125 Vdc, 8 A max. 2000 VA/150 W max.
- **Isolation**: 4000 Vrms for 1 minute to chassis
- **Functions**: Programmable Load Control, with preset times or via systems interface
  - (Selectable) Fault Failsafe (faulted with power off)
  - Alarm Failsafe
  - Out-of-Lock Failsafe
  - One pulse per hour; contacts closed for one minute at top of the hour
  - Other Functions, as required

Optional Solid State Relays

- **Type**: Four, Form-C (SPDT), solid state contact sets
- **Connections**: Pluggable 12-pole 5-mm terminal strip, with 4, 3-pole mating connections
- **Rating**: 240 Volts, 120 mA, 35 Ohms max On Resistance (typical 23 Ohms)
- **Isolation**: 3750 Vrms Input/Output
- **Functions**: KYZ Pulse Metering, or any switching function requiring long life relays that can tolerate 100 mA max ON current and 23 Ohms resistance.

12.8.4 Event Input Connections

- **Type**: Four, optically-isolated 24 – 240 Vdc (may be configured for 5-V logic level)
- **Connections**: Pluggable 8-pole 5-mm terminal strip, with 4, 2-pole mating connectors
- **Isolation**: 4000 Vrms for 1 minute to chassis
- **Resolution**: 1 microsecond

Types of Events and Triggering Functions

Events are logged by triggers, and in the 1133A are separated into four groups: DSP Triggers, Power Quality Triggers, System Level Triggers and external. DSP Triggers include any measurement processed by the DSP that meets a logical condition, such as the frequency changing by 0.1 Hz, or the line voltage dropping below 110 volts. Power Quality triggers conform specifically to methods
and definitions in IEC 61000-4-30, section 5.4, Supply–Voltage Dips and Swells. System Triggers are 1133A conditions that may be important to know, such as the 1133A losing GNSS synchronization or the flash memory module being full. External triggers occur with a voltage changing state at any of the four external event inputs. When a triggering condition is true, then an event can be logged or some action taken. For additional information concerning Triggering in the DSP, see Chapter 8, Working with Triggers and Downloading Event Records.

### 12.9 Flash Memory Data Storage

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash Module</td>
<td>Removable</td>
</tr>
<tr>
<td>Capacity</td>
<td>32 Mbytes (standard), number of records stored depends on data items selected.</td>
</tr>
<tr>
<td>Configuration</td>
<td>500, 64K blocks Registered data area (32 MB, standard)</td>
</tr>
<tr>
<td>Data</td>
<td>Selectable from all functions measured and totalized by 1133A; each record is stored with a time tag</td>
</tr>
<tr>
<td>Storage Rate</td>
<td>Selectable; default is as follows:</td>
</tr>
<tr>
<td>Lifetime</td>
<td>100,000 storage cycles, minimum</td>
</tr>
<tr>
<td>Data Retention</td>
<td>Indefinite; no power or battery required for data retention</td>
</tr>
</tbody>
</table>

### 12.10 DSP Configuration

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Using PSCSV (see Configure Operation, DSP Mode, CT-PT Ratios and Transformer Loss Compensation. Internal Calibration set at factory).</td>
</tr>
<tr>
<td>Unit Type</td>
<td>Texas Instruments TMS320C32 Floating-Point DSP</td>
</tr>
<tr>
<td>Configuration</td>
<td>(Default) 120 V, 5 A, 60 Hz, 3-phase / 4-wire / 3-element; Make other available configurations through PSCSV software.</td>
</tr>
<tr>
<td>Mode</td>
<td>All structures initialized to known default settings (calibration values done after initialization)</td>
</tr>
</tbody>
</table>
12.11 IP Address

192.168.000.254  Default value
(other) Set up by user with PSCSV software.

12.12 Ethernet (Physical) Address

Set at factory Last 3 pairs of 48 bits (shown in Hex) are same as unit serial number. Check using STATUS/TIME button (e.g. for 00-01-B3-BC-61-4E, 00-01-B3 is fixed, BC-61-4E is the unit serial number, which is 12345678 in decimal).

12.13 Measurement Specifications

Note: Accuracy specifications include all sources of uncertainty. Except as noted, specifications apply for the full operating range, including temperature (−10°C to +50°C), line voltage, input range including specified over-range, power factor, input frequency, and drifts over a one-year calibration interval. Specifications assume synchronization to GNSS and operation in 3-element mode or in a well-balanced system where imbalance does not degrade accuracy.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watts, Wh</td>
<td>0.025% of reading, 10% of range or greater and PF &gt; 0.2</td>
</tr>
<tr>
<td>Under Range</td>
<td>0.0025% of range, below 10% of range</td>
</tr>
<tr>
<td>Power Factor</td>
<td>0.005% of VA, PF &gt; 0.2</td>
</tr>
<tr>
<td>VA, VAh</td>
<td>Same as W, Wh except no PF effect</td>
</tr>
<tr>
<td>VAR, VARh</td>
<td>Same as W, Wh except replace PF with (\sqrt{1 - PF^2})</td>
</tr>
<tr>
<td>Vrms</td>
<td>0.02% of reading or 0.002% range, whichever is greater</td>
</tr>
<tr>
<td>Arms</td>
<td>0.03% of reading or 0.003% range, whichever is greater</td>
</tr>
<tr>
<td>V^2h</td>
<td>0.04% of reading or 0.004% range, whichever is greater</td>
</tr>
<tr>
<td>A^2h</td>
<td>0.06% of reading or 0.006% range, whichever is greater</td>
</tr>
<tr>
<td>Phase Angle, (\phi)</td>
<td>0.01°, phase-to-phase or voltage-to-current, 10% of range minimum</td>
</tr>
<tr>
<td>Power Factor</td>
<td>0.0002 (\times) (\sin(\phi)), 10% of range min.</td>
</tr>
<tr>
<td>Harmonics</td>
<td>0.05% THD or 5% of reading, whichever is greater</td>
</tr>
<tr>
<td>Frequency</td>
<td>&lt;1 ppm (0.0001%) of reading, 50 or 60 Hz nominal, plus time base error</td>
</tr>
<tr>
<td>System Phase</td>
<td>0.03° plus [time base error (\times) 360° (\times) frequency]</td>
</tr>
<tr>
<td>System Time</td>
<td>1 (\mu)s plus time base error</td>
</tr>
<tr>
<td>Event Inputs</td>
<td>± 10 (\mu)s (typical)</td>
</tr>
</tbody>
</table>
12.14 Power Quality Measurement Capability

The 1133A is equipped to detect power quality issues and record them to flash memory and/or send them out one of the available ports (RS-232/485/Modem and Ethernet). Flash memory may be configured to record types of information: (1) Revenue and (2) Event data. Revenue quantities are recorded on a fixed schedule and may include many more items than a typical energy meter would record. Event data are logged on the occurrence of an event trigger and designated to initiate logging data. System status is used for advanced monitoring and control of the operation of the 1133A and system node to which it is connected.

Some of these power quality issues are specified below, and may be configured through PSCSV Software to trigger as an event. Other Power Quality issues may be seen as Revenue Information; this includes Energy, Voltage/Current, Frequency Variation, Flicker and Harmonics. To configure through PSCSV software, see Chapter 7. Regularly check the Arbiter web site at www.arbiter.com/pcsv/index.php for updates to PSCSV.

12.14.1 Harmonic Measurements

Categories | Harmonics Data; Harmonic Summary Data
Standard | Per IEC 61000-4-7, 100-µs overlapping data window
Measurements | THD, K-factor, rms harmonic current and voltage, rms harmonic current and voltage with K-factor compensation (each harmonic magnitude is multiplied by the square of the harmonic number before summing), individual harmonic magnitude and phase
Logged Data | Selectable, may be regularly logged or registered; or event-logged when user-specified limits are exceeded

12.14.2 Power Interruptions

Logged Data | Selectable, may be regularly logged or registered; or event-logged when user-specified limits are exceeded
Method | DSP
Configuration | Set up with PSCSV (see “Configuring Triggers and Downloading Event Data” in Section 8.2.)

12.14.3 Flicker

Standard | Per IEC 61000-4-15, Pst and Instantaneous
Logged Data | Selectable, may be regularly logged or registered; or event-logged when user-specified limits are exceeded
Configuration | Set up with PSCSV (see “Configuring Triggers and Downloading Event Data”); Download with PSCSV, DNP 3.0 and Modbus and PQ-DIF.
12.15 Limit Alarms

Limit alarms may currently be defined and set through PSCSV software and include alarming to the display, memory and through any of the communication channels.

Functions: Upper or lower limits may be set on most measured functions. Limits may also be set on maximum imbalance (ratio of Zero and Negative Sequence Components to Positive Sequence).

Output: Via system interface and display or contact closure

Interface: Configure and read with PSCSV (see “Configuring Multimode Relays” in Section 7.10).

12.16 System Control and Monitoring

Combining DSP and GNSS technology, the 1133A can measure time-dependent electrical system quantities and display them on the front panel or record them for future use. To record System Time, Phase and Frequency data, see Chapter 7 on using PSCSV software.

12.16.1 System Time, Phase and Frequency

“System” refers to the electrical system under measurement. By comparing the generated system time and frequency to the GNSS signal as a reference, the 1133A can measure and record the (integrated) difference in time and frequency, as well as other time-related system facts.

System Time: Unlimited accumulation with ± 1-µs resolution
Frequency: 7 digits, xx.xxxxx Hz
System Phase: 0 – 360 degrees with 0.01 degree resolution
Effect of DC: None; Rejected by narrow band digital filtering

12.16.2 Phasors

Standard: Per IEEE Synchrophasor Standard C37.118
Rate: Depends on nominal frequency; 1 – 50 measurements per second for 50 Hz, 1 – 60 measurements per second for 60 Hz
Interface: User configured through PSCSV (see Configure Ports – C37.118 Synchrophasor Protocol). Uses SERIAL 1 and SERIAL 2 (RS-232, RS-485 or Modem) and the Ethernet port, and UDP Broadcast mode uses the Ethernet port.
12.17 Synchronization

The standard 1133A includes an twelve-channel global positioning system (GNSS) receiver, which provides accurate time to a fraction of a microsecond anywhere in the world. Optionally, choose an IRIG-B decoder to synchronize the 1133A. By comparing an internal 10 MHz oscillator to the 1-PPS (pulse-per-second) output of the GNSS receiver, the 1133A maintains its frequency to within a few parts in \(10^{10}\). For IRIG-B synchronization (Option 07), timing signals are as accurate as the IRIG-B clock source.

12.17.1 GNSS Information

- **Tracking**: GPS-L1 (1575.42 MHz) – 12 Channel, tracks up to 12 satellites depending on conditions, antenna location and receiver model
- **Acquisition**: 2 minutes, typical
- **Accuracy**: UTC – USNO ±1 µs
- **Out-of-Lock**: Via system interface and status display; optional, via contact closure
- **Indication**: Satellite Tracking, view from front panel, STATUS key

12.17.2 GNSS Antenna & Cable Characteristics

- **Power**: +5 Volts DC, 30 mA nominal, supplied through antenna cable from 1133A
- **Frequency**: 1575.42 MHz
- **Gain**: 35 dB (nominal)
- **VSWR**: 2:1
- **Mounting**: 3/4-inch NPT pipe thread (1” – 14 marine type) mount
- **Dimensions**: 77.5 mm diameter x 66.20 mm height (3.05” x 2.61”)
- **Weight**: 170 grams (6.0 oz.)
- **Connections**: Type-F
- **Cable**: Type RG-6, 15 m (50 ft) included; longer cables optionally available

12.17.3 Synchronization Output - IRIG-B

The 1133A includes one IRIG-B output for use with synchronizing external equipment.

- **Type**: One; two-pole; IRIG-B000 or IRIG-B003 per C37.118 (unmodulated or DC level-shift), 200 mA peak; pluggable 5-mm terminal strip with mating connector
12.17.4 Time Base Error

GNSS Locked  Less than 1 µs, when locked to at least one satellite
Unlocked  10 ppm, typical, after being locked for 10 minutes minimum (< 1 second/day unlocked, typical)

12.18 Instrument Power Requirements

The 1133A derives its operating power from an integral power supply. Two power supplies are available. The standard Option-03 power supply accepts high-voltage, ac or dc inlet power. Option 04 accepts only low-voltage dc inlet power. Both options use the same terminal strip for the power line connection.

Option 03 85 – 264 Vac, 47 – 63 Hz or 110 – 250 Vdc, 5 VA, typical
Option 04 10 – 60 Vdc, 5 VA, typical. (DC only)
Input  Terminal strip with fuse; surge withstand per ANSI C37-90.1 and IEC 801-4 standard

12.19 General Specifications

12.19.1 Physical Specifications

Size  1 RU (430 mm W x 44 mm H) rack mount or tabletop; 260 mm deep FMS. Rack mounts included.
Weight  2 kg (4.5 lbs.), net
  5 kg (11 lbs.), shipping

12.19.2 Environmental Specifications

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Operating</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument</td>
<td>-10°C to +50°C</td>
<td>-40°C to +85°C</td>
</tr>
<tr>
<td>Antenna</td>
<td>-40°C to +85°C</td>
<td>-55°C to +100°C</td>
</tr>
<tr>
<td>Antenna Cable</td>
<td>-40°C to +75°C</td>
<td>-40°C to +80°C</td>
</tr>
<tr>
<td>Rel. Humidity</td>
<td>10% to 90% non-condensing</td>
<td>10% to 90% non-condensing</td>
</tr>
</tbody>
</table>

Table 12.2: Temperature and Humidity List
Chapter 13

DNP 3.0 and MODBUS Data Structures

13.1 Introduction

Arbiter Systems provides additional capability and flexibility for data acquisition within the Model 1133A by supporting both DNP 3.0 and Modbus protocols.

Prior to using a DNP 3.0 or Modbus application to access 1133A data, configure the 1133A for these protocols using PSCSV software. To set up the 1133A for use with Modbus or DNP 3.0, see “Configuring Modbus Protocol” and “Configuring DNP 3.0 Protocol” in Section 7.

The majority of information in this section consists of the tables of index values used to access 1133A data from other software applications specifically designed for use with DNP 3.0 or Modbus. While these index codes have been tested successfully, Arbiter Systems has no control over the performance and suitability of using these applications with the Model 1133A, and makes no claim or warranty in this regard.

13.2 Definitions and Conventions

13.2.1 DNP 3.0

DNP 3.0 is an industry standard SCADA communications protocol originating in the electric industry in the USA. DNP 3.0 describes standards for SCADA protocol facilities such as data requests, polling, controls, and report by exception (RBE), where master-slave and peer-to-peer communication architectures are supported. A master device issues commands and the slave device responds to the commands.

Using DNP 3.0, the Model 1133A is considered a slave device that only responds to commands from the master with data or status. The 1133A cannot be configured using DNP 3.0. Configure the 1133A only through PSCSV software.

13.2.2 Modbus

Modbus Protocol is a messaging structure, widely used to establish master-slave communication between intelligent devices. A Modbus message sent from a master to a slave contains the address of
the slave, the “command,” the data, and a check sum (LRC or CRC). It is traditionally implemented using RS232, RS422, or RS485 over a variety of media, but also is available as Modbus TCP/IP. Modbus can be transmitted via two modes: ASCII and RTU. With ASCII, each twelve-bit byte in a message is sent as 2 ASCII characters, and with RTU, each twelve-bit byte is sent as two four-bit hexadecimal characters.

13.2.3 32-Bit Numbers & Little Endian

Indices in boldface represent 32-bit values, 2 16-bit values each. Little endian means that the lower-indexed value contains the lower half (16 least-significant bits) of the 32-bit quantity. Example: to find the A Active Energy Delivered 32-bit value, use: 65536 * DNP[729] + DNP[728]. 32-bit register values are scaled according to the values of Kp set separately using PSCSV configuration.

13.2.4 Scale Factors

The scale factors Vmax (maximum rms voltage, volts), Imax (maximum rms current, amperes), Pmax (maximum per-element power, watts) and Ptmax (maximum total power, watts) are set using PSCSV configuration. These values are stored internally in the Model 1133A, and are used as shown on the following pages to scale the various integer results in the DNP/Modbus integer data structure.

To set up DNP scale factors, see Section 7.6, and Figures 7.6 and 7.7.
### Table 13.1: Voltage and Current Register Values

The 1133A measures any voltage and current by scaling an analog input (AI)\(^1\) according to PT or CT values stored in the 1133A. Users also select a nominal range to maximize accuracy, e.g. 0 to 5 Amps, or 0 to 150 Volts. Make these selections using PSCSV software prior to recording any data or the data will not be accurate.

Thereafter, DNP users should be able to download any of the Quantities listed in Table 13.1 by using the Index value associated with it.

For example, call B-phase current magnitude with index number 10, or B-phase current phase angle with index number 11. The measurement resolution is determined by the maximum current divided by 32767.

---

\(^{1}\)AI indicates analog-input point, CT indicates Counter Point, BI indicates Binary Input
DNP 3.0 and MODBUS Data Structures

13.4 Power Data Structure

The 1133A determines power quantities based on the cross product of measured voltages and currents. For additional details on this measurement, see Section 11.8, “Functional Description, Power and Energy.”

DNP users should be able to download any of the Quantities listed in Table 13.2 by using the Index value associated with it.

For example, call C-phase Active Power with index number 29, or C-phase power factor with index number 11. The measurement resolution is determined by the maximum current divided by 32767.

### Table 13.2: Power Register Values

<table>
<thead>
<tr>
<th>DNP Type/Index</th>
<th>Modbus Input Reg.</th>
<th>Quantity</th>
<th>Full Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI:24</td>
<td>30025</td>
<td>A Active Power (W)</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:25</td>
<td>30026</td>
<td>A Reactive Power (VAR)</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:26</td>
<td>30027</td>
<td>A Apparent Power (VA)</td>
<td>Pmax = 32767</td>
</tr>
<tr>
<td>AI:27</td>
<td>30028</td>
<td>A Power Factor</td>
<td>±1.0000 = ±32767</td>
</tr>
<tr>
<td>AI:28</td>
<td>30029</td>
<td>A Q</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:29</td>
<td>30030</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:30</td>
<td>30031</td>
<td>C Active Power (W)</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:31</td>
<td>30032</td>
<td>C Reactive Power (VAR)</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:32</td>
<td>30033</td>
<td>C Apparent Power (VA)</td>
<td>Pmax = 32767</td>
</tr>
<tr>
<td>AI:33</td>
<td>30034</td>
<td>C Power Factor</td>
<td>±1.0000 = ±32767</td>
</tr>
<tr>
<td>AI:34</td>
<td>30035</td>
<td>C Q</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:35</td>
<td>30036</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:36</td>
<td>30037</td>
<td>B Active Power (W)</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:37</td>
<td>30038</td>
<td>B Reactive Power (VAR)</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:38</td>
<td>30039</td>
<td>B Apparent Power (VA)</td>
<td>Pmax = 32767</td>
</tr>
<tr>
<td>AI:39</td>
<td>30040</td>
<td>B Power Factor</td>
<td>±1.0000 = ±32767</td>
</tr>
<tr>
<td>AI:40</td>
<td>30041</td>
<td>B Q</td>
<td>±Pmax = ±32767</td>
</tr>
<tr>
<td>AI:41</td>
<td>30042</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:42</td>
<td>30043</td>
<td>Total Active Power (W)</td>
<td>±Ptmax = ±32767</td>
</tr>
<tr>
<td>AI:43</td>
<td>30044</td>
<td>Total Reactive Power (VAR)</td>
<td>±Ptmax = ±32767</td>
</tr>
<tr>
<td>AI:44</td>
<td>30045</td>
<td>Total Apparent Power (VA)</td>
<td>Ptmax = 32767</td>
</tr>
<tr>
<td>AI:45</td>
<td>30046</td>
<td>Total Power Factor</td>
<td>±1.0000 = ±32767</td>
</tr>
<tr>
<td>AI:46</td>
<td>30047</td>
<td>Total Q</td>
<td>±Ptmax = ±32767</td>
</tr>
<tr>
<td>AI:47</td>
<td>30048</td>
<td>Reserved</td>
<td>0</td>
</tr>
</tbody>
</table>
## 13.5 Frequency, Flicker and Relative Phase Data Structure

<table>
<thead>
<tr>
<th>DNP Type:Index</th>
<th>Modbus Input Reg.</th>
<th>Quantity</th>
<th>Full Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI:48</td>
<td>30049</td>
<td>Frequency</td>
<td>327.67 Hz = 32767</td>
</tr>
<tr>
<td>AI:49</td>
<td>30050</td>
<td>Frequency Error</td>
<td>±32.767 Hz = ±32767</td>
</tr>
<tr>
<td>AI:50</td>
<td>30051</td>
<td>Frequency Rate of Change</td>
<td>±327.67 Hz/s = ±32767</td>
</tr>
<tr>
<td>AI:51</td>
<td>30052</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:52</td>
<td>30053</td>
<td>System Time Deviation (seconds)</td>
<td>±327.67 sec = ±32767</td>
</tr>
<tr>
<td>AI:53</td>
<td>30054</td>
<td>System Time Deviation (cycles)</td>
<td>±3276.7 cycles = ±32767</td>
</tr>
<tr>
<td>AI:54</td>
<td>30055</td>
<td>Instantaneous Flicker, A Voltage</td>
<td>3276.7 Flicker = 32767</td>
</tr>
<tr>
<td>AI:55</td>
<td>30056</td>
<td>Instantaneous Flicker, A Current</td>
<td>3276.7 Flicker = 32767</td>
</tr>
<tr>
<td>AI:56</td>
<td>30057</td>
<td>Instantaneous Flicker, C Voltage</td>
<td>3276.7 Flicker = 32767</td>
</tr>
<tr>
<td>AI:57</td>
<td>30058</td>
<td>Instantaneous Flicker, C Current</td>
<td>3276.7 Flicker = 32767</td>
</tr>
<tr>
<td>AI:58</td>
<td>30059</td>
<td>Instantaneous Flicker, B Voltage</td>
<td>3276.7 Flicker = 32767</td>
</tr>
<tr>
<td>AI:59</td>
<td>30060</td>
<td>Instantaneous Flicker, B Current</td>
<td>3276.7 Flicker = 32767</td>
</tr>
<tr>
<td>AI:60</td>
<td>30061</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:61</td>
<td>30062</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:62</td>
<td>30063</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:63</td>
<td>30064</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:64</td>
<td>30065</td>
<td>A Voltage Relative Phase</td>
<td>Ref. = 0</td>
</tr>
<tr>
<td>AI:65</td>
<td>30066</td>
<td>A Current Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:66</td>
<td>30067</td>
<td>C Voltage Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:67</td>
<td>30068</td>
<td>C Current Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:68</td>
<td>30069</td>
<td>B Voltage Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:69</td>
<td>30070</td>
<td>B Current Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:70</td>
<td>30071</td>
<td>Zero Sequence Voltage Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:71</td>
<td>30072</td>
<td>Zero Sequence Current Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:72</td>
<td>30073</td>
<td>Positive Sequence Voltage Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:73</td>
<td>30074</td>
<td>Positive Sequence Current Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:74</td>
<td>30075</td>
<td>Negative Sequence Voltage Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:75</td>
<td>30076</td>
<td>Negative Sequence Current Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
</tbody>
</table>

Table 13.3: Frequency, Flicker and Relative Phase Register Values
**Frequency, Flicker and Relative Phase Register Values, continued.**

<table>
<thead>
<tr>
<th>DNP Type:Index</th>
<th>Modbus Input Reg.</th>
<th>Quantity Description</th>
<th>Full Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI:76</td>
<td>30077</td>
<td>A Voltage Relative Phase (to A Current)</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:77</td>
<td>30078</td>
<td>A Current Relative Phase</td>
<td>Ref. = 0</td>
</tr>
<tr>
<td>AI:78</td>
<td>30079</td>
<td>C Voltage Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:79</td>
<td>30080</td>
<td>C Current Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:80</td>
<td>30081</td>
<td>B Voltage Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:81</td>
<td>30082</td>
<td>B Current Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:82</td>
<td>30083</td>
<td>Zero Sequence Voltage Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:83</td>
<td>30084</td>
<td>Zero Sequence Current Relative Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:84</td>
<td>30085</td>
<td>Positive Sequence Voltage Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:85</td>
<td>30086</td>
<td>Positive Sequence Current Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:86</td>
<td>30087</td>
<td>Negative Sequence Voltage Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:87</td>
<td>30088</td>
<td>Negative Sequence Current Rel. Phase</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:88-95</td>
<td>30089-96</td>
<td>Reserved (8 Values)</td>
<td>0</td>
</tr>
</tbody>
</table>
### 13.6 Harmonic and Harmonic Summary Data Structure

<table>
<thead>
<tr>
<th><strong>DNP</strong></th>
<th><strong>Modbus</strong></th>
<th><strong>Quantity</strong></th>
<th><strong>Full Scale</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>AI:96</td>
<td>30097</td>
<td>A RMS Harmonic Voltage</td>
<td>Vmax = 32767</td>
</tr>
<tr>
<td>AI:97</td>
<td>30098</td>
<td>A RMS Harmonic Voltage, K-Factor Adjusted</td>
<td>Vmax = 32767</td>
</tr>
<tr>
<td>AI:98</td>
<td>30099</td>
<td>A Voltage RMS THD, Fundamental Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:99</td>
<td>30100</td>
<td>A Voltage RMS THD, Total Signal Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:100</td>
<td>30101</td>
<td>A Voltage K-Factor</td>
<td>32.767 = 32767</td>
</tr>
<tr>
<td>AI:101</td>
<td>30102</td>
<td>A RMS Harmonic Current</td>
<td>Imax = 32767</td>
</tr>
<tr>
<td>AI:102</td>
<td>30103</td>
<td>A RMS Harmonic Current, K-Factor Adjusted</td>
<td>Imax = 32767</td>
</tr>
<tr>
<td>AI:103</td>
<td>30104</td>
<td>A Current RMS THD, Fundamental Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:104</td>
<td>30105</td>
<td>A Current RMS THD, Total Signal Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:105</td>
<td>30106</td>
<td>A Current K-Factor</td>
<td>32.767 = 32767</td>
</tr>
<tr>
<td>AI:106</td>
<td>30107</td>
<td>C RMS Harmonic Voltage</td>
<td>Vmax = 32767</td>
</tr>
<tr>
<td>AI:107</td>
<td>30108</td>
<td>C RMS Harmonic Voltage, K-Factor Adjusted</td>
<td>Vmax = 32767</td>
</tr>
<tr>
<td>AI:108</td>
<td>30109</td>
<td>C Voltage RMS THD, Fundamental Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:109</td>
<td>30110</td>
<td>C Voltage RMS THD, Total Signal Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:110</td>
<td>30111</td>
<td>C Voltage K-Factor</td>
<td>32.767 = 32767</td>
</tr>
<tr>
<td>AI:111</td>
<td>30112</td>
<td>C RMS Harmonic Current</td>
<td>Imax = 32767</td>
</tr>
<tr>
<td>AI:112</td>
<td>30113</td>
<td>C RMS Harmonic Current, K-Factor Adjusted</td>
<td>Imax = 32767</td>
</tr>
<tr>
<td>AI:113</td>
<td>30114</td>
<td>C Current RMS THD, Fundamental Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:114</td>
<td>30115</td>
<td>C Current RMS THD, Total Signal Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:115</td>
<td>30116</td>
<td>C Current K-Factor</td>
<td>32.767 = 32767</td>
</tr>
<tr>
<td>AI:116</td>
<td>30117</td>
<td>B RMS Harmonic Voltage</td>
<td>Vmax = 32767</td>
</tr>
<tr>
<td>AI:117</td>
<td>30118</td>
<td>B RMS Harmonic Voltage, K-Factor Adjusted</td>
<td>Vmax = 32767</td>
</tr>
<tr>
<td>AI:118</td>
<td>30119</td>
<td>B Voltage RMS THD, Fundamental Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:119</td>
<td>30120</td>
<td>B Voltage RMS THD, Total Signal Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:120</td>
<td>30121</td>
<td>B Voltage K-Factor</td>
<td>32.767 = 32767</td>
</tr>
<tr>
<td>AI:121</td>
<td>30122</td>
<td>B RMS Harmonic Current</td>
<td>Imax = 32767</td>
</tr>
<tr>
<td>AI:122</td>
<td>30123</td>
<td>B RMS Harmonic Current, K-Factor Adjusted</td>
<td>Imax = 32767</td>
</tr>
<tr>
<td>AI:123</td>
<td>30124</td>
<td>B Current RMS THD, Fundamental Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:124</td>
<td>30125</td>
<td>B Current RMS THD, Total Signal Reference</td>
<td>100% = 32767</td>
</tr>
<tr>
<td>AI:125</td>
<td>30126</td>
<td>B Current K-Factor</td>
<td>32.767 = 32767</td>
</tr>
<tr>
<td>AI:126</td>
<td>30127</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>AI:127</td>
<td>30128</td>
<td>Reserved</td>
<td>0</td>
</tr>
</tbody>
</table>

Table 13.4: Harmonic and Harmonic Summary Register Values

For technical details on how the Model 1133A measures harmonics and calculates harmonic summary data, see Section 11.14, in the Functional Description. DNP users should be able to download any of the Quantities listed in Table 13.4 by using the Index value associated with it. For example, call C-phase, RMS Harmonic Current with index number 111. The measurement resolution is determined by the maximum current divided by 32767.
13.7 Individual Harmonic Voltages and Currents

<table>
<thead>
<tr>
<th>DNP Type:Index</th>
<th>Modbus Input Reg.</th>
<th>Quantity</th>
<th>Full Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI:128–227</td>
<td>30129-30228</td>
<td>A Voltage Individual Harmonic Data</td>
<td>Vmax=32767</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(M = 128, P = 129)</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:228–327</td>
<td>30229-30328</td>
<td>A Current Individual Harmonic Data</td>
<td>Imax=32767</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(M = 228, P = 229)</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:328–427</td>
<td>30329-30428</td>
<td>C Voltage Individual Harmonic Data</td>
<td>Vmax=32767</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(M = 328, P = 329)</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:428–527</td>
<td>30429-30528</td>
<td>C Current Individual Harmonic Data</td>
<td>Imax=32767</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(M = 428, P = 429)</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:528–627</td>
<td>30529-30628</td>
<td>B Voltage Individual Harmonic Data</td>
<td>Vmax=32767</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(M = 528, P = 529)</td>
<td>±180deg = ±32767</td>
</tr>
<tr>
<td>AI:628–727</td>
<td>30629-30728</td>
<td>B Current Individual Harmonic Data</td>
<td>Imax=32767</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(M = 628, P = 629)</td>
<td>±180deg = ±32767</td>
</tr>
</tbody>
</table>

Table 13.5: Individual Harmonic Voltages and Currents

Specifying DNP Type Index Values

\[
\text{DNP Harmonic Magnitude} = M + 2(n - 1)
\]

\[
\text{DNP Harmonic Phase Angle} = P + 2(n - 1)
\]

where: M corresponds to magnitude in the table above, P corresponds to phase in the table above, and n equals the harmonic number.

**Example 1:** Specify the type index for the magnitude of the 3rd harmonic of the A-phase voltage.
Type Index Value = \( M + 2(n - 1) = 128 + 2(3 - 1) = 132 \)

**Example 2:** Specify the type index for the phase angle of the 5th harmonic of the C-phase current.
Type Index Value = \( P + 2(n - 1) = 429 + 2(5 - 1) = 437 \)

Scaling and Resolution

Compute actual values from DNP readings as follows: divide the DNP reading by the full-scale number of counts and multiply by the full scale range. For example, if the DNP reading for voltage is 21069, and the maximum voltage value is 150, the actual voltage is determined as follows:

\[
\text{Measured Voltage} = \frac{21069}{32767} \times 150 = 96.45 \text{ volts}
\]

Remember that magnitudes are actual scaled primary values and the resolution is determined by dividing the maximum primary value by the Full Scale count. For example, with a maximum (1133A) current range of 2.5 Amps (CT ratio of 100), then the resolution is \( \frac{250}{32767} = 0.0076 \) Amps. If the actual primary current is 96.5 Amps, then the DNP reading would be:

\[
\text{Expected Counts} = \frac{96.5}{250} \times 32767 = 12,648 \text{ counts.}
\]
### 13.8 Energy Register Values

<table>
<thead>
<tr>
<th>DNP</th>
<th>Modbus Quantity Full Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNP:Index:0</td>
<td>30729–30730 A Active Energy Delivered Register (Wh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:1</td>
<td>30731–30732 C Active Energy Delivered Register (Wh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:2</td>
<td>30733–30734 B Active Energy Delivered Register (Wh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:3</td>
<td>30735–30736 Total Active Energy Delivered Register (Wh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:4</td>
<td>30737–30738 A Active Energy Received Register (Wh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:5</td>
<td>30739–30740 C Active Energy Received Register (Wh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:6</td>
<td>30741–30742 B Active Energy Received Register (Wh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:7</td>
<td>30743–30744 Total Active Energy Received Register (Wh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:8</td>
<td>30745–30746 A Apparent Energy Delivered Register (VAh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:9</td>
<td>30747–30748 C Apparent Energy Delivered Register (VAh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:10</td>
<td>30749–30750 B Apparent Energy Delivered Register (VAh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:11</td>
<td>30751–30752 Total Apparent Energy Delivered Register (VAh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:12</td>
<td>30753–30754 A Apparent Energy Received Register (VAh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:13</td>
<td>30755–30756 C Apparent Energy Received Register (VAh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:14</td>
<td>30757–30758 B Apparent Energy Received Register (VAh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:15</td>
<td>30759–30760 Total Apparent Energy Received Register (VAh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:16</td>
<td>30761–30762 A Reactive Energy Register, Quadrant 1 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:17</td>
<td>30763–30764 C Reactive Energy Register Quadrant 1 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:18</td>
<td>30765–30766 B Reactive Energy Register Quadrant 1 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:19</td>
<td>30767–30768 Total Reactive Energy Register Quadrant 1 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:20</td>
<td>30769–30770 A Reactive Energy Register Quadrant 2 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:21</td>
<td>30771–30772 C Reactive Energy Register Quadrant 2 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:22</td>
<td>30773–30774 B Reactive Energy Register Quadrant 2 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:23</td>
<td>30775–30776 Total Reactive Energy Register Quadrant 2 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:24</td>
<td>30777–30778 A Reactive Energy Register, Quadrant 3 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:25</td>
<td>30779–30780 C Reactive Energy Register Quadrant 3 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:26</td>
<td>30781–30782 B Reactive Energy Register Quadrant 3 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:27</td>
<td>30783–30784 Total Reactive Energy Register Quadrant 3 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:28</td>
<td>30785–30786 A Reactive Energy Register Quadrant 4 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:29</td>
<td>30787–30788 C Reactive Energy Register Quadrant 4 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:30</td>
<td>30789–30790 B Reactive Energy Register Quadrant 4 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:31</td>
<td>30791–30792 Total Reactive Energy Register Quadrant 4 (VARh) 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:32</td>
<td>30793–30794 A Qh Delivered Register 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:33</td>
<td>30795–30796 C Qh Delivered Register 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:34</td>
<td>30797–30798 B Qh Delivered Register 32-bit integer</td>
</tr>
<tr>
<td>DNP:Index:35</td>
<td>30799–30800 Total Qh Delivered Register 32-bit integer</td>
</tr>
</tbody>
</table>

Table 13.6: Energy Values
### DNP Modbus Quantity Full Scale

<table>
<thead>
<tr>
<th>DNP Type:Index</th>
<th>Modbus Input Reg.</th>
<th>Quantity</th>
<th>Full Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plc:36</td>
<td>30801-30802</td>
<td>A Qh Received Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:37</td>
<td>30803-30804</td>
<td>C Qh Received Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:38</td>
<td>30805-30806</td>
<td>B Qh Received Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:39</td>
<td>30807-30808</td>
<td>Total Qh Received Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:40</td>
<td>30809-30810</td>
<td>A Volt-Squared Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:41</td>
<td>30811-30812</td>
<td>C Volt-Squared Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:42</td>
<td>30813-30814</td>
<td>B Volt-Squared Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:43</td>
<td>30815-30816</td>
<td>Total Volt-Squared Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:44</td>
<td>30817-30818</td>
<td>A Amp-Squared Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:45</td>
<td>30819-30820</td>
<td>C Amp-Squared Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:46</td>
<td>30821-30822</td>
<td>B Amp-Squared Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:47</td>
<td>30823-30824</td>
<td>Total Amp-Squared Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:48</td>
<td>30825-30826</td>
<td>A Volt-Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:49</td>
<td>30827-30828</td>
<td>C Volt-Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:50</td>
<td>30829-30830</td>
<td>B Volt-Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:51</td>
<td>30831-30832</td>
<td>Total Volt-Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:52</td>
<td>30833-30834</td>
<td>A Amp-Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:53</td>
<td>30835-30836</td>
<td>C Amp-Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:54</td>
<td>30837-30838</td>
<td>B Amp-Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:55</td>
<td>30839-30840</td>
<td>Total Amp-Hour Register</td>
<td>32-bit integer</td>
</tr>
<tr>
<td>Plc:56–63</td>
<td>30841-30842</td>
<td>Reserved Registers (8) (16 values)</td>
<td>32-bit integer</td>
</tr>
</tbody>
</table>

For technical details on how the Model 1133A measures energy data, see Section 11.8

Returned values are count values and are scaled in customers application software.

Indices in boldface represent 32-bit values, 2 16-bit values each. Little endian means that the lower-indexed value contains the lower half (16 least-significant bits) of the 32-bit quantity. Example: to find the A Active Energy Delivered 32-bit value, use: \(65536 \times DNP[729] + DNP[728]\). 32-bit register values are scaled according to the values of Kp set separately using PSCSV configuration.

### 13.9 Trigger Status

<table>
<thead>
<tr>
<th>DNP Type:Index</th>
<th>Modbus Input Reg.</th>
<th>Quantity</th>
<th>Full Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI:0</td>
<td>30843-30844</td>
<td>DSP Trigger Status</td>
<td>32-bit bitfield</td>
</tr>
</tbody>
</table>

Table 13.7: Trigger Status Values

**Notes:**

Bitfield:

AI indicates analog-input point, CT indicates Counter Point, BI indicates Binary Input

Values are “Little Endian. See Introduction at the beginning of Appendix A.”
Chapter 14

Event Input Voltage Settings

14.1 General Information

This section describes two configurations of the 1133A Event Inputs, and the installation of resistors to change the Event Input voltage range from 24–240 Vdc to 5 Vdc CMOS level.

14.2 Event Input Specifications

For your convenience, the Event Input specifications are repeated below in Table 14.1.

<table>
<thead>
<tr>
<th>Part</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type &amp; Number</td>
<td>Four, optically-isolated 24-240 Vdc (may be configured for 5-Vdc logic level)</td>
</tr>
<tr>
<td>Connections</td>
<td>Pluggable, 8-pole, 5-mm terminal strip, with 4, 2-pole mating connectors</td>
</tr>
<tr>
<td>Isolation</td>
<td>4000 Vrms for 1 minute to chassis</td>
</tr>
<tr>
<td>Resolution</td>
<td>1 μs</td>
</tr>
</tbody>
</table>

Table 14.1: Event Input Specifications

14.3 Standard Event Input Voltage, 24 – 240 Vdc

All of the four event inputs on the 1133A Power Quality / Revenue Standard are configured for an input voltage range of 24-240 Vdc. For the standard setting NONE of the four optional resistors need to be installed, i.e. R225, R226, R227, R228 (See Figure 14.1).

14.4 Optional Event Input Voltage, 5 Vdc, Logic Level

To set up the Event Inputs for a 5 Vdc, follow the instructions below.

WARNING! Do not remove the top cover while power is applied. Hazardous voltages are present while the power cord is connected. Always disconnect the unit from the input power source before removal of the top cover.
CAUTION! Use care handling any of the components for static discharge.

1. Set the Line Power switch to OFF position (if so equipped). Disconnect power cord from rear panel.
2. Remove rack-ears (if so equipped) and remove the top cover using a T-25 driver (4 screws).
3. Disconnect the small antenna cable from the receiver board. Carefully, pull straight out from the GNSS board connector. Set aside.
4. Remove any connector plugs from input/output connectors at the rear panel.
5. Remove all of the screws to input/output connectors attached at the rear panel of the chassis, and store for later use.
6. Remove the two screws to the Memory Board, located near the right-front of the chassis, and lift out the memory module. Grasp across the narrow side of the memory board near the connector and pull up.
7. Remove the six screws holding the main board and carefully slide it forward to allow for release of the RJ serial connectors at the right rear of the chassis.
8. Locate the four resistor positions (R225, R226, R227, R228) near the Event Input connectors. See Figure 14.1.
9. Clean the solder out of the holes for each of the resistors, and install a 511 Ohm resistor (1/4 Watt, carbon composition) in each location.
10. Replace all of the components in the reverse order described above, and restore the unit into service.

Figure 14.1: Event Input Resistor Settings
Chapter 15

Accurate CT Calibration for the Model 1133A

15.1 Overview

The Model 1133A Power Sentinel offers accuracy in power measurement of 0.025%. Existing CTs provide accuracy of a few tenths of one percent. How then can the 1133A actually provide accuracy of 0.025% in the field?

The answer is by calibrating the existing CT’s. By comparing each CT to an accurate reference CT, traceable to national standards (for example, NIST in the USA), the errors of the test CT can be determined at several currents and the correction factors entered into a table in the 1133A. The 1133A uses these correction factors, interpolating between them based on the measured current, to correct measured power (and current) to the actual values, in real time, within the instrument’s stated accuracy.

15.2 Calibration Process

To calibrate the CT’s requires three things: (1) a calibrated reference CT, (2) a source of high current, and (3) some means of comparison. Each of these will be addressed below.

15.3 Calibrated Reference CT

Arbiter Systems has developed the Model 936A, an accurate, multi-ratio reference CT suitable for these calibrations, and suitable for calibration by national standards laboratories at an accuracy which exceeds 0.01% (the present limit of traceability at NIST). This CT will have ratios of 1200 : 5, 1000 : 5, 800 : 5, and 600 : 5. It will operate accurately at currents from 0 to 200% of rating. Using a two-stage, amplifier-aided design, this CT should be fundamentally capable of accuracy better than 10 ppm (0.001%).

By using a multi-turn primary through the center of the reference CT, current ratios of \((1200 / N) : 5\), \((1000 / N) : 5\), \((800 / N) : 5\), and \((600 / N) : 5\) can be provided as well (with \(N\) equal to the number of turns). By using a multi-turn primary on the CT under test, ratios of \((1000 \times M) : 5\), \((800 \times M) : 5\), and so on can also be provided. And finally, by using both \(N\) turns through the
reference CT and M turns through the CT under test, ratios of \(1000 \times M \div N\) : 5, \((800 \times M \div N) : 5\), can be provided. This allows a wide range of test CT ratios to be calibrated with a single accurate reference artifact.

### 15.4 Excitation Current Source

For a high current supply required to perform the calibration, consider the Model 935A, Current Source. This will work on the principle of a “CT in reverse,” that is, a “donut” having a multi-turn primary excited at a reasonable current level (5 to 10 amps maximum). This device will allow a heavy-gauge winding to be placed through its center, exciting it at the high currents required (up to 2000 ampere-turns).

While it is possible, and perhaps even desirable on some accounts, to provide a regulated, solid-state source to drive the excitation coil, this would be very expensive and heavy considering the powers involved (up to 1000 VA). Due to the accurate ratio-metric measurement technique to be proposed in the next section, it is not necessary to have the excitation current be particularly accurate or even stable. Therefore, we can use a much simpler brute-force design based on a multi-tap autotransformer and Variac to set the current. The design contemplated will offer settings for input voltage range (100, 120, 200, 220 and 240 Vrms) and output range (100, 50, 20, 10 and 5% of full-scale), and continuous adjustment from zero to the selected output range. The device would be powered on site from the ac–mains power.

### 15.5 Comparison Technique

The most direct method of comparison involves making a measurement using the reference CT, then using the unknown, and then calculating the ratio correction factor and phase angle from the data (Figure 15.1). This has the drawbacks that the current source and measurement device must be substantially more accurate and stable than the desired measurement result, typically by a factor of 4 or 5. If this were possible, it would greatly increase the cost and size of the equipment.

![Figure 15.1: Comparison Technique A](image)

A better technique is called “nulling” (Figure 15.2). In this method, the outputs of the two CT’s, reference and test, are subtracted electrically by using superposition (Kirchhoff’s law), and the difference (error) measured directly. This subtraction is exact, and introduces no error. Using a second channel of the same measuring instrument, the actual secondary current can also be measured, and the ratio correction factor and phase angle are then determined mathematically. Best of all, if the measuring instrument can make the two measurements simultaneously, then
effects of source variations cancel out. Furthermore, since the quantity being measured is a small error, equal to at most about 1% of the secondary current, then the accuracy required of the measuring instrument could be relaxed as well.

The ideal instrument to make this comparison is the Arbiter Systems Model 931A Power System Analyzer. This instrument samples both of its selected input channels simultaneously, meeting the requirement stated above. Best of all, measuring the error current with 0.05% accuracy, the Model 931A is capable of making this comparison at a level of 5 ppm of the secondary current (0.05% of 1%). This standards-lab performance can readily be achieved in the field using rugged, portable equipment designed for field use, operated by service technicians with little or no training in metrology techniques.

![Figure 15.2: Comparison Technique B](image)

### 15.6 Accessories

This setup will be provided with the necessary accessories to perform the required calibrations. The cable carrying the high primary current will be AWG 4/0 welding cable, capable of up to 500 amperes current. For applications where the cable can be run through the center of the test CT, a single long length (about 15 m or 50 ft) of cable will be provided, allowing for multi-turn setups. To perform a calibration of, for example, a 1000:5 CT at currents up to 2000 amperes, four turns are required through each of the excitation CT, the test CT, and the reference CT.

For applications where the current must be provided to a bar running through the test CT, four shorter (3 m or 10 ft) cables will also be provided. The lugged ends of all of the cables are connected to the primary of the test CT. This would form a single-turn loop, with each cable carrying 500 of the 2000 amperes of current.

Software will be provided to automate the data gathering and reduction process, using a serial connection to the Model 931A and prompting the operator to perform the proper hookup and settings of the other equipment. The data could later be printed out, and it can be stored in a data file suitable for use when configuring the 1133A, eliminating a manual step where errors could enter into the process.

Hardware required for connecting the lugged ends of the cables together, completing the high-current loop, and tools to tighten the hardware to specification, will also be a part of the kit.
15.7 Selection of the Current Calibration Points

The proper choice of calibration points (test currents) satisfies two criteria: first, the points chosen should allow complete characterization of the CT; and second, the points should allow for accurate interpolation. Since CT's are magnetic devices, they have error curves, which are smooth and do not have jumps or breakpoints. Usually, either a linear (1, 2, 3, 4, 5) or logarithmic (0.1, 0.2, 0.5, 1.0, 2.0) progression of the test current values will provide an accurate characterization of the CT performance.

Many interpolation algorithms do not easily deal with non-linear input progressions, often yielding bizarre results. The algorithm chosen for the 1133A will operate well with either logarithmic or linear progression of test points. No algorithm can be expected to yield acceptable performance if the test points are not spaced out in some logical manner. For example, the test sequence (0.1, 0.2, 0.3, 10, 15, 20) might seem reasonable for a device which had relatively large errors at the ends of its range, and small, consistent errors in the midrange. However, the large hole in the middle is certain to confound any general-purpose interpolation algorithm with more complex-than-linear interpolation. What will confuse the algorithm is the dramatic change in the slope of the x-axis points at 0.3 and 10. Using points with a relatively predictable and consistent pattern, such as logarithmic or linear progression, will eliminate this potential problem.

To determine which is the best choice for a particular type of CT, you could characterize the CT initially using enough points to thoroughly describe its performance. Then, the points can be plotted on graph paper (or using a spreadsheet program) with log and linear axes for the current values. Whichever curve appears smoother and more representative of the CT to the eye is probably the best choice for the calibration point sequence. In general, logarithmic sequences (1, 2, 5, and 10) emphasize the lower current values and linear (1, 2, 3, 4, 5) sequences emphasize the higher current values. Where the errors are changing rapidly at the low end of the current range (usually due to changes in permeability of the core as a function of current level), a logarithmic progression will usually work best. When the errors are changing rapidly at the high end of the current range (usually due to incipient saturation of the core with increasing burden voltage), then a linear progression might be a better choice (although a reduction in burden will almost certainly improve overall performance).

15.8 Conclusion

Taking advantage of the full accuracy of the 1133A Power Sentinel requires calibration of the user’s CT’s. This paper presents a method to perform these calibrations.

Calibrating existing CT’s requires three extra pieces of equipment: a reference CT, an excitation current source and a current comparator. Two newly developed products by Arbiter Systems should provide users with these tools for on site calibrations. The Model 935 Current Source and Model 936 Reference CT are now available for this purpose. The popular Arbiter Systems Model 931 Power System Analyzer can accept three-phase primary currents up to 2000 amperes (higher under some conditions), with a transfer accuracy of 5 ppm and an overall traceable accuracy of 0.01%, or better.
Appendix A

Working with Ethernet Connections

A.1 Checking the Computer Network Settings

There are two methods of setting network values in your Windows computer: automatically or manually. To check how the addresses are set up in your machine, select the following:

1. Select Start > Network and Dial Up Connections > Local Area Connection, or Start > Settings > Control Panel > Network and Dial Up Connections, then right click on Local Area Connection.

2. On the Local Area Connection window, click on Properties.

3. Select “Internet Protocol (TCP/IP)” under the area marked “Components checked are used by this connection,” and click on Properties.

4. In the upper settings block, one of the two possible radio buttons will be selected: “Obtain an IP address automatically,” or “Use the following IP address.”

If the Network settings on the computer are set up automatically, then the values will not be listed in the Internet Protocol (TCP/IP) Properties window. To check the current IP address values, run ipconfig at the command prompt (DOS prompt) as follows:

1. In Windows XP, select Start > Programs > Accessories > Command Prompt; in Windows 98 select Start > Programs > MS-DOS.

2. At the prompt, C:\ > type the word “ipconfig.” The following values are representative of Windows XP on a local network.

C:\ >ipconfig
Windows IP Configuration
Ethernet adapter Local Area Connection
 Connection-specific DNS suffix . . . . :ASI
 IP address . . . . . . . . . . . . . . . . . . . . . . . . . . . . :100.101.0.103
 Subnet Mask . . . . . . . . . . . . . . . . . . . . . . . . . . . . :255.255.255.0
 Default Gateway . . . . . . . . . . . . . . . . . . . . . :100.101.0.4
A.2 Setting an IP Address on the Computer

In some situations, it may be better to set up the network values manually. Set the IP address manually if directly connecting the 1133A to the computer Ethernet card with a crossover cable or through a hub. Later, you can reset the network values to be set up automatically when connected to your local.

1. Follow steps 1 - 4 above and check the radio button labeled “Use the following IP address.”
2. Type in the IP address and subnet mask values that you wish and close the window(s). A gateway address should not be necessary.
3. Do not use an IP address with the last values higher than 254. It may be a good idea to set up the computer IP address and that of the 1133A to sequential numbers, like 100.101.102.1 and 100.101.102.2.
4. Click OK and restart your computer.

A.3 Setting an IP Address on the 1133A

Use the RS-232 cable and RJ-11 to DB-9F adapter to set the IP address on the 1133A.

1. Connect the cable and adapter between the computer and the 1133A. Note which COM port you are connected to on both the computer and the 1133A.
2. Open PSCSV software and connect with the 1133A. Make certain that you have chosen the correct port on the computer.
3. If necessary, check the COM 1 or 2 settings on the 1133A so that they agree with those you are using with PSCSV.
4. Log on to the 1133A with Permission to configure.
5. Choose Connection > Configure > Communication Ports, or click the Configure Ports button.
6. In the Configure Ports window, select Ethernet and type in the IP address in the right-hand window named “IP Address.”
7. Click OK and the address should now be installed. Check this by pressing and the STATUS/TIME button on the 1133A. If necessary, press and hold the STATUS/TIME button on the 1133A for three seconds to move to the second set of menus. The new IP address should appear with the subnet mask value.
8. You must restart the 1133A for the new IP address be in effect.
Appendix B

Using Surge Arresters

B.1 Introduction

These instructions cover the installation of the Arbiter Systems Model AS0094500, Surge Arrester/Grounding Block. The AS0094500 performs two basic functions:

1. Provides a solid and reliable grounding point for the antenna system connected to a GNSS receiver;
2. Protects connected equipment from the damaging effects of atmospheric static electricity and induced voltage spikes from nearby lightning strikes or other electrical events.

Figure B.1: AS0094500 Surge Arrester

B.2 Description

The Model AS0094500 is a three-terminal device with two type F connectors and one ground terminal. The type F connectors are interchangeable. One connects to the antenna and the other connects to the receiver. A screw terminal provides a connection point for an earth ground wire. The arrester is weatherproof and may be mounted outdoors provided that the cabling and type F connectors are sealed from the weather. The arrester also passes dc power to energize the antenna.
B.3 Installation

B.3.1 Mounting Location

Location is a key consideration when installing the Model AS0094500. It should be mounted as close as possible to a good earth ground, such as a grounding rod or station ground grid. The shorter the path between the arrester and the earth ground, the more effectively it will bypass the induced voltages.

B.3.2 Ground Connection

The Model AS0094500 may be grounded in two ways: (1) via the ground-wire screw connection, or (2) by hard-mounting directly to a grounded metal surface.

If grounding via the ground-wire screw connection, use the largest possible gauge wire. Hole diameter allows up to 8 AWG wire (0.129 in or 3.26 mm). This wire should be as short as possible, and connected to a good earth ground.

Alternately, the arrester may be mounted directly to a well-grounded plate within the facility.

B.3.3 Antenna and Clock Connections

The type F connectors are interchangeable. One connects to the antenna and the other connects to the receiver. Use only a low-loss, tri-shield or quad-shield 75-ohm coaxial cable – RG-6 or RG-11 are the preferred cable types. RG-59, or other similar types of coaxial cable, should be avoided due to greater signal loss and poorer shielding at the GNSS frequency (1.575 GHz).

B.3.4 Weather Sealing the Connections

To protect from weather, use only type F connectors with appropriate sealing features. Typically this includes an o-ring in the male connector that seats against the face of the female connector on the surge arrester. Also, crimped connectors frequently include a silicone gel flooding compound, which enhances the ability of the connection to withstand the rain and humid conditions. To better seal the entire connection, cover the joint with GE Silicone II compound.

Use the proper crimping tool if using crimp-on connectors. Improper tools may not guarantee a strong and sufficiently grounded connector resulting in poor cable performance and GNSS reception. Consider purchasing RF cables of various standard and custom lengths manufactured by Arbiter Systems.

B.3.5 Suggested Mounting

Figure B.2 illustrates the recommended mounting of the AS0094500 with the F-connectors facing downward. Install drip loops in the cables to reduce the likelihood of moisture penetrating the device and the structure.
B.3.6 Physical Dimensions

Overall: 59 mm x 38 mm x 18 mm (2.32 in x 1.49 in x 0.71 in) LxWxH
Mounting Hole Dim: 50 mm x 15 mm
Mounting Hole Dia: 4 mm (0.157 in)
F Connector Dim: 24 mm, center to center
Weight: 48.2 g (1.7 oz)
Appendix C

IRIG-B Primer

C.1 Introduction

IRIG-B is a complete serial time code of 74 bits that occurs once per second. It be subdivided into various forms, including modulated (analog), unmodulated (CMOS/TTL/Level-Shift) and with the C37.118 specification bits enabled or disabled (IEEE-1344 mode turned ON or OFF). The Model 1133A transmits only unmodulated IRIG-B, and allows you to also set the time zone to Local or UTC.

C.1.1 Modulated and Unmodulated IRIG-B

Figure C.1 illustrates the primary differences between modulated and unmodulated IRIG-B. You will notice that the while modulated IRIG-B is distinctive because it has a sine wave carrier signal of 1 kHz, it is similar to unmodulated IRIG-B since the peak values of the carrier follow the same form as the digital waveform. IRIG-B is considered to be pulse-width modulated, in that the information is contained in the percent of time that the analog peak-to-peak value, or TTL level, is maximum. Notice the three states in both forms of the IRIG-B waveform (with times in parentheses): IRIG-B Reference (8 ms); IRIG Zero (2 ms); IRIG-B One (5 ms). Reference bits are also placed within each instance that the time code is transmitted.

![Figure C.1: IRIG-B Waveforms](image_url)

The IRIG-B time code consists of 74 bits produced every second, and contain various time,
date, time changes and time quality information of the time signal. Timing information is divided into logic ones, zeros and reference bits.

There are three functional groups of bits in the IRIG-B time code, in the following order: Binary Coded Decimal (BCD), Control Function (CF) and Straight Binary Seconds (SBS). The BCD group contains only time information including the (daily) hours, minutes and seconds and recycles yearly. The CF group contains year, time quality, leap year, pending leap seconds and parity. The SBS consists of the total elapsed seconds that recycles daily.

C.1.2 IRIG-B Type Codes

The Model 1133A provides IRIG-B that follows one type code: unmodulated (or demodulated) IRIG-B. Also, this signal type is further subdivided according to whether the IRIG-B time code includes the C37.118 extension. The Model 1133A allows you to enable or disable the C37.118 extension (IEEE 1344 mode ON or OFF), the differences depicted in Table C.1.

<table>
<thead>
<tr>
<th>1344 Mode</th>
<th>1344 ON</th>
<th>1344 OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unmodulated, B00X</td>
<td>B000</td>
<td>B003</td>
</tr>
<tr>
<td>Modulated, B12X</td>
<td>B120</td>
<td>B123</td>
</tr>
</tbody>
</table>

Table C.1: IRIG-B Code Designations

C.1.3 IRIG-B C37.118 Extension

As mentioned above, C37.118 enables extra bits of the Control Function (CF) portion of the IRIG-B time code. Within this portion of the time code, bits are designated for additional features, including:

- Calendar Year (2 digits)
- Leap seconds
- Daylight savings
- Local time offset
- Time quality
- Parity
- Position identifiers

To be able to use these extra bits of information, relays, RTU’s and other equipment receiving the time code must be able to decode them. Consult your equipment manual to determine if the 1344 mode should be turned ON in the Model 1133A. To view details of the C37.118 standard, please check with the IEEE.

**NOTE:** To obtain a copy of of the IRIG-B 2004 specification, please use the link to the Arbiter web site, http://www.arbiter.com and check under Documentation > Timing and Frequency.
C.2 Connecting the IRIG-B Output

The Model 1133A comes equipped with one, high drive, IRIG-B output connector using screw terminals. Terminal connectors are compatible with twisted pair cabling. If using a coaxial cable, you can easily transition from the two wires (coming from the back of the 1133A) to a BNC connector using a BNC Breakout.\(^1\)

NOTE: If using a shielded, twisted-pair cable (e.g. Belden 8760), connect the cable shield to the clock ground lug.

C.2.1 Screw Terminals

Prepare the twisted pair cable by stripping back at least 1/4 inch of the insulation and any shielding; DO NOT tin the bare wire with solder. Tighten the screws down on the wire.

C.2.2 How Far Can I Run IRIG-B Cabling?

Some important considerations for transmitting IRIG-B over long distances are: (1) resistive losses in cabling, (2) electromagnetic interference, (3) propagation delays and (4) installation and maintenance costs.

Additional Information on Using IRIG-B

1. For details on distributing IRIG-B signals over long distances, see application note, AN101, Distributing Timing Signals in a High-EMI Environment. Download the file: appnote101.pdf

2. For important considerations about IRIG-B connections, distribution of signals and accuracy, download the file: IRIG-B_accuracy_and_connection_requirements.pdf

C.2.3 Synchronizing Multiple IED’s From One Masterclock Output

In many installations, master clock signals (e.g. from the 1133A) are “fanned out” to a number of devices. This method makes more efficient use of the clock synchronizing capability since the clock drivers are designed to handle multiple loads. The exact number of possible loads must be determined from the input impedance of each connected IED. For example, if the input impedance of the IED is 5 kilohms, determine the device current (I) drawn as derived in Calculation C.1.

\[
I = \frac{V}{Z} = 5 \text{ Volts} \div 5000 \text{ Ohms} = 0.001 \text{ Amps} (1\text{mA})
\]

If you were to connect ten of the same IED’s to the same output, then the total current drawn would be 10 x 0.001 A = 0.01 A (10 mA).

\(^1\)Model 4969 and 4970, Pomona Electronics, 9028 Evergreen Way, Everett, WA 98204, 800-490-2361, <http://www.pomonaelectronics.com/index.php>}
C.2 Connecting the IRIG-B Output

C.2.4 Connecting Unmodulated IRIG-B

To drive multiple loads from one clock timing output, make sure they are wired in parallel. Some call this “Daisy-Chaining”, however the idea is to drive all of these loads in parallel from the single output. It is much simpler to connect loads to unmodulated IRIG-B than for modulated. This is because all of the loads are driven at the same voltage and each draws current from the transmission line.

To determine capacity for Unmodulated IRIG-B, follow these steps:

1. determine the number of loads to be connected to a single clock output
2. determine the impedance (or resistance) of each load
3. divide the drive voltage (5 V) by the resistance of each device
4. sum up all the load currents for the total current for one clock output.

Another method is to determine the lumped impedance of all of the connected IED’s in parallel. Then, determine the overall current by dividing the drive voltage (5 V) by the computed lumped impedance value. This current should not exceed 250 mA.

C.2.5 Wire Losses

Another factor affecting the available voltage is the resistive losses through the cabling. Wire has a certain resistivity associated with it that is determined by its metallic composition, and resistance determined by the diameter and length. For example, single-strand, 22 AWG (bare, enamel-coated) copper wire has a resistance of approximately 19.6 ohms per 1000 feet. To compute the loss we must include both wires in the connection, signal and return. For coaxial cabling, the resistance of the center conductor is rated differently than the shield. For a twisted pair, both of them should essentially have the same resistance per cut length. If we use a twisted pair of 22 AWG (copper as above), then the available voltage (at 100 mA of current) for 500 feet of wire is calculated as in C.2.

\[
V_{pp \, \text{available}} = 5.0 - I \times 19.6 \, \text{wire} = 3.04 \, V_{pp}
\]

So, you can see that a considerable amount of the drive voltage is lost with 100 mA of current and 500 feet of 22 AWG twisted pair transmission line. This level should would most likely be detected by the decoder in most IED’s using CMOS, but not TTL. To avoid these problems, make your cable runs as short as possible, to use larger diameter cable, and to carefully distribute the loads.

C.2.6 Cable Delays

Electromagnetic waves travel at the speed of light \((C)\) in free space or vacuum and a fraction of that through cabling. The speed of a wave in free space is given in Identity C.3.

\[
C = 3 \times 10^8 \, \text{meters/second}
\]
Since electromagnetic waves travel slower through any cable, cable manufacturers normally specify cable with a velocity factor (VF), which is a fraction of the speed of light in free space, and characteristic of the specific cable. The Velocity Factor for the RG-6 cabling used by Arbiter Systems for GNSS antenna connections, is about 83% of C. Most transmission lines have velocity factors in the range of 65% to 97%. Using these values you can determine the actual time delay in your cable distribution system and compare it to your required accuracy. As an example, it would take 840 feet of RG-6 cable (with a velocity factor of 83%) to delay the signal by one microsecond. For IRIG-B timing applications, these delays may not be important, compared to other criteria. Otherwise, you would be forced to compensate for the time delay using another method, such as advancing the timing output or placing another master clock at the remote site.

Calculating the signal delay in a transmission line with a velocity factor of 83% is as shown in Equation C.4:

\[
T = \frac{1}{CK_v}
\]

Where:

- \( T \) = Cable delay, in nanoseconds;
- \( \lambda \) = Cable length, in meters;
- \( C \) = Speed of light (3 × 10^8 meters per second);
- \( K_v \) = Nominal velocity of propagation (e.g. 0.83).

### C.2.7 Solutions

There are many solutions to providing an accurate timing signal in distant locations. However, the most satisfying solution may not be to string cabling for hundreds of meters. The costs associated with installing and maintaining cabling over a wide area may be unsatisfactory. Since the GNSS is so pervasive, it may prove to be less costly to install another clock at a distant location, which would also improve accuracy and provide redundancy. Before installing cabling over a wide area, be sure to first examine all the possibilities.
Appendix D

CE Mark Certification

D.1 Introduction

On the following page contains the individual CE Mark Certification for models covered in this manual. This includes Model 1133A Power Sentinel, GNSS-Synchronized Power Quality/Revenue Standard™.
Declaration of Conformity with European Union Directives

Date of Issue: October 8, 2015

Directives: 2004/108/EC Electromagnetic Compatibility
73/23/ EEC Low Voltage Safety

Model Number(s): 1133A Power Sentinel*
Multifunctional Synchronized Measurement Device

Manufacturer: Arbiter Systems, Inc.
1324 Vendels Circle, Suite 121
Paso Robles, CA 93446 – USA

Harmonized Standards: EN50121-4:2006
IEC61850-3 Ed.2

Referenced: Residential, Commercial and Light Industrial Environments
EN61010-1 Safety requirements of Electrical Equipment for Measurement, Control and Laboratory Use.

Signed: [Signature]

Signatory: Bruce H. Roeder

This certificate declares that the described equipment conforms to the applicable requirements of the directives on Electromagnetic Compatibility 89/339/EEC, Safety 73/23/EEC, and amendments by 93/68/EEC adopted by the European Union.

*with Option 04 - Low Vdc power supply operated between 12 Vdc and 60 Vdc
Appendix E

Vorne Output Values

E.1 Introduction

This section describes the Vorne serial output strings when selected from the Configure Ports menu. To configure the 1133A to broadcast the desired message via Vorne protocol, see Section 7.2.2.

E.2 Vorne Protocol in Use

Selecting the Vorne protocol from the configure ports menu configures either Communication Port 1 or 2 to broadcast data to support Vorne large format time displays. Note that the 1133A sends the complete string as listed below, with carriage-return line-feed characters after each line of data. Data is transmitted ahead of time, and the \(<\text{BEL}>\) character is transmitted on time. The Vorne display itself is configured to recognize one of the lines of data by its address seen at the start of the string (for example, “44” UTC/Local time). When properly configured, the Vorne display updates simultaneously upon receipt of the \(<\text{BEL}>\) character the data contained in the configured address. “\(\geq\)” symbolizes a carriage return and line feed for each line of data.

E.3 Description of Vorne Protocol

<table>
<thead>
<tr>
<th>Response:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11nn (\geq)</td>
<td>Out-Of-Lock Time</td>
</tr>
<tr>
<td>44hhmmss (\geq)</td>
<td>UTC/Local Time</td>
</tr>
<tr>
<td>22±ffe.fff (\geq)</td>
<td>Frequency Deviation</td>
</tr>
<tr>
<td>33±ss.s (\geq)</td>
<td>Time Deviation*</td>
</tr>
<tr>
<td>34±ssss.sss (\geq)</td>
<td>Time Deviation*</td>
</tr>
<tr>
<td>66hhmmss (\geq)</td>
<td>System Time</td>
</tr>
<tr>
<td>77nn.nnn (\geq)</td>
<td>System Frequency</td>
</tr>
<tr>
<td>88nnn.nn (\geq)</td>
<td>System Phase</td>
</tr>
<tr>
<td>89nnn.nn (\geq)</td>
<td>System Magnitude</td>
</tr>
<tr>
<td>55ddd (\geq)</td>
<td>Day of Year</td>
</tr>
<tr>
<td>(&lt;\text{BEL}&gt;)</td>
<td>(&lt;\text{BEL}&gt;) = hex 07</td>
</tr>
</tbody>
</table>

\(<\text{BEL}>\) = hex 07
The decimal points shown above are not actually transmitted in the data stream, but their position is implied. The displays are configured to show the decimal point in this position.

*Time Deviation is output in two formats in the same data stream: 33±.ss and 34±sss.sss.

Output for the 33±.ss format will be +9.bb when the measured value exceeds +9.99 (b = blank). It will be -9.bb when the measured value is less than -9.99.

Table E.1 lists the output for the 34±sss.sss format, which observes the following conventions for out-of-range values and leading blanks. Decimal points are implicit and do not appear in the data stream.

<table>
<thead>
<tr>
<th>Time Deviation Range</th>
<th>Format (b=blank)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Below -999.999</td>
<td>-bbb.bbb</td>
</tr>
<tr>
<td>-999.999 to -100.000</td>
<td>-sss.sss</td>
</tr>
<tr>
<td>-99.999 to -10.000</td>
<td>-bss.sss</td>
</tr>
<tr>
<td>-9.999 to -0.001</td>
<td>-bbs.sss</td>
</tr>
<tr>
<td>+0.000 to +9.999</td>
<td>+bbs.sss</td>
</tr>
<tr>
<td>+10.000 to +99.999</td>
<td>+bss.sss</td>
</tr>
<tr>
<td>+100.000 to +999.999</td>
<td>+sss.sss</td>
</tr>
<tr>
<td>Above +999.999</td>
<td>+bbb.bbb</td>
</tr>
</tbody>
</table>

Table E.1: Vorne 34 Output, Time Deviation Values

E.4 Sample 1133A Vorne Output

The string below illustrates the actual broadcast of the 1133A configured to Vorne protocol.

<table>
<thead>
<tr>
<th>Vorne Output</th>
<th>Address</th>
<th>Meaning</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1100</td>
<td>11</td>
<td>Out-of-Lock Time</td>
<td>0</td>
</tr>
<tr>
<td>44144216</td>
<td>44</td>
<td>UTC/Local Time</td>
<td>UTC 14:42:16</td>
</tr>
<tr>
<td>22-00021</td>
<td>22</td>
<td>Frequency Deviation</td>
<td>-00.021 Hz</td>
</tr>
<tr>
<td>33-003</td>
<td>33</td>
<td>Time Deviation</td>
<td>-0.03 seconds</td>
</tr>
<tr>
<td>34- 0030</td>
<td>34</td>
<td>Time Deviation</td>
<td>-000.030 seconds</td>
</tr>
<tr>
<td>66144215</td>
<td>66</td>
<td>System Time</td>
<td>UTC 14:42:15</td>
</tr>
<tr>
<td>7759979</td>
<td>77</td>
<td>System Frequency</td>
<td>59.979 Hz</td>
</tr>
<tr>
<td>8807413</td>
<td>88</td>
<td>System Phase</td>
<td>74.13 degrees</td>
</tr>
<tr>
<td>8909591</td>
<td>89</td>
<td>System Magnitude</td>
<td>95.91 Vrms</td>
</tr>
<tr>
<td>55250</td>
<td>55</td>
<td>Day of Year</td>
<td>250</td>
</tr>
</tbody>
</table>
Appendix F

Uploading Firmware

F.1 Introduction

This section describes uploading new firmware into the Model 1133A. The Flash Update Application, called 1133AUploader, and is available from the Arbiter Systems website at www.arbiter.com. Search under Downloads > Software and locate it under the product name 1133A. Uploading firmware is only possible through one of the two serial ports using the serial adapter and phone cord that came with the 1133A.

If you do not have a serial port on your pc, use a USB-to-serial adapter. The USB side of the adapter plugs into your pc and the serial side connects to the DB9 side of the serial adapter that came with the 1133A. The driver software will assign a serial port by COM number to the adapter. That number should appear under Serial Port in the Settings menu of the Uploader. You can also check this COM port number under Device Manager in your Windows operating system.

F.2 Firmware Uploading Procedure

1. Connect the phone cord and adapter between one of the serial ports on the 1133A and the pc. Use the USB-to-Serial adapter if needed.
2. Make sure that the pc and the 1133A do not lose power during the uploading process. The pc should be connected to main power.
3. Start the 1133AUploader software. You will receive a warning about maintaining power to your computer and the 1133A during the uploading process.
4. From the 1133A_Uploader menu, select Settings > Serial Port and choose the correct serial port number for your pc. If using a USB-to-Serial adapter choose the COM port number assigned to the adapter.

5. Select Settings > Baud Rate and choose the same baud rate as on the 1133A. Locate the 1133A Baud rate by pressing the Status/Time key (hold for three seconds to get second set). Note that faster baud rates transfer firmware more quickly.

6. Click the blue and white folder to locate and select the firmware file you have already downloaded. It will indicate that it is importing the file and state the firmware version. Note that you do not need to unzip the file, as it is done automatically by the uploader.

7. Click the blue and white (up) arrow button to start the upload to the 1133A. The program will initially erase program memory. A progress bar will indicate when the upload is complete.

8. You should receive a message that firmware has been successfully uploaded (indicated in the uploader window). After this you need to restart the 1133A.

NOTE: Do not turn off the 1133A if for some reason the upload was not successful, or stopped prematurely. Recheck your serial port settings in the 1133A_uploader and restart the upload process.
Bibliography


Index

accessories
  included, 1
  optional
    cables, 25
    crimp tool and connectors, 25
    in–line amplifier, 25
    surge arrester, 24
antenna
  1133A connection, 27
  cable
    effects of cable parameters, 25
  connection, 21, 27
  installation, 21
  mounting assembly, 22
  mounting kit, 21, 22
  mounting procedure, 22
  power supplied to, 26
  resistance check, 24
  testing, 24
  user-supplied cables, 27
  voltage, 24
  voltage check, 24
antenna cable, 25
Appendix
  A, 151
  B, 153
  C, 156
  D, 161
  E, 163
  F, 165
Arbiter web site, ii

Broadcast
  basic data, 92
  data filter tool, 91
  energy data, 93
  from 1133A to PSCSV, 91
  harmonic data, 95
  harmonic summary data, 96
  list of data types, 92
  phasor data, 99
  relative phase data, 100
  waveform data, 98

Buttons
  Basic Data, 39
  Channel Current, 40
  Channel Voltage, 40
  Close a Connection, 38
  Configure Flash, 40
  Configure Kp, 39
  Configure Measurement, 39
  Configure Ports, 39
  Configure Relays, 39
  Configure Scheduled, 39
  Configure Triggers, 39
  Configure UDP, 39
  Copy, 38
  Create a snapshot, 38
  Decrease Vertical Scale, 40
  Download Event, 40
  Download Scheduled, 40
  Energy Data, 39
  Erase Event, 40
  Erase Flash, 40
  Erase Scheduled, 40
  Export to CSV, 38
  Flash Status, 40
  Harmonic Data, 39
  Harmonic Summary Data, 39
  Home Page, 38
  Increase Vertical Scale, 40
  Login, 38
  Open, 38
  Open a Connection, 38
  Pause, 39
  Phase Data, 39
  PMU-1, 39
CT calibration
accurate, 147

display
  calibration information, 32
date–time, 31
ergy, 33
event log, 30
fault indication, 34
flash memory, 31
flicker, 34
frequency, time deviation, 30
harmonics, 34
IP Address, 32
MAC and Port no., 33
position, 31
power, 33
receiver status, 30
serial port info, 33
startup, copyright, 28
startup, GNSS locked, 29
startup, GNSS status, 28
startup, initial, 28
system configuration, 31
unit information, 32
unlocked indication, 34
voltage, current, 29

DNP
  configuring Class 0, 54
data structure, 135
ergy, 143
frequency, flicker, phase, 139
harmonic values, 141
individual harmonics, 142
power, 138
trigger status, 144
voltage and current, 137

Ethernet
  working with
    Appendix A, 151

Event Inputs
  specifications, 145
  voltage settings, 145

Exporting data
  in CSV format, 101
  in PQDIF format, 102

Fault indication, 5
filter tool, see Broadcast data
firmware
  downloads, ii
  updates, ii
  uploading, 165
frequency alert, audible, 61
front panel drawing, see panel drawing, front

Function Description
  available signal functions, 122
  contact outputs, 119
  CT and PT compensation, 114
  current inputs, 111
dc offsets, 115
error analysis, 112
  ethernet, 120
event inputs, 119
event logging, 118
flash memory, 118
flicker, 117
GNSS synchronization, 111
harmonics, 116
interruptions, 117
load balance, 118
overview, 111
phase and frequency, 115
phase balance, 118
phasor measurements, 117
power and energy, 112
Schulz–Laios algorithm control, 123
self calibration, 112
serial channels, 119
signal sampling, 112
system time deviation, 117
transformer compensation, 114
trigger channel parameter summary, 123
triggering in the DSP, 120
voltage and current, 114
voltage fluctuations, 117
voltage inputs, 112

fuses
  replacing, 11
  types and location, 11

Ghost PMU, see PMU, ghost
gnss
surge arrester, 24

handling
precautions, 1

IP address
setting on 1133A, 152

IRIG-B
Appendix C, 156
C37.118 description, 157
time code description, 157
type codes, 157
waveform comparison, 156
issuance, ii

LED
annunciator
definitions, 5

List of Options, 125

MODBUS
data structure, 135
energy, 143
frequency, flicker, phase, 139
harmonic values, 141
individual harmonics, 142
power, 138
trigger status, 144
voltage and current, 137

mounting kit
antenna, 21

Network
checking settings on computer, 151
checking with ipconfig, 151
setting IP address manually, 152

operate indication, 5

Option
03, terminals with SWC, 7
04, terminals with SWC, 7

Options
power, 08, 11
power, 10, 10

Out of Lock indication, 5

panel drawing
front, 4

panel drawings
rear, 6

PMU, see C37.118
Configuring in PSCSV, 58
ghost, 57, 60
PSCSV broadcast, 99
PSCSV protocol, 39
PSCSV type, 92
power quality, 36, 81, 124, 128, 131
reference, 83
setup triggers, 82
power supply
10–60 Vdc, 7
110–350 Vdc, 7
PSCSV main screen, 37
Pst, flicker
configure, 69, 107

rack mount
mounting instructions, 2
Rear panel, 42
rear panel, 64

registered data, see Scheduled Data

ROM date, ii

Scheduled Data
checking flash status, 104
configuring storage, 107
data values, 108
erasing data, 108
how energy is totalized, 109
intro, 103
using KYZ, 104
using other protocols, 104
using PSCSV, 104, 105

snapshots, 38
specifications, 124

static discharge
protection against, 1

support
request, iii

surge arrester, 24
surge arresters, 153

synchronizing
multiple devices on one port, 158

Time Set indication, 5
toolbar
   broadcast, 38
   configuration, 39
   connection, 38
   flash, 40
   input, 40
   main, 38
   records, 41

Triggers
   defining data logged, 86
   downloading event records, 88
   event notification, 88
   hysteresis, 83
   logging data, 85
   Power Quality, 81
   Power Quality definitions, 81
   PQ reference, 83
   Schulz-Laios settings, 87
   sliding reference, 83
   system triggers, 85
   User (DSP), 79
   User trigger definitions, 80
   using external inputs, 84
Triggers and Event Recording, 79

UDP
   broadcasting, 62
   configuration frame, 63
   receiving, 45
unpacking the 1133A, 1
upload configuration, 76

version
   manual, v
Vorne
   configuring, 49
   output values, 163

warranty, iii
Window Function, 59